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1 Welcome to OMNIC Macros 
 
 
 
Welcome to Thermo Scientific OMNIC™ Macros. With OMNIC 
Macros, you can turn a series of OMNIC software operations into a 
simple click of the mouse button.  
 
This manual covers the basic display features of OMNIC Macros 
and takes you through the steps of creating and running macros. 
Reference information about the commands in OMNIC Macros and 
the OMNIC software operations which can be executed using 
OMNIC macros are provided at the back of the manual. 
 

 Note You should have OMNIC or EZ OMNIC installed on your computer 
before you run OMNIC Macros\Basic™. If you install Macros\Basic 
on a system that includes OMNIC, the complete OMNIC command 
set is available for creating macros in Macros\Basic software. If only 
EZ OMNIC is installed, the Macros\Basic task list includes only the 
OMNIC commands that are available in EZ OMNIC. The general 
functions of Macros\Basic, such as the software features to run 
utilities or create conditional statements and loops in macros, are 
available when Macros\Basic is run with OMNIC or EZ OMNIC.  
 
 
The following manual conventions are used in this manual to help 
you learn about the software features and draw your attention to 
important information.  

Conventions 
used in this manual 

 
Bold type is used when you need to perform an action. 
 

 Note Notes contain helpful supplementary information.  

 Notice Follow instructions labeled “Notice” to avoid damaging the system 
hardware or losing data.  



 

  Caution Indicates a hazardous situation which, if not avoided, could result in 
minor or moderate injury.  

 
In case of emergency, follow the procedures established by your 
facility. If you have questions or concerns about safety or need 
assistance with operation, repairs or replacement parts, you can 
contact our sales or service representative in your area or use the 
information at the beginning of this document to contact us.  

Questions 
or concerns  

 
 
OMNIC Macros allows you to easily create macros that you can use 
with our OMNIC spectroscopy software. You can run macros from 
OMNIC by adding them to an OMNIC menu or the OMNIC toolbar. 
You can also run macros directly from Macros\Basic and from the 
Macros\Basic Macro Panel.  

About OMNIC Macros 

 
 
A macro is a series of OMNIC software operations, or tasks, which 
are joined together using OMNIC Macros. Once the macro has been 
created, the series of tasks can be executed from OMNIC as if they 
were a single OMNIC command. 

What is a macro? 

 
 
Macros\Basic is the macros creation portion of OMNIC Macros. It 
allows you to specify the tasks you want the macro to perform and 
allows you to join them together to create the macro. To build a 
macro, you point to the tasks that you want the macro to perform and 
then click the mouse button to add the tasks to the macro. 
Information on creating a macro is available in chapter 3, “Creating 
a Macro Using Macros\Basic.”  

What is Macros\Basic? 
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The Macro Panel is the portion of OMNIC Macros from which you 
can run many different kinds of macros. The Macro Panel consists of 
a set of macro buttons and macro control buttons. You can run a 
macro by selecting the macro from the Macro Panel and then 
clicking the Run Macro button. Information on running a macro 
from the Macro Panel is available in chapter 4, “Running Macros 
from the Macro Panel.” 

What is the Macro Panel? 

 
You also use the Macro Panel commands to assign macros to the 
Macro Panel. Information on assigning macros is available in 
chapter 5, “Assigning a Macro to the Macro Panel.” 
 

 Note It is often more convenient to run macros directly from OMNIC 
rather than using the macro panel. To run a macro from OMNIC, 
you must first add the macro to an OMNIC menu or the OMNIC 
toolbar. See Running a Macro from OMNIC later in this chapter for 
more information.  

 
 
Before you use the OMNIC Macros applications, you should be 
familiar with basic Windows® software operations such as pointing 
and clicking and working with the Windows Task Bar. You should 
also be familiar with OMNIC software operations. 

Using OMNIC Macros 

 
To try running macros, you can use the set of macros we’ve supplied 
with the OMNIC Macros software. These macros perform a number 
of basic data collection and plotting operations. The example macro 
set appears on the Macro Panel when you first start the Macro Panel 
application. You can also open these macro files in Macros\Basic to 
see how the macros were created. 
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There are several ways to start the Macros\Basic software as 
described below. For more detailed instructions on using Windows 
features, see your Windows documentation. 

Starting and 
quitting Macros\Basic 

 
To start Macros\Basic, do one of the following: 

• Double-click the Macros\Basic shortcut on your workstation 
desktop. 

  
-or- 
If the Macros\Basic shortcut does not appear on your desktop:  
• Open the Windows Start menu by choosing Start on the 

Windows taskbar. 
• Point to Programs in the Start menu. 
• Point to the Thermo Scientific OMNIC program group. 
• Choose the Macros\Basic program. 

• Double-click a file in Explorer: 

1. Use Explorer to locate a macro file or the OMMAC.EXE 
program file. 

2. Double-click the file to start Macros\Basic. If you double-
click a macro file, the macro contained in the file is displayed 
when Macros\Basic starts.  

 
 
To quit Macros\Basic, do one of the following: 

• Click the close box in the upper right corner of the Macros\Basic 
main window. 

• Choose Exit from the File menu. 
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There are several ways to start the Macro Panel as described below. 
For more detailed instructions on using Windows features, see your 
Windows documentation. 

Starting and 
quitting the Macro Panel 

 
To start the Macro Panel, do one of the following: 

• Open the Macro Panel program from the Start menu: 
• Open the Windows Start menu by choosing Start on the 

Windows taskbar. 
• Point to Programs in the Start menu. 
• Point to the Thermo Scientific OMNIC program group. 
• Choose the Macro Panel program. 

• Double-click the program file in Explorer: 

1. Use Explorer to locate a macro file or the MPANEL.EXE 
program file. 

2. Double-click the file to start the Macro Panel.  
 

 Note When you start the Macro Panel, OMNIC is started automatically if 
it is not already running. The OMNIC window may obscure the view 
of the Macro Panel. To view the Macro Panel, you may need to size 
or move the OMNIC window.  

 
To quit the Macro Panel, do one of the following: 

• Click the close box in the upper right corner of the Macro Panel. 

• Choose Exit from the File menu. 
 
 
When you have created a macro, you can run it from the Macro 
Panel, or directly from the OMNIC menu or toolbar. To add a macro 
to OMNIC’s menu or toolbar, see chapter 3, “Assigning a Macro to 
an OMNIC Menu or Toolbar.” Once you have added a macro to an 
OMNIC menu or the OMNIC toolbar, you can execute the macro just 
as you would any other OMNIC command or toolbar button. 

Running a 
macro from OMNIC  
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To run a macro from OMNIC, follow these steps: 
 
1. Choose the macro menu item or toolbar button. 
 
 The macro loads and runs. As the macro runs, it displays a status 

window that shows the status of the macro, including the names 
of the tasks as they execute. 

 
 

 
 
 
2. To stop the macro or exit a loop in the macro, click the 

appropriate buttons. 
 
 Clicking the Exit Loop button causes the macro to jump out of a 

loop prior to its normal completion, and displays an error 
message. This button is only enabled when the macro is 
executing tasks within a Start of Loop/End of Loop structure. 
There may be a time delay between clicking the Exit Loop 
button and the display of the error message. The macro continues 
to execute the tasks following the End of Loop task. 

 
 Clicking the Stop Macro button cancels execution of a macro 

prior to its normal completion, and displays an error message. 
There may be a time delay between clicking the Stop Macro 
button and the display of the error message.  

 
 
Macros\Basic and the Macro Panel include on-line help for both 
applications to give you easy access to information on how to use the 
OMNIC Macros software. Whenever you have a question about how 
to perform an operation, use Help to quickly find the information 
you’re looking for.  

Getting on-line help 
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Help information on using the Macro Panel and Macros\Basic is 
available from the Help menu. To access this information, choose 
Contents from the Help menu. The Macros Help Contents appears 
on the screen. The contents lists the available categories of help. To 
get help information for a particular topic, click the underlined text.  
 
When you are creating your macro, you can also access context-
sensitive help for setup dialog boxes and error messages by selecting 
the Help button in the dialog box. Help information for that dialog 
box will be displayed. 
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2 Creating a Macro Using Macros\Basic
 
 
 
Using OMNIC Macros\Basic, you can create macros which 
automate OMNIC software operations. Macros\Basic is flexible 
enough to allow you to create a macro which is highly interactive or 
a macro which requires very little interaction at run time.  
 
To create a macro, you specify the tasks to be performed by the 
macro and the parameter settings to be used for the operations. The 
tasks which can be added correspond directly with OMNIC software 
commands and operations. You can also add features such as loops 
for performing repetitive tasks and customized dialog boxes for 
presenting the operator with information or choices between several 
tasks. All of these features can be added to your macros by simply 
pointing to and clicking menu commands, tasks and task symbols in 
the Macros\Basic main window. 
 
This chapter provides an overview of the Macros\Basic working 
environment and features. It also covers procedures for creating, 
testing and saving macros.  
 
 
As described in the introduction to this manual, Macros\Basic is the 
macros creation portion of the OMNIC Macros package. Using 
Macros\Basic you can create, test, save, and print macros.  

Using Macros\Basic 
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There are several ways to start the Macros\Basic software. For more 
detailed instructions on using Windows features, see your Windows 
documentation. 

Starting and 
quitting Macros\Basic 

 
To start Macros\Basic, do one of the following: 

• Double-click the Macros\Basic shortcut on your Workstation 
desktop. 

  
-or- 
If the Macros\Basic shortcut does not appear on your desktop:  
• Open the Windows Start menu by choosing Start on the 

Windows taskbar. 
• Point to Programs in the Start menu. 
• Point to the Thermo Scientific OMNIC program group. 
• Choose the Macros\Basic program. 

• Double-click a file in Explorer: 

1. Use Explorer to locate a macro file or the OMMAC.EXE 
program file. 

2. Double-click the file to start Macros\Basic. If you double-
click a macro file, the macro contained in the file is displayed 
when Macros\Basic starts.  

 
 
To quit Macros\Basic, do one of the following: 

• Click the close box in the upper right corner of the Macros\Basic 
main window. 

• Choose Exit from the File menu. 
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When you open Macros\Basic, the Macros\Basic window appears on 
the display.  

About the 
Macros\Basic window  

The Macros\Basic window consists of these items (shown in the 
following illustration): 

• The menu bar. 

• The task list, which lists the tasks available for creating macros. 

• The find task box, which lets you quickly locate tasks in the task 
list. 

• The macro workspace, which displays a graphical representation 
of the tasks in the macro. 

• The page buttons, which let you view different pages of the macro 
in the workspace. 

• The status bar, which displays information about the selected task 
or command or about what the software is currently doing. 
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Menu bar Macro workspaceFind task box

Status bar Task list Page buttons
 

 
The Macros\Basic menu bar contains the Macros\Basic menu names. 
The commands in the Macros\Basic menus allow you to manage 
your macro files, edit macros, insert loops, dialog boxes and macros 
into a macro, test your macros and get on-line help. For information 
on the Macros\Basic commands, refer to the “Macros\Basic 
Command Descriptions” section of chapter 8, “OMNIC Macros 
Commands and Tasks.” 

The menu bar 
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The task list contains all of the tasks that can be added to a macro to 
perform OMNIC software operations. Most of the tasks in the task 
list correspond directly with the OMNIC commands of the same 
name. The task list is divided into sections which reflect the location 
of the task’s command in the OMNIC software menus. Tasks which 
do not correspond directly with OMNIC commands, such as 
selecting a spectrum, are listed under the Utilities section of the task 
list.  

The task list 

 
To select an item in the task list, click the task with the mouse or use 
the up and down arrow keys to highlight the task and then press 
Enter. You can also move to a task by typing the first character of 
the task name. If you need to change the focus to the task list, click 
one of the dashed lines between each group of tasks in the task list. 
When tasks are selected, they are added to the macro at the location 
of the insertion point in the workspace. 
 
 
The find task box quickly searches through all of the tasks using the 
characters or words you enter. To use the find task box, enter text 
contained in the name of the task you want to find and press Enter, 
or click the binocular button next to the find task box. To find the 
next occurrence of the text, press Enter again. When you locate the 
task you want, you can click the task name to add it to the macro 
workspace at the insertion point, or press Ctrl+Enter. 

The find task box 

 
 
The status bar is a line at the bottom of the Macros\Basic window 
that displays status information about the following: 

The status bar 

• When a menu is active, the status bar displays a short message 
describing the action the highlighted command performs. 

• When a task is highlighted in the task list, the status bar displays a 
short message describing the action the highlighted task performs. 

• When Macros\Basic needs to inform you of its progress or give 
you information following the completion of a command, it 
displays an informative message. 
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The macro workspace provides you with a graphical representation 
of the macro you are working on. When you add a task to the macro, 
the task is displayed as a task symbol in the workspace. The task is 
added to the macro at the location of the insertion point, which 
appears in the workspace as a dashed blue line. 

The macro workspace 

 
 

Task symbols Insertion point

 
 
 
When you add a task to a macro, the task symbol for the task appears 
in the macro workspace. Using the editing functions available in the 
Edit menu, you can cut, copy and paste task symbols to easily edit 
your macro. If the task symbol is red or blue, the task has associated 
parameters. Double-clicking the task symbols for these tasks allows 
you to set the task parameters. For example, double-clicking the 
Experiment Setup task symbol will display the Experiment Setup 
dialog box, allowing you to set the data collection parameters for 
subsequent data collection tasks.  

Task symbols 
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The insertion point is the blue dashed line which appears between 
task symbols in the macro workspace. The insertion point indicates 
where the next task you select will be placed in the macro. You can 
move the insertion point to a new location by clicking between the 
task symbols in the workspace at the new location.  

Insertion point 

 
 Note When a task symbol in the workspace is selected, the insertion point 

is removed from the workspace. Click between task symbols in the 
workspace to redisplay the insertion point.  
 
 
When each page of the macro workspace is filled with tasks, a new 
page is automatically generated. The page buttons beneath the 
workspace can be used to move to different pages of the macro. The 
function of each page button is indicated below. 

The workspace page buttons 

 
 Returns to the start of the macro. 

 Moves back two pages in the macro. 

 Moves back one page in the macro. 

 Moves forward one page in the macro. 

 Moves forward two pages in the macro. 

 Moves to the end of the macro. 

 
 
To create a macro, you specify the tasks that you want the macro to 
perform; then you set the parameters that control how the tasks are 
executed. After you have specified the functions of the macro, you 
can test and save the macro.  

Creating a macro 

 
Features which can be added to a macro include:  

• Tasks which correspond with OMNIC commands and operations. 

• Loops for repeating a series of tasks a specified number of times. 

• Comment dialog boxes for providing information for the operator 
at run time. 
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• If…Then conditions to allow certain tasks to run depending on 
the outcome of previous tasks. 

• Decision dialog boxes for providing the operator with several 
choices of operations at run time.  

• OMNIC Dynamic Data Exchange (DDE), which allows you to 
initiate commands, set parameters, or return a parameter value. 

• Existing macros. 
 
These features are added to the macro by selecting the tasks from the 
task list or by selecting commands from the Insert menu. Tasks in 
the task list are added by clicking the tasks. Loops, dialog boxes and 
macros are added to the macro by choosing the appropriate 
command from the Insert menu. 
 
You can also assign values to variables or use variables to store the 
results from a previous task. Once a variable is assigned, you can use 
it in subsequent tasks in the macro.  
 
The following procedure describes the steps involved in creating a 
macro. Details on each step are provided in the sections following 
this procedure.  
 
To create a macro: 
 
When you first start Macros\Basic, only the Start and End task 
symbols appear on the display. This indicates that the Macros\Basic 
program is ready to create a macro. 
 
1. If you have already created a macro and want to create 

another one, choose New from the File menu.  
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2. Position the insertion point in the macro at the point where 

you want to add the task or Insert menu option. Then select 
the features from the task list or the Insert menu that you 
want to add to the macro.  

 
 As each feature is added, the task symbol for the task or Insert 

option is placed in the workspace at the position of the insertion 
point.  

 
 
3. Set the task parameters so that the tasks will operate as 

desired at run time.  
 
 Some tasks have parameters which must be set in order for the 

macro to compile and run. The task symbols for tasks with 
parameters which must be set are displayed in red until you set 
the parameters. Other tasks may have parameters which can be 
changed but do not need to be set in order for the macro to run. 
The task symbols for tasks with parameters which can be 
changed are displayed in blue. The task symbols for tasks which 
have no settable parameters are displayed in black. To change 
the parameters associated with a task, double-click the task 
symbol. The setup dialog box for that task will appear in the 
workspace. Enter the parameter values that you want and then 
choose OK. 

 
 Note At this point you can try out the macro using the Test command, or 

you can save the macro using the Save command. When you choose 
either command, the macro will first be compiled. Errors that are 
found in the macro during compilation are indicated with error 
messages along with possible sources of the error.  
 
 
4. To test the macro, choose Test from the Macro menu.  
 
 If errors are found during compilation, you must correct the 

errors before you can continue to test the macro. The macro is 
then run as it will operate at run time. All of the tasks in the 
macro will be executed. 
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5. To save the macro you just created, choose Save from the 

File menu.  
 
 The macro is compiled before it is saved. If errors are found 

during compilation, you can choose to save the macro without 
correcting the errors; however, the macro will not execute if you 
try to run it. You can open the macro later and fix the errors.  

 
 
6. When the macro is finished compiling, enter a file name for 

the macro and choose OK.  
 
 
7. Enter the optional Comments, Author or Title in the 

Summary Info dialog box and then choose OK.  
 
 
8. If you turned on the Password check box, type a password in 

the Enter Password dialog box and then choose OK. 
 
 You will be asked to verify the password by entering it again. 
 
In order to run the macro you just created, you can add it to 
OMNIC’s menu or toolbar, or you can assign it to a Macro Panel 
button. Using OMNIC’s menus and toolbar provides the easiest 
method for running macros. For information on how to assign a 
macro to an OMNIC menu or toolbar, see chapter 3, “Assigning a 
Macro to an OMNIC Menu or Toolbar. For information on how to 
assign a macro to a Macro Panel button, see chapter 5, “Assigning a 
Macro to the Macro Panel.” 
 
 
The tasks in the task list correspond to OMNIC commands and 
operations. As tasks are selected, the task symbol for the task is 
placed in the workspace at the position of the insertion point. When 
the macro is run, the tasks are executed in the order they appear in 
the macro. 

Adding tasks to a macro 
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To add a task to a macro: 
 
1. Click between existing tasks in the workspace at the point 

where you want to add the new task.  
 
 The insertion point will move to the selected location. 
 
 
2. Click the task in the task list to add it to the macro.  
 
 The task symbol for the task appears in the workspace. 
 
When adding tasks to macros, keep in mind that some tasks will fail 
at run time unless certain conditions are met. For example, two 
spectra must be selected in order for an Add task to execute at run 
time. In this case, you must make sure that two Select Spectrum 
tasks appear in the macro before the Add task. For information on 
the requirements for each Macros\Basic task, refer to the 
“Macros\Basic Task Descriptions” section of chapter 8, “OMNIC 
Macros Commands and Tasks.” 
 
In addition, you can specify how the tasks are executed at run time 
by setting the parameters associated with the task. For example, by 
setting the Baseline Correct task parameters, you can specify 
whether to perform an automatic or manual baseline correction. For 
information on how to set these parameters, refer to the “Modifying 
the Parameters Associated with a Task” section of this chapter. For 
information on the parameters associated with each task, refer to the 
“Macros\Basic Task Descriptions” section of chapter 8, “OMNIC 
Macros Commands and Tasks.” 
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You can edit your macro using the Cut, Copy and Paste commands. Cutting, copying and 

pasting tasks in a macro  
To cut a task from a macro: 

1. Select the task by clicking the task symbol in the workspace.  

 If you want to cut more than one task from the macro, hold down 
the Ctrl key and make additional selections. You can use the 
Shift key to select contiguous tasks. 

 
2. Choose Cut from the Edit menu or press Ctrl + X to remove 

the selected task(s) from the macro.  

 The tasks are placed on the Clipboard and remain there until a 
different task is cut or copied. 

 
 
To copy tasks in a macro: 

1. Select the task you want to copy by clicking the task symbol 
in the workspace.  

 If you want to copy more than one task, hold down the Ctrl key 
and make additional selections. You can use the Shift key to 
select contiguous tasks. 

 
2. Choose Copy from the Edit menu or press Ctrl + C to copy 

the selected task(s).  

 The copied tasks are placed on the Clipboard and remain there 
until a different task is cut or copied. 

 
 
To paste tasks in a macro: 

1. Position the insertion point by clicking in the workspace at 
the point where you want to paste the task(s). 

 
2. Choose Paste from the Edit menu or press Ctrl + V.  

 The tasks which are on the Clipboard are pasted into the macro 
at the insertion point. 
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Some tasks have parameters which must be set in order for the 
macro to run. The task symbols for tasks with parameters which 
must be set are displayed in red until you set the parameters. Other 
tasks may have parameters which can be changed but do not need to 
be set in order for the macro to run. The task symbols for tasks with 
parameters which can be changed are displayed in blue. The task 
symbols for tasks which have no settable parameters are displayed in 
black. 

Modifying the parameters 
associated with a task 

 
 Note For information on the parameters associated with a task, check the 

entry for the task in the “Macros\Basic Task Descriptions” section of 
chapter 8, “OMNIC Macros Commands and Tasks.”  
 
To modify the parameter settings associated with a task: 
 
1. Double-click the task symbol for a task that has settable 

parameters.  
 
 Task symbols for tasks which have settable parameters will be 

displayed in red or blue. When you double-click a red or blue task 
symbol, the setup dialog box for the task will appear on the 
display. 

 
 
2. Set the parameters.  
 
 To change the focus to a specific parameter in the setup dialog 

box using the keyboard, hold down the Alt key and press the 
underscored character in the parameter name. If the parameter is 
an option or a check box, using the Alt + underscore key 
combination will turn the option or check box on or off. 

 
 
3. Choose OK when the parameters are set as you want them. 
 
 These parameter settings will control the operation of the task 

when the macro is run. 
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 Note The task symbols for tasks which have required parameters will 

change from red to blue once the required parameters have been 
set.  
 
 
Variables can be used to store information and task results in a 
macro and to carry out mathematical calculations. Macros\Basic 
provides you with three types of variables:  macro variables, the 
Result variable, and the Index variable. 

Using variables in macros 

 
Macro variables are containers, defined at development time, that 
can hold nearly any type of information:  numbers, text strings and 
comma separated lists, for example. You can define up to 65535 
macro variables in a macro. The capability of the Math task allows 
you to parse the content of macro variables which contain multiple 
items, characters, words, and lines of text. 
 
The Result variable is used by Macros\Basic to store the results of 
the most recently completed task. You may find it useful to access 
the Result variable to find the results of tasks such as:  Average, 
Find Peaks, Noise, Peak Height, Peak Area, Quantify, and Search. 
Each time the macro executes one of these tasks, the current value of 
the Result variable is overwritten. 
 
The Index variable is the iteration number in a loop. This variable 
exists only within a loop, but you can use it to access the current 
loop count. 
 
Macro variables and the Result variable can be used in all tasks that 
have settable parameters. 
 
 
Most tasks allow you to use macro variables. Whenever you open a 
task that accepts macro variables, the Macro Variable viewer is 
automatically opened. To add a macro variable reference, just click a 
line in the Macro Variable viewer and a reference is added at the 
insertion point in the dialog.  

Displaying a list 
of assigned variables 
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You can also view all of the macro variables you have assigned by 
using the Show Macro Variables command in the Macro menu. 
Selecting the command once opens the macro variable viewer 
window.  
 

 
 
Close the viewer by either choosing Show Macro Variables again 
from the Macro menu, or closing the viewer window directly. 
 
 
Macro variables, Result variable and the Index variable can be used 
in all tasks that have settable parameters. To add the current value of 
a macro variable to a task, use the placeholder #mv?#, where ? is the 
number assigned to the macro variable whose value you want to 
include. To add the current value of the Result variable to a task, 
type the placeholder #result# in the text box displayed in the setup 
screen for the task. To add the current value of the Index variable to 
a task, type the placeholder #index# in the text box displayed in the 
setup screen for the task. 

Using variables in macro tasks 

 
For example, if you want to use macro variable 1 to specify the 
number of loop cycles, type the placeholder #mv1# in the Number of 
Times to Execute Loop box. If the value of macro variable 1 at run 
time is equal to 14, the loop will be executed 14 times. Think of the 
“#mv?#” notation as meaning “value of mv?”. For example, #mv7# 
means “substitute the current value of macro variable mv7 here”. 
 

 Note If you use the Result variable in a task, make sure you add the task 
to the macro immediately following the task that places its results in 
the Result variable. For descriptions of the tasks which place their 
results in the Result variable, see the section “Macros\Basic task 
descriptions” in chapter 8, “OMNIC Macros Commands and 
Tasks.”  
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 Note The Index variable exists only within the loop that is executing. In 

nested loops, it is the value of the imminent loop index.  
 
 

Loops can be used in macros to repeat a task or series of tasks a 
specified number of times. For example, if you want to collect ten 
spectra and add the spectra to a library, you could create a loop 
which would execute ten times and include a Collect Sample task 
and a Add to Library task in the loop.  

Adding a loop to a macro 

 
When you add a loop to a macro, you need to specify the location of 
the loop and the tasks to be included in the loop. You can also set up 
a loop to pause at the end of each loop cycle at run time and to stop 
if a certain condition is met. For example, if you want to collect a 
background spectrum periodically until the moisture level in the 
sample compartment is less than some value, you could write a 
macro loop that includes a Peak Height task to measure the water 
band in each background spectrum followed by a Store Result task 
to save the peak height result in a macro variable. Then you can 
enter the macro variable as the end-of-loop condition and set the 
condition value to the maximum allowable peak height for water in 
the background spectrum.  
 
If a pause is included in the loop, you are given the option at run 
time to continue or exit the loop at the end of each loop cycle. 
 
If an end-of-loop condition is set, the macro will check whether the 
condition is true at the end of each loop cycle and exit the loop 
without completing the full number of iterations specified by the 
Start of Loop task if the condition is true.  
 
To add a loop to a macro: 
 
1. Position the insertion point in the workspace where you want 

to add the loop. 
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2. Choose Loop from the Insert menu. 
 
 The Start of Loop setup dialog box is displayed. 
 

  
 

 
3. Enter the number of times to execute the loop.  
 
 You can choose to have the loop run a defined number of times, 

or to loop through all the spectra in a window.  
 
 If you choose to loop the macro a defined number of times, 

choose the Number Of Times To Execute Loop button. You can 
enter a number, or you can use a macro variable by typing a 
placeholder for the macro variable in the Number of Times to 
Execute Loop box. For example, if you want to use macro 
variable 1 to specify the number of loop cycles, select the value 
in the Number Of Times To Execute The Loop box, then click 
mv1 in the Macro Variable window. If the value of macro 
variable 1 at run time is equal to 14, the loop will be executed 14 
times. 

 
 If you want to loop through all of the spectra within a window, 

choose the Loop Through All Spectra Currently In Window 
button. This option applies each task in the loop to each spectra 
in the currently selected window. The macro does not affect any 
spectra added to the window while executing the loop. If loops 
are nested, only one can use the Loop Through All Spectra 
Currently In Window option. 

 

OMNIC Macros User’s Guide       25 
 



 
 If you want the macro to pause at run time after each iteration of 

the loop, turn on the Pause After Each Loop Cycle check box. 
Then choose OK. The Start of Loop and End of Loop task 
symbols appear in the workspace. The Start of Loop task symbol 
indicates the number of times the loop will be executed. If the 
word “All” appears, the macro will loop through all the spectra 
in the currently selected window. The insertion point is 
positioned between the Start of Loop and End of Loop tasks. 

 
 
4. Select the tasks that you want to be included in the loop.  
 
 You can also cut and paste the Loop tasks to move them within 

the macro. 
 
 
5. If you want to specify an end-of-loop condition, double-click 

the End of Loop task symbol. 

 The End of Loop setup dialog box is displayed.  
 

  
 

 Define a condition to end the loop. A valid condition uses a 
logical operator to evaluate two expressions. The result of the 
evaluation is either true or false. An expression may be a macro 
variable reference, a number, a text string or another expression. 
Text strings must be enclosed in quotes if they contain a space. 
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 To specify a macro variable, enter it in the form “#mv?#” where 

? is the number of the macro variable, or click a defined macro 
variable displayed in the Macro Variables window. To specify an 
operator, enter any common arithmetic operator (for a complete 
list of operators, see the Loop command description). A 
placeholder for the macro variable you select will be placed at 
the end of any existing text in the box. 

 When you are finished specifying the end-of-loop condition, 
choose OK.  

 Note Once the loop has been defined, you can change the Start of Loop 
and End of Loop parameter settings by double-clicking the Start of 
Loop or End of Loop task symbol.  

 
 

If…Then structures can be used within a macro to allow certain 
tasks to execute based on the outcome of previous tasks. Using the 
If…Then, Else and End If tasks, you can carry out one set of tasks if 
a condition is true (If branch), and another set of tasks if the 
condition is false (Else branch). For example, to collect and save 
spectra that meet a certain noise requirement, you could test for the 
noise level, then use the If…Then command to save the spectrum if 
it met the requirement.  

Adding an If…Then 
structure to a macro 

 
When you add an If…Then structure to a macro, you need to specify 
the condition to be met for the If branch tasks to be carried out. You 
can also choose to specify a set of tasks to carry out if the condition 
is not met. For example, if a spectrum does not meet the noise level 
requirement, a dialog box could be displayed alerting the operator. 
 
To add an If…Then structure to a macro: 
 
1. Position the insertion point in the workspace where you want 

to add the If…Then structure. 
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2. Choose If…Then from the Insert menu.  
 
 The If…Then dialog box is displayed. 
 

  
 
 
3. Enter the condition to meet for the tasks to continue.  

 Define a condition to execute the If branch of the If…Then 
structure. A valid condition uses a logical operator to evaluate 
two expressions. The result of the evaluation is either true or 
false. An expression may be a macro variable reference, a 
number, a text string or another expression. Text strings must be 
enclosed in quotes if they contain a space. 

 To specify a macro variable, enter it in the form “#mv?#” where 
? is the number of the macro variable, or click a defined macro 
variable displayed in the Macro Variables window. To specify an 
operator, enter any common arithmetic operator (for a complete 
list of operators, see the Loop command description). A 
placeholder for the macro variable you select will be placed at 
the end of any existing text in the box. 

 When you are finished specifying the If…Then condition, 
choose OK. 
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4. Select the tasks that you want to be included when the 

If…Then condition is true.  
 
 You can also cut and paste tasks to move them within the macro. 

If the condition specified in the If…Then task is met when you 
run the macro, the tasks immediately following the If branch of 
the If…Then task will be executed.  

 
 
5. Position the insertion point after the Else task and select the 

tasks that you want to be included when the If…Then 
condition is false. 

 
 You can set up your macro to carry out one set of tasks if a 

condition is true (If branch), and another set of tasks if the 
condition is false (Else branch). If the condition specified in the 
If…Then task is not met when you run the macro, the tasks 
immediately following the Else task will be executed. 

 
 Note The Else task is optional. If you want the macro simply to continue 

if the If…Then condition specified in the If…Then task is not met 
rather than execute another set of tasks, delete the Else task.  
 
 
A dialog box which provides information for an operator at run time 
can be added to a macro using the Comment command in the Insert 
menu. The run time dialog box will display the message until the 
operator chooses OK. 

Adding a comment 
dialog box to a macro 

 
The comment text can include placeholders for macro variables or 
for the Result variable. At run time, the current value of the macro 
variable or the Result variable will replace the placeholder in the 
comment dialog box. If you include the Result variable in the 
Comment text, make sure you add the Comment task to the macro 
immediately following the task whose result you want to include.  
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To add a comment dialog box to a macro: 
 
1. Position the insertion point in the macro where you want the 

Comment dialog box to appear. 
 
 
2. Choose Comment from the Insert menu.  
 
 The Comment setup dialog box appears. 
 

  
 
 
3. Enter the text you want to be displayed when the macro is 

run.  
 
 To include the current value of the Result variable in the 

comment text, type the placeholder #result# in the Text of 
Comment box. To include the current value of a macro variable 
in the comment text, click its name in the Macro Variables 
window. A placeholder for the macro variable you select will 
appear at the end of any existing text in the Text of Comment 
box. 

 
 
4. Enter the text you want to be displayed as the caption for the 

comment dialog box, and then choose OK.  
 
 This is the text that is displayed in the title bar of the comment 

dialog box at run time. 
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 Comment dialog boxes can display any number of characters. If 

you include the results of a Find Peaks or Search task in a 
comment, the comment dialog box will automatically add scroll 
bars, letting you view all of the data.  

 
 Note You can view or change the comment text at any time by double-

clicking the Comment task symbol.  
 
 
The Decision command in the Insert menu allows you to create your 
own dialog boxes with prompt text and up to three buttons. Selecting 
these buttons at run time executes a task or series of tasks which you 
specify when you add the decision task to the macro.  

Adding a decision 
dialog box to a macro 

 
The Decision prompt text can include placeholders for macro 
variables or for the Result variable. At run time, the current value of 
the macro variable or the Result variable will replace the placeholder 
in the Decision dialog box. If you include the Result variable in the 
Decision prompt, make sure you add the Decision task to the macro 
immediately following the task whose result you want to include.  
 
To add a decision dialog box to a macro: 
 
1. Position the insertion point in the macro where you want the 

decision dialog box to appear. 
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2. Choose Decision from the Insert menu. 
 
 The Decision setup dialog box appears. 
 

  
 
 
3. Type the text you want displayed at run time in the Prompt 

text box.  
 Decision prompts can display any number of characters. The 

prompt text should indicate the choices available in the dialog 
box and should give an indication of the results of each choice. 

 To include the current value of a macro variable in the prompt 
text, type the placeholder #mv?# in the Prompt box, where ? is 
the number assigned to the macro variable whose result you want 
to include, or click its name in the Macro Variable window. To 
include the current value of the Result variable in the prompt 
text, type the placeholder #result# in the Prompt box. To include 
the current value of the Index variable in the prompt text, type 
the placeholder #index# in the Prompt box. 
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4. Click in the Label box for Button 1 and type the label for 

that button. 
 The label you enter will appear on the button in the run time 

decision dialog box. If you want to define an underscore 
character for choosing the button from the keyboard, place the 
“&” character before the chosen letter in the button label. For 
example, to set up the key combination Alt + C for a Cancel 
button, type the label “&Cancel”. 

 
 
5. Click in the Action box for Button 1 and then select the tasks 

you want associated with that button from the task list.  
 The tasks appear in the list in the order in which you select them. 
 
 
6. Parameters associated with the tasks added to the Action box 

can be set by double-clicking the task name in the Action box.  
 The cursor changes to a box when it is moved over a task in an 

Action box with settable parameters. Tasks with parameters 
which must be set appear in red and begin with an asterisk (*) 
when they are added to the Action box. Tasks with parameters 
which can be set but do not need to be set in order for the macro 
to run appear in blue when they are added to the Action box. 

 
 
7. Repeat steps 4, 5 and 6 for Button 2 and Button 3.  
 You can also choose to define only one or two buttons for the 

decision dialog box if you want to limit the options available at 
run time. 

 
 
8. When each button has been defined, choose OK. 
 

 Note You can view or change the Decision prompt text or the Decision 
task parameters at any time by double-clicking the Decision task 
symbol.  
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When the macro is run, the decision dialog box will be displayed 
with the prompt text and the buttons you have defined in the macro. 
The illustrations on the following page show a decision dialog box 
and the setup screen used to create it. 
 
The following illustrations show the decision setup screen and the 
resulting decision dialog box at run time. 
 
 

 
 
 
The decision setup screen illustrated above will result in the 
following Decision dialog box at run time. Clicking the buttons in 
the dialog box below will carry out the tasks specified in the action 
boxes in the previous illustration. 
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Macros that have been created, compiled and saved in the 
Macros\Basic application can be added to a macro using the Macro 
command in the Insert menu. You can also use the Macro command 
to add executable files created with a program such as Visual Basic. 
If you add an executable file to a Macros\Basic macro, the OMNIC 
Macros application (either Macros\Basic or Macro Panel) will 
suspend execution of the calling macro until the executable file 
finishes or tells OMNIC Macros to resume.  

Calling an existing 
macro or executable 

from a macro 

 
You can use macro variables to specify the names of macro files. To 
add a macro variable to a file name, use the placeholder #mv?#, 
where ? is the number assigned to the macro variable whose value 
you want to include. The placeholder will be replaced by the current 
value of the macro variable at run time.  
 
To add an existing macro to a macro: 
 
1. Position the insertion point where you want to add the 

macro. 
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2. Choose Macro from the Insert menu. 
 
 The Macro setup dialog box will appear on the screen. 
 

  
 
 
3. Type the name of the macro in the File Name box or choose 

Browse to select the macro from the list of macro or 
executable files available. 

 
 If you do not specify a DOS path with the file name, the macro 

subdirectory of the OMNIC directory will be used. You can also 
choose the Browse button to display a dialog box that allows you 
to locate and select the macro. 

 
 
4. Choose the File Type. 
 
 Choose Macro if you wish to call a Macros\Basic macro 

(.MAC). Choose Executable if you wish to run an application 
file such as a routine created with Visual Basic. 
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 If you choose to call an Executable file, you can also append a 

command line argument containing values you want to send to 
the called application. For example, you could choose to call the 
executable “run.exe” and append the command line argument 
“abc.txt.” This would be the same as using the Windows Run 
command to execute the file “abc.txt.” 

 
 
5. Choose to call the macro as a function. 
 
 If you choose to call a macro, you can choose Call Macro As A 

Function to call the macro as a function. Calling a macro as a 
function lets you can pass values between the macros. The Store 
Arguments and Return Value tasks provide a mechanism for 
sharing values between macros when used with the Macro 
command. When a macro is called as a function, it is the 
responsibility of the function macro to seize the arguments 
passed to it and set the return value. For more information, see 
the descriptions for these tasks in chapter 8, “OMNIC Macros 
Commands.” 

 
 
6. Verify the pathname of the macro to use, then choose OK. 
 
 If you choose OK, a Macro task symbol will appear in the 

workspace. 
 

 Note You can select a different macro to be associated with this Macro 
task by double-clicking the Macro task symbol and selecting a new 
macro file.  
 
 
You can define global parameters for your macros by setting 
options. Use the Options command to specify how the current macro 
affects OMNIC, to set password protection for this macro and to 
define the default format for numerical values displayed in 
Macros\Basic dialog boxes.  

Customizing a macro 
by setting options 
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To specify options for the current macro:   
 
1. Choose Options from the Macro menu. 
 
 
2. Turn on the Reset OMNIC Parameters When Macro Ends 

check box if, after running the macro, you want the macro to 
reset OMNIC parameter values to the values they had before 
the macro was executed. 

 
 
3. Turn on the Password Protect This Macro check box if you 

wish to use a password to protect this macro from being 
changed.  

 
 When this check box is selected, the software will ask for a 

password the next time you save the macro. After a macro is 
saved with a password, the macro will run without requiring a 
password but the software will ask for the password before 
allowing the macro to be opened for editing. 

 
 
4. Enter a valid format for displaying numerical values in 

Macros\Basic dialog boxes in the Default Format For 
Numerical Values entry box.  

 
 Use zeros to set up your default format if you want Macros\Basic 

to add zeros to the number when it has fewer digits than the 
format specifies. Use the pound sign (#) to set up your default 
format if you want to specify the number of significant digits but 
don’t want Macros\Basic to add zeros. For example, if you want 
the number 24.123 to be displayed as 24.12, enter “#.##” in the 
Default Format text box. 

 
 
5. When you are finished setting options, choose OK. 
 
 The next time you save the macro, it will include the new 

settings for the global parameters. 
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After you have created your macro, you can test the macro. When 
you test the macro, the macro code is first compiled; then the macro 
is run as it will appear to the operator at run time.  

Testing a macro 

 
If errors are found during compilation, they are reported and the test 
is canceled. You must correct the errors before you can proceed with 
the test. The source of the error is indicated in the error message that 
is displayed. Help information on the source of the error and 
possible solutions can be displayed from the error message dialog 
box. When you close the error message dialog box, the task symbol 
for the task that caused the error will be highlighted in the macro 
workspace.  
 
To test the current macro: 
 
Choose Test from the Macro menu.  
 
If errors are found in the macro, they are reported and the test is 
canceled. If no errors are found, the macro is run as it will appear to 
the operator at run time. 
 

 Note When you test or run a macro, the current OMNIC settings are saved 
before the macro is run, and then are restored after the macro has 
completed.  
 
 
Before a macro is saved, it is first compiled. If errors are found 
during compilation, they are reported and you are given the option of 
saving the macro with errors or canceling the Save command. If you 
choose to save the macro, the macro will not execute if you try to 
run it. However, you can open it later to fix the errors. The source of 
the error is indicated in the error message that is displayed. Help 
information on the source of the error and possible solutions can be 
displayed from the error message dialog box. When you close the 
error message dialog box, the task symbol for the task that caused 
the error will be highlighted in the macro workspace.  

Saving a macro 
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To save the current macro: 
 
1. Choose Save from the File menu.  
 
 If errors are found during compilation, you are given the option 

of saving the macro with errors or canceling the Save command. 
If the macro has been previously saved, it will be saved with the 
current file name. If the macro has not been previously saved, the 
Save As dialog box will appear.  

 
 
2. If the Save As dialog box is displayed, enter a file name for 

the macro in the File Name text box and then choose OK. 
 
 
3. Enter the optional Comments, Author or Title in the 

Summary Info dialog box and then choose OK.  
 
 These comments are displayed in the Macro Panel when this 

macro is selected. 
 
 
4. If the Enter Password dialog box appears on the display, type 

a password and then choose OK. 
 
 You will be asked to verify the password by entering it again. If 

you enter a password, the Macros\Basic program will require the 
password to be entered before opening the macro for editing. 

 
 The password feature is controlled by the Password Protect This 

Macro check box in the Options dialog box. See “Customizing A 
Macro By Setting Options” in chapter 2 “Creating A Macro 
Using Macros\Basic” for details.  
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3 Assigning a Macro to an OMNIC 

Menu or Toolbar 
 
 
 
The easiest way to quickly run macros you create with Macros\Basic 
is to assign the macro to a menu command or toolbar button within 
OMNIC. Your macros are then always available whenever you run 
OMNIC. 
 
This chapter describes how to assign macros to the OMNIC menu 
and toolbar. 
 
 
The Edit Menu command in the OMNIC Edit menu allows you to 
customize the menus by adding macro commands. Adding a macro 

to an OMNIC menu  
To assign a macro to the OMNIC menus, follow these steps: 
 
1. In OMNIC, choose Edit Menu from the Edit menu. 
 
 The Edit Menu dialog box appears listing every item in each 

OMNIC menu. 
 
 



 
2. Choose Add Item to add the macro to the menus. 
 
 The Menu Item dialog box appears. 
 

 
 
 
3. Choose Run Basic Macro under Item Type. 
 

  
 
 
4. Select the macro file. 
 
 Type the complete pathname of your macro file in the Macro 

pathname box. If you do not specify a DOS path with the file 
name, the macro subdirectory of the OMNIC directory will be 
used. You can also choose the Browse button to display a dialog 
box that allows you to locate and select the macro. Macro files 
have the extension .MAC. 
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5.  Enter the menu information. 
 
 Select from the Menu drop down list the menu to which you 

want the item added. 
 
 Type in the Menu text box the name of the macro exactly as you 

want it to appear in the menu. If you want to define an 
underscore character for choosing the command from the 
keyboard, place the “&” character before the chosen letter in the 
command label. For example, to use the N in the macro name 
“Noise Macro,” type “&Noise Macro” in the text box. 

 
 Choose OK to confirm the Menu Item dialog. Then choose OK 

to confirm the Edit Menu dialog. 
 
 
6. Choose Save Configuration As in the File menu to save your 

menu changes. 
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The Edit Toolbar command in the OMNIC Edit menu allows you to 
customize the toolbar by adding buttons to initiate macros. Adding a macro to 

the OMNIC toolbar  
To assign a macro to the OMNIC toolbar, follow these steps: 
 
1. In OMNIC, choose Edit Toolbar from the Edit menu. 
 
 The Edit Toolbar dialog box appears showing the standard 

button library and the current toolbar. 
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2. Choose Add Item to add the macro to the toolbar. 
 
 The Add Toolbar Item dialog box appears. 
 

  
 
 
3. Choose Run Basic Macro under Item Type. 
 
 
4. Select the macro file. 
 
 Type the complete pathname of your macro file in the Macro 

Pathname box. If you do not specify a DOS path with the file 
name, the macro subdirectory of the OMNIC directory will be 
used. You can also choose the Browse button to display a dialog 
box that allows you to locate and select the macro. Macro files 
have the extension .MAC. 
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5. Enter the button name and icon information. 
 
 Click in the Item Name text box and type the name you want to 

assign to the new button. Once the button is added to the toolbar, 
you can point to the button and hold down the right mouse 
button to display its assigned name. 

 
 To select the icon that will be displayed on the new button, click 

the Browse button in the Icon/Bitmap box. A dialog box appears 
that allows you to locate and select a file that contains a bitmap 
or icon image. When you select a file, the image it contains 
appears as a button. When you are finished selecting a file, 
choose OK. The new button appears in the Icon/Bitmap box. 

 
 Choose OK to close the Add Toolbar Item dialog box. 
 
 
6. Click and drag the macro button to the toolbar. 
 
 Click the new button as it is displayed in the User Item box and 

drag the button to the desired location in the Current Toolbar 
box. Then choose OK. 

 
 
7. Choose Save Configuration As in the File menu to save your 

toolbar changes. 
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Once you have added a macro to an OMNIC menu or the OMNIC 
toolbar, you can execute the macro just as you would any other 
OMNIC command or toolbar button. 

Running a 
macro from OMNIC  

 
To run a macro from OMNIC, follow these steps: 
 
1. Choose the macro menu item or toolbar button. 
 
 The macro loads and runs. As the macro runs, it displays a status 

window that shows the status of the macro, including the names 
of the tasks as they execute. 

 

  
 
 
2. To stop the macro or exit a loop in the macro, click the 

appropriate buttons. 
 
 Clicking the Exit Loop button causes the macro to jump out of a 

Loop prior to its normal completion, and displays an information 
message. This button is only enabled when the macro is 
executing tasks within a Start of Loop/End of Loop structure. 
The macro continues to execute the tasks following the End of 
Loop task. 

 
 Clicking the Stop Macro button cancels execution of a macro 

prior to its normal completion, and displays an information 
message. 
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4 Running Macros from the Macro 

Panel 
 
 
 
The Macro Panel allows you to run macros you create in 
Macros\Basic by pressing just a few buttons. First, you select the 
macro from the Macro Panel. Then you start the macro by clicking 
the Run Macro button.  
 
This chapter provides an overview of the Macro Panel operation and 
procedures for running macros from the Macro Panel. OMNIC also 
has the capability of running macros directly from the toolbar or 
menus. See Chapter 3 “Assigning a Macro to an OMNIC Menu or 
ToolBar” for more information. 
 
 

Using the Macro 
Panel in select mode 

The Macro Panel is a “panel” of buttons which can be used to run 
macros. The Macro Panel has two modes of operation:  the select 
macros mode and the assign macros mode. In select mode, the 
Macro Panel can be used to select and run macros. In assign mode, 
you can assign macros to the macro panel buttons. This chapter 
explains how to use the Macro Panel in the select macro mode. For 
information on using the Macro Panel in the assign macro mode, 
refer to chapter 5, “Assigning a Macro to the Macro Panel.” 
 
 
There are several ways to start the Macro Panel. For more detailed 
instructions on using Windows features, see your Windows 
documentation. 

Starting and 
quitting the Macro Panel 
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To start the Macro Panel, do one of the following: 

• Open the Macro Panel program from the Start menu: 
• Open the Windows Start menu by choosing Start on the 

Windows taskbar. 
• Point to Programs in the Start menu. 
• Point to the Thermo Scientific OMNIC program group. 
• Choose the Macro Panel program. 

• Double-click the program file in Explorer: 

1. Use Explorer to locate a macro file or the MPANEL.EXE 
program file. 

2. Double-click the file to start the Macro Panel.  
 

 Note When you start the Macro Panel, OMNIC is started automatically if 
it is not already running. The OMNIC window may obscure the view 
of the Macro Panel. To view the Macro Panel, you may need to size 
or move the OMNIC window.  

 
To quit the Macro Panel, do one of the following: 

• Click the close box in the upper right corner of the Macro Panel. 

• Choose Exit from the File menu. 
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When the Macro Panel is initially displayed, it appears in the select 
macros mode. In select mode, the Macro Panel consists of the Macro 
Panel menu bar, the macro buttons, and the macro control buttons.  

About the Macro Panel 

 
 

Menu bar Macro buttons Macro control buttons

 
 

The menu bar The menu bar contains the Macro Panel menu names. In select 
macros mode, the menu commands allow you to quit the Macro 
Panel application, display a directory of assigned macros, and get 
help on using the Macro Panel.  
 
 

The macro buttons The macro buttons allow you to select the macro to be run. The 
macro buttons are saved in sets consisting of seven buttons. 
Different sets of macro buttons can be displayed by clicking the 
Next Set button. 
 
 
The macro control buttons have the following functions. The macro control buttons 
 
Next Set - Displays the next set of macro buttons.  
Run Macro - Runs the currently selected macro. 
Exit Loop - Exits a loop before the loop has been executed the 
specified number of times without stopping the macro. 
Stop Macro - Stops the execution of the macro. 
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Macros can be run from the Macro Panel by selecting the macro 
button with the mouse and then choosing the Run Macro button. A 
macro can also be run by pressing the function key that corresponds 
with the macro button. You can use the function keys to run macros 
when either the Macro Panel or the OMNIC window is active.  

Running a macro 
from the Macro Panel 

 
The function keys F2 through F8 correspond with the following 
macro buttons. The F1 key is reserved for Help; it cannot be 
assigned to a macro.  
 
 

 
 
 
To run a macro from the Macro Panel: 
 
1. Make sure the Macro Panel is in the select macros mode.  
 
 To switch to select mode, choose Select Macros from the 

Options menu. 
 
 
2. If the macro you want to run is not in the currently displayed 

set of macro buttons, click the Next Set button to display the 
next set of macro buttons. 

 
 
3. Select the macro you want to run by clicking the macro 

button for that macro.  
 
 When you select the macro, the macro description appears in the 

message box beneath the macro buttons. 
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4. Click the Run Macro button to run the selected macro.  
 

 Note You can exit a loop during the execution of a macro without 
stopping the macro by clicking the Exit Loop button. You can stop 
the macro by clicking the Stop Macro button.  
 
 
To use the function keys to run a macro from the Macro Panel: 
 
1. Make sure the Macro Panel is in the select macros mode.  
 
 To switch to select mode, choose Select Macros from the 

Options menu. 
 
 
2. If the macro you want to run is not in the currently displayed 

set of macro buttons, click the Next Set button to display the 
next set of macro buttons. 

 
 
3. Press the function key which corresponds with the macro you 

want to run to start the macro.  
 
 For example, if the following set of macro buttons were 

displayed, pressing the F4 function key would run the Scan & 
Peaks macro. 

 

 
 
 

 Note You can exit a loop during the execution of a macro without 
stopping the macro by clicking the Exit Loop button. You can stop 
the macro by clicking the Stop Macro button.  
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Displaying a different 
set of macro buttons 

The macro buttons are saved in sets consisting of seven buttons each. 
If the macro you want to run does not appear in the currently 
displayed set of macro buttons, click the Next Set button to display 
the next set of macro buttons.  
 
 
You can display a directory of the macros which are currently 
assigned to macro buttons using the Directory command in the 
Options menu. The directory lists the button name, the file name of 
the associated macro, the date and time the macro was created, and 
any comments that were entered in the Summary Info for the macro 
when the macro was saved. 

Displaying a directory 
of assigned macros 

 
To display a directory of currently assigned macro: 
 
1. Choose Directory from the Options menu. 
 
 The directory of current macro button assignments is displayed. 

The directory lists the button name, the file name of the assigned 
macro, and any comments that were saved with the macro. 
 

 Note You can quickly move to a macro button by selecting a macro in the 
list and then choosing Go To.  
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5 Assigning a Macro to the Macro Panel
 
 
 
As described in the previous chapter, the Macro Panel gives you 
quick access to many macros, which you can select and run while 
using OMNIC. In order to run a macro from the Macro Panel, it 
must first be assigned to a Macro Panel button. Macros are assigned 
to Macro Panel buttons using the functions available in the Macro 
Panel assign mode. The Macro Panel assign mode also allows you to 
create and delete macro button sets and set protection for the macro 
button assignments. 
 
This chapter describes how to assign macros to the Macro Panel and 
use the other Macro Panel assign mode functions. 
 
Once the macros are assigned, you can run them by switching to the 
Macros Panel select mode, selecting a macro and then clicking the 
Run Macro button. Information on running a macro from the Macro 
Panel is available in chapter 4, “Running Macros from the Macro 
Panel.” 
 
 



 
When you choose Assign Macros from the Macro Panel Options 
menu, the Macro Panel is displayed in the assign macros mode. In 
assign mode, the Macro Panel expands to include additional buttons 
and text boxes, as illustrated below. These features allow you to 
assign macros to the Macro Panel and protect the macro button 
assignments. Additional commands are also available from the menus 
in assign mode which allow you to create and delete sets of macro 
buttons.  

Using the Macro 
Panel in assign mode 

 
 

 
 
 
The Macro Panel menu bar and buttons have the following functions 
in assign mode. 

Assign mode 
Macro Panel features 

 
Macro Panel menu bar 
In assign macros mode, the menu commands allow you to create a 
new set of seven macro buttons, save your changes to or delete the 
currently displayed set of macro buttons, display a directory of 
assigned macros, get help on using the Macro Panel, and quit the 
Macro Panel application. 
 
Macro buttons - Allow you to choose which button to assign a 
macro to. 
Macro control buttons 
Next Set - Displays the next set of macro buttons. 
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Run Macro, Exit Loop and Stop Macro - These buttons are 
disabled in the assign mode. 
Label - The Label text box allows you to enter the label for the 
selected macro button. 
Protect Assignments - Displays a dialog box which allows you to 
set protection for the macro button assignments. 
Change Assignment - Displays a dialog box which allows you to 
choose the macro to assign to the currently selected macro button. 
 
 
After a macro has been compiled and saved from Macros\Basic, you 
can assign the macro to a button on the Macro Panel. Until a macro 
has been assigned to a macro button, it cannot be run from the Macro 
Panel. 

Assigning a macro 
to a macro button 

 
To assign a macro to a macro button: 
 
1. If the Macro Panel is not currently displayed, double-click 

the Macro Panel icon to open the Macro Panel. 
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2. Choose Assign Macros from the Options menu.  
 
 The Macro Panel appears with the assign macro functions 

enabled, as illustrated below. 
 

  
 
 
3. If the macro assignments are protected, you must enter the 

password in order to enter the assign macros mode.  
 
 Type the password in the text entry box and then choose OK. 
 
 
4. Select the set of macro buttons you want to add the macro to 

by clicking Next Set until the desired button set is displayed. 
 
 If all of the buttons have already been assigned, you will need to 

create a set of buttons by choosing New Set from the File menu. 
 
 
5. Select the macro button you want to assign the macro to by 

clicking the macro button.  
 
 The current label for the selected button will appear in the Label 

text box. 
 
 
6. Type a label for the macro button in the Label box. 
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7. Click the Change Assignment button.  
 
 The Change Assignment dialog box appears on the display. 
 

  
 
 
8. Type the name of the macro you want to assign to the macro 

button in the File Name box, or select it from the list of 
macros.  

 
 If the macro you want to use is not displayed in the list of 

available macros, select a different drive or directory. To see file 
types other than Macros\Basic macros (.MAC), use the Files Of 
Type drop-down list box to choose a type of file. Choose OK 
when you have selected the macro. 

 
 
9. Comments that were saved with the macro file will appear in 

the comment box directly beneath the macro buttons.  
 
 If no comments were saved with the macro file, you can enter 

comments for the macro in the comments box by clicking inside 
the box and typing the desired text.  
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10. When you are done assigning macros, choose Save Changes 

from the File menu, or choose Select Macros from the 
Options menu (this automatically saves the macro button 
assignment changes and returns you to the Macro Panel in 
select mode). 

 
 

Using the New Set and Delete Set commands in the File menu, you 
can create and delete sets of macro buttons.  Creating and deleting 

macro button sets 
To create a set of macro buttons: 

 
1. Make sure the Macro Panel is in the assign macros mode. 

 
 If the Macro Panel is in select mode, choose Assign Macros from 

the Options menu. This enables the assign macros functions.  
 

 Note If the macro assignments are protected, you must enter the password 
in order to switch to the assign mode.  

 
 

2. Choose New Set from the File menu.  
 

 The new set of macro buttons appears on the Macro Panel. 
 
 

3. To add comments for this set of macro buttons, make sure no 
buttons are selected. Then type the comments in the comments 
box directly beneath the macro buttons. 

 
 
To delete an existing set of macro buttons: 

 
1. Make sure the Macro Panel is in the assign macros mode. 

 
 If the Macro Panel is in select mode, choose Assign Macros from 

the Options menu. This enables the assign macros functions.  
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 Note If the macro assignments are protected, you must enter the password 

in order to switch to the assign mode.  
 
 

2. If the macro buttons you want to delete are not currently 
displayed, click Next Set until they appear on the Macro 
Panel. 

 
 
3. Choose Delete Set from the File menu. 

 
 The macro buttons will be deleted. 

 
 Note Only the macro buttons are deleted. The macro files which were 

assigned to the macro buttons remain saved.  
 
 

After assigning macros to macro buttons, you can protect the macro 
button assignments to prevent changes. The Protect Assignments 
button allows you to specify a password in order to make changes to 
the macro button assignments. 

Setting the macro 
button assignment 

protection 
To set the macro button assignment protection:  
 
1. Make sure the Macro Panel is in the assign macros mode.  
 
 If the Macro Panel is in select mode, choose Assign Macros from 

the Options menu. This enables the assign macros functions.  
 

 Note If the macro assignments are protected, you must enter the password 
in order to switch to the assign mode.  
 
 
2. Choose Protect Assignments.  
 
 The Protect Assignments dialog box appears on the display. 
 
 
3. Choose the Protect option and then choose OK. 
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4. Enter the password to use and choose OK.  
 
 The assign macros functions are automatically disabled. 
 
 
After setting the Assign Macros password, you can change the 
password as described below. 

Changing the assign 
macros password  

To change the Assign Macros password:  
 
1. Make sure the Macro Panel is in the assign macros mode.  
 
 If the Macro Panel is in select mode, choose Assign Macros from 

the Options menu. This enables the assign macros functions.  
 
 
2. Enter the current password.  
 
 
3. Choose Protect Assignments.  
 
 The Protect Assignments dialog box appears on the display. 
 
 
4. Choose Change Password and then choose OK. 
 
 
5. Enter the new password and then choose OK.  
 
 The Macro Panel remains displayed with the assign macros 

functions enabled. 
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You can remove the macro button assignment protection entirely by 
following the procedure below. 

Removing macro button 
assignment protection  

To remove the macro button assignment protection:  
 
1. Make sure the Macro Panel is in the assign macros mode.  
 
 If the Macro Panel is in select mode, choose Assign Macros from 

the Options menu. This enables the assign macros functions.  
 
 
2. Enter the current password.  
 
 
3. Choose Protect Assignments.  
 
 The Protect Assignments dialog box appears on the display. 
 
 
4. Choose Remove Protection and then choose OK. 
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6 Working With Macro Files 
 
 
 
The Macros\Basic File menu commands allow you to work with 
macro files. This chapter describes how to use the File menu 
commands to open, save, print and run macros from Macros\Basic. It 
also explains how to move macro files from one computer to 
another. 
 
 
You can open an existing macro to modify, view or print the macro.  Opening an 

existing macro 
 
To open an existing macro: 
 
1. Choose Open from the File menu. 
 
 
2. Type the file name of the macro you want to open or select 

the file from the list of available files.  
 
 If the macro you want to open is not listed, select a different 

drive or directory from the Drives or Directories list boxes. 
 
 A list of the most recently opened macro files appears at the 

bottom of the File menu of OMNIC. You can select a macro in 
this list by choosing it from the menu. 

 
 
3. Choose OK. 
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Before a macro is saved it is compiled. If errors are found during 
compilation, they are reported and you are given the option of saving 
the macro with errors or canceling the Save command. If you choose 
to save the macro, the macro will not execute if you try to run it, but 
you can open it later to fix the errors. The source of the error is 
indicated in the error message that is displayed. Help information on 
the source of the error and possible solutions can be displayed from 
the error message dialog boxes. Saving a macro with a password 
requires the operator to enter the correct password before modifying 
the macro.  

Saving a macro 

 
Macros are saved in the location specified by the active OMNIC 
Options file (usually in the C:\OMNIC\MACRO directory). See the 
manuals and on-line help that came with your OMNIC software for 
information on customizing OMNIC by setting options for details on 
changing the directory used to store macros. All macro files are 
saved with the extension *.MAC. 
 
To save the current macro: 
 
1. Choose Save from the File menu.  
 
 If errors are found during compilation, you are given the option 

of saving the macro with errors or canceling the Save command. 
If the file has been previously saved, the file will be saved with 
the current file name. If the file has not been saved previously, 
the Save As dialog box will appear.  

 
 
2. If the Save As dialog box appears on the display, type a file 

name for the macro in the File Name text box and then 
choose OK. 

 
 
3. Enter the optional Comments, Author or Title in the 

Summary Info dialog box and then choose OK. 
 
 These comments are displayed in the Macro Panel when this 

macro is selected. 
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4. If the Enter Password dialog box appears on the display, type 

a password and then choose OK. 
 
 You will be asked to verify the password by entering it again. If 

you enter a password, the Macros\Basic program will require the 
password to be entered before opening the macro for editing. 

 
 The password feature is controlled by the Password Protect This 

Macro check box in the Options dialog box. See “Customizing A 
Macro By Setting Options” in chapter 2 “Creating A Macro 
Using Macros\Basic” for details.  

 
 
You can use the Save As command to save a copy of the macro with 
a different name. This is useful when you want to modify a macro 
but also want to keep a copy of the original macro. 

Saving a macro 
with a new name 

 
Before the macro is saved it is compiled. If errors are found during 
compilation, they are reported and you are given the option of saving 
the macro with errors or canceling the save. If you choose to save 
the macro, the macro will not execute if you try to run it, but you can 
open it later to fix the errors. The source of the error is indicated in 
the error message that is displayed. Help information on the source 
of the error and possible solutions can be displayed from the error 
message dialog boxes. Saving a macro with a password requires the 
operator to enter the correct password before modifying the macro.  
 
To save the current macro with a new name: 
 
1. Choose Save As from the File menu. 
 
 
2. Enter a file name for the macro in the File Name text box. 
 
 
3. Choose OK. 
 
 

OMNIC Macros User’s Guide       67 
 



 
4. Enter the optional Comments, Author or Title in the 

Summary Info dialog box and then choose OK.  
 
 These comments are displayed in the Macro Panel when this 

macro is selected. 
 
 
5. If the Enter Password dialog box appears on the display, type 

a password and then choose OK. 
 
 You will be asked to verify the password by entering it again. If 

you enter a password, the Macros\Basic program will require the 
password to be entered before opening the macro for editing. 

 
 The password feature is controlled by the Password Protect This 

Macro check box in the Options dialog box. See “Customizing A 
Macro By Setting Options” in chapter 2 “Creating A Macro 
Using Macros\Basic” for details. 

 
 
Summary information which describes the contents of the macro can 
be saved with the macro using the Summary Information command 
in the File menu. You are also prompted to enter summary 
information when you save a macro for the first time. This 
information will be displayed in the comments box for the macro 
when the macro is selected in the Macro Panel. Entering the 
summary information is optional. 

Entering 
summary information 

for a macro 

 
To enter summary information for a macro: 
 
1. Choose Summary Info from the File menu.  
 
 
2. Enter the information you want to save with the file in the 

Title, Author and Comments text boxes.  
 
 The comments you enter will be displayed in the Macro Panel 

when the macro is selected. 
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3. Choose OK. 
 
 
When you want to print a copy of your macro, you have two printing 
options. You can print a text listing of the tasks in the current macro 
using the Print Listing command or you can print a copy of the task 
symbols using the Print Symbols command. 

Printing a macro  

 
To print a listing of the tasks in the current macro: 

• Choose Print Listing from the File menu. 
 
To print the task symbols for the current macro: 

• Choose Print Symbols from the File menu. 
 
 
Macros can be run from Macros\Basic. The Run command executes 
the macro you select as if you were running it from the OMNIC 
toolbar or menu. The macro you select is the one executed, not the 
one currently open in Macros\Basic. 

Running a macro 
from Macros\Basic 

 
To run a macro from Macros\Basic: 
 
1. Choose Run from the File menu. 
 
 
2. Type the name of the macro you want to run in the File 

Name text box or select the macro from the list of available 
files.  

 
 If the macro you want to run is not listed, select a different drive 

or directory from the Drives or Directories list boxes. 
 
 
3. Choose OK. 
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Macro files can be moved from one computer to another by copying 
the macro files (*.MAC) onto a floppy disk and then copying the 
files onto the new computer. This enables you to develop macros on 
one computer and run the macros on one or several other computers.  

Moving macro files 
between computers 

 
You can move the macro files individually and assign the macros to 
the Macro Panel on the new computer, or you can move a Macro 
Panel with its associated macro files and macro button assignments. 
 
To move a Macro Panel with its associated files, you need to copy 
the files listed below into the appropriate subdirectories on the new 
computer.  

• All of the macro files (*.MAC) that are associated with the Macro 
Panel must be copied into the macro directory on the new 
computer. 

• The Macro Panel file (C:\OMNIC\MPANEL.EXE) from the 
computer on which the macro button assignments were made 
must be copied into the C:\OMNIC directory on the new 
computer. 

 
 Notice When you move the Macro Panel, you overwrite the current Macro 

Panel assignments on the new computer. However, the individual 
macro files (*.MAC) are not overwritten and can be assigned to the 
new Macro Panel.  
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7 Example Macros 
 
 
 
This chapter provides you with five example macros to study. The 
first example takes you step-by-step through the process of creating 
a macro. The second example demonstrates how to use the Report 
task to send results to another file via DDE. The third example 
shows an example Report task dialog configured to output results to 
a Word file. The fourth example demonstrates how to use the 
If…Then capability of Macros\Basic with the quantitative features 
of TQ Analyst. The final example shows how to pass values between 
two macros when one calls the other. 
 
Several example macros came with your Macros\Basic software for 
you to study. Some of these are explained in detail in this chapter. 
The example macros that accompany your software are listed below. 
You can find these example macros in the macro subdirectory of the 
OMNIC folder. 
 

 Ommac1.mac This macro lets you define the collection parameters, collect a 
sample and background, display and print the resulting spectrum. 
 

 Ommac2.mac This macro uses a loop to collect a series of five samples after 
collecting a background. 
 

 Ommac3.mac This macro collects a background and sample, then finds the 
resulting peaks and prints the result. 
 

 Ommac4.mac This macro collects a background and sample, converts the spectrum 
to absorbance, then uses the Decision task to let the operator decide 
whether to search a library, label the peaks or correct the baseline. 
 

 Ommac5.mac This macro shows how to use the Report task to send results to 
Microsoft® Excel via DDE (dynamic data exchange).  
 



 
 Ommac6.mac This macro uses the If…Then capability of Macros\Basic with the 

quantitative features of our TQ Analyst software package for 
quantitative analysis.   
 

 Call.mac and Function.mac These macros show how to pass values between macros. Call.mac 
makes a value available to another macro; Function.mac takes the 
value passed to it and returns another value based on a calculation it 
performs. 
 

 Reqex.mac This macro takes text from an external file (reqex.txt) and parses it 
into macro variables. 
 

 Index.mac This macro shows how to use the Index variable within a loop. 
 
 
When executed from OMNIC, this example macro will open a log 
file, collect a sample and background spectrum, take the ratio of two 
peaks in the sample spectrum and append the result to the open log 
file. Follow the steps below to create the example macro. 

Creating a 
macro step by step 

 
Step 1: Open the Macros\Basic application. If the application is already 

open, choose New from the File menu.  
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Step 2: Add the following tasks to the macro in the order shown in the 

illustration below. 
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Step 3: Double-click the first Peak Height task symbol in the macro and 

enter the location for the first peak. If you want OMNIC to use the 
peak that is closest to the location you specified, make sure the Seek 
Closest Peak option is on. If you want to calculate the corrected peak 
height, enter values for the Baseline start and Baseline end 
parameters. When you are finished, choose OK. 
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Step 4: Double-click the first Store Result task symbol in the macro and 

click “Peak Height” in the list of tasks which can store their results 
as a macro variable. If you entered a baseline region in the previous 
Peak Height task, click “Corrected” in the list of peak height results 
which can be stored. If you did not enter a baseline region, click 
“Uncorrected.” When you are finished, choose OK. 
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Step 5: Repeat step 3 for the second Peak Height task in the macro. 
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Step 6: Repeat step 4 for the second Store Result task in the macro.  
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Step 7: Double-click the Math task symbol in the macro. In the Math setup 

dialog box, click “mv1” in the Macro Variables window. A 
placeholder for the macro will be added to the Equation Definition 
text box. Add the divide function by typing a slash (/) on the 
keyboard. In the Macro Variables window, click “mv2.” A 
placeholder for the macro will be added to the equation. When you 
are finished, choose OK. 
 
 

 
 

 
Step 8: Double-click the Report task symbol in the macro. In the Text box, 

type: 
 
  Peak Height Ratio Macro 
  The peak height ratio is #mv3# units. 
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 Turn on the “Append to Log” option and then choose OK. 

 
 

 
 
 

 For information on assigning the macro to an OMNIC menu or 
toolbar, see chapter 3. For information on assigning the example 
macro to the Macro Panel, see chapter 4. To learn how to run the 
macro from the Macro Panel, see chapter 5.  
 
 

Using a macro 
to send 

quantitative 
results to an Excel 

spreadsheet  

This macro demonstrates how to use the Report task to send results 
to Microsoft® Excel via DDE (dynamic data exchange). The overall 
goal of this example macro is to continuously collect spectra, 
quantify them, then send the quantitative results to an Excel 
spreadsheet. This example is not presented in a step-by-step form. 
Rather we show you the task symbols and task list. These items 
show all of the tasks and parameters used in the macro. The task 
symbols and task list are on the next page.  
 

OMNIC Macros User’s Guide       79 
 



 
You can test or modify this macro yourself by opening the macro 
“ommac5.mac” in the macro subdirectory of the OMNIC folder. 
This macro was created using an earlier version of Macros\Basic that 
contained a task called “Collect Setup.” This task has been replaced 
by a task called “Experiment Setup” in OMNIC E.S.P. However, 
Collect Setup is still supported and this task will execute correctly 
with your version of OMNIC.  
 
For more information on using OMNIC DDE with macros, see 
chapter 9 of this manual, “Designing a Macro with OMNIC DDE.” 
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       Symbol List 

Collect Background

Collect Setup

Quant Setup

Math

Start

Start of Loop

Collect Setup

Quantity

Store Quant Results

Math

Report

100

Math

End of Loop

End

          Task List 
Collect Setup 
 No. of scans = 32 
 Resolution = 4. 
 Apodization = Happ-Genzel 
 Zero Filling = None 
 Final Format = Absorbance 
 Correction = None 
 File Handling = Save Interferograms 
 Background Handling = Collect  
  background after 6000 minutes 
Collect Background 
 Show data collect window 
Quant Setup 
 Filename = d:\omnic\quant\examples 
  \tqx_pls.qnt 
 Title = turboquant example method-pls 
 Parameters = Collect, Bench 
Math 
 mv1 = 1 
 Format = “?” 
Start of Loop 
 Loop count = 100 
 No pause between loops 
 Collect Sample 
  Show data collect window 
 Quantify 
 Store Quant Results 
  mv3 = Quantify | SpectrumTitle 
  mv4 = Quantify | ConcentrationList 
  mv5 = Quantify | StdErrorList 
 Math 
  mv2 = #mv1# + 1 
  Format = “?” 
 Report 
  Text = #mv3# #mv4# 
   #mv5# 
  DDE Item =  
   R#mv1#C1:R#mv2#C4 
  Application = Excel 
  Topic 
 Math 
  mv1 = #mv1# + 2 
  Format = ? 
End of Loop 
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Most of this example macro is straightforward so we will 
concentrate on the Report task. The Report task formats the Quantify 
results and sends them to the output location specified in the Report 
task dialog box. 

Setting up the Report task 

 
The example below shows how to use the DDE output option to 
send quantitative results to an Excel spreadsheet. To use the Report 
DDE option, you must correctly specify the values for the Item, 
Application, and Topic fields in the Report task dialog. Any mistake 
in the Item or Topic fields will cause the macro to fail at run time. 
The following illustration shows the DDE options set correctly for 
this example. 
 
 

 
 
 
Use the Application field to specify the program you want the 
Report task to send data to. For this example, simply enter “Excel”. 
In general, the correct entry for an application is the root name of the 
*.exe file for the application. Capitalization is not important in this 
or any of the DDE fields. 

Application field 
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 Note The specified application must be running and idle for DDE to 

succeed. If the application is not running, the Report task will fail. If 
the application is busy, for example if Excel has a cell selected for 
editing, the Report task will wait indefinitely until the application 
becomes idle. This may cause Macros\Basic to appear as if it has 
“hung up” but it is actually waiting for the DDE application to 
become available.  

 
 
The Topic field allows you to specify a particular file or page within 
the selected application. It is best to explicitly specify the topic. If 
you leave the Topic field blank, the Report task will send the data to 
the selected page in whatever application file is currently open 
(which is what would happen in this example). If more than one 
copy of Excel is open, the results are sent to the first one 
encountered, which can lead to unpredictable results. Below are 
some example topics for Excel. For Microsoft Word examples, see 
the next section. For other applications, refer to the documentation 
for the application. 

Topic field 

 
For Microsoft Excel 5.0, files and page names are referenced by 
book and sheet. For a new Excel book, the references will be: 
 
[Book1]Sheet1 
[Book1]Sheet2 
etc. 
 
As soon as you save the Excel book, the “Book1” reference changes 
to the file name. For example, 
 
[abc.xls]Sheet1 
[abc.xls]Sheet2 
 
If you rename a sheet in Excel, the “Sheet” reference changes to the 
name you entered. For example, 
 
[abc.xls]FirstSheet 
[abc.xls]Sheet2 
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To ensure that your macro will work as expected, either leave the 
Topic field blank and make sure you have only the target 
spreadsheet file open, or create your Excel book ahead of time, save 
it and refer to the topic by file and page name. Using the [Book1] 
topic reference is not recommended because as soon as you save the 
book, the DDE will fail because the topic has changed. 
 
 
Use the Text field to specify the data you want to send to Excel and 
how the data will be formatted. In the Store Quant Result task of this 
example macro, we selected three items to store (Spectrum Title, 
Concentration List and Standard Error List) and assigned three 
macro variables to store them (mv3, mv4, and mv5). 

Text field 

 
To send the data stored in a macro variable to Excel, you must type 
the macro variable name in the text field of the Report task. The 
contents of the first macro variable you enter will be placed in the 
first column of the first row in the specified spreadsheet file. Use the 
<tab> character to specify the next field to the right (row 1, column 
2). To enter a tab character, hold down the Control key and press the 
Tab key. Use the carriage return to specify the next row in the 
specified spreadsheet file. 
 
Macro variables created by selecting a column header from the table 
in the bottom half of the Store Quant Result window may return 
more than one element of data. If a macro variable contains more 
than one element of data, tabs are inserted automatically so that each 
element falls in a separate column in the spreadsheet. In this 
example macro, the selected quantitative method calculates the 
concentrations for three components, so the ConcentrationList macro 
variable (mv4) and the StdErrorList macro variable (mv5) will each 
contain three tab separated values. 
 
With the Text Field set up as follows: 
 
mv3 mv4 
  mv5 
 
the spreadsheet file will look like the example below. 
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 A B C D 
1 80 PPM C3H8 30 PPM CH4 1.94 0.99 1.92
2 0.05 0.04 0.05
3 80 PPM C3H8 30 PPM CH4 1.26 0.51 4.01
4 0.10 0.07 0.110

 
 
The first row contains the spectrum title and the three concentration 
values. The second row contains the three standard error values. The 
initial tab character in line 2 instructs the macro to skip the first 
column so that the concentration and standard error values are 
aligned properly in the spreadsheet. Therefore, the complete Report 
result will cover 2 rows with each report using 4 columns. 
 
 
The Item field allows you to define the range of cells in the specified 
application file and page the data will be sent to. In this example you 
would enter R1C1:R2C4 because we have 2 rows and 4 columns of 
data in each row. If you enter too many or too few rows or columns, 
the DDE will fail. 

Item field 

 
If we were just sending one sample result to Excel we would be 
done. If you want to send additional results to Excel without 
overwriting the previous ones, you must use macro variables to 
increment the row indexing. For example, to set up the Report task 
in this example macro to accept and report the results from multiple 
samples, you must enter the following in the Item field: 
 
R#mv1#C1:R#mv2#C4 
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For each iteration of the loop, the range of cells will increment so 
that the end of the range (#mv2#) is always one row greater than the 
start of the range (#mv1#). The following illustrations show how to 
set up the two Math tasks immediately preceding and following the 
Report task to increment these values. 
 
 

 
 
 

 
 
 
At run time, the values for these macro variables will be substituted 
for the #mv1# and #mv2# placeholders. The Math task before the 
Report task sets mv2 to the value of mv1 plus 1. The Math task after 
the Report task increments the value of mv1 by 2 in preparation for 
the next loop. The macro will now keep looping and append any 
subsequent quantitative results to the specified Excel spreadsheet. 
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Sending results to Microsoft Word via DDE is a little simpler than to 
Excel, although less flexible. The following illustration shows an 
example Report task dialog configured to output results to a Word 
file. 

Using a macro to 
send results to 

Microsoft Word 
 
 

 
 
 
To indicate that the output is to go to Word, enter “winword” in the 
Application field. 
 
The Topic is the document name of a Word file. For example, you 
could use “abc.doc” for an unsaved document or 
“c:\mydocs\abc.doc” for a document that has been saved. You must 
use the full DOS path and file name for an existing document; the 
file name alone will not work. 
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The Item is the name of an existing bookmark for a Word file. In 
Word, defining a bookmark lets you give a unique name to a specific 
location you have selected. Create a bookmark in a Word file by 
selecting the location you wish to mark, choosing Bookmark from 
the Edit menu, and giving the bookmark a name. See the 
documentation that came with Word for more information. 
 
There is no way to append results to a Word file, since the results 
always overwrite the contents of the existing Word bookmark. To 
store a single result from the Report task, simply enter the name of 
the bookmark, for example, “Result”. 
 
To save more than one result in a Word file, you can set up a 
document with several sequential bookmarks already created and 
then reference them by a macro variable. For example, create a 
Word file containing 10 bookmarks named: 
 
Result1 
Result2 
… 
Result10 
 
Then set the Item in the Report task to “Result#mv1#”. Using a loop 
in the macro to increment mv1 ten times will save the results in the 
sequential bookmarks. The symbol and task lists below show an 
example of how this could be set up. 
 

88       OMNIC Macros User’s Guide 
 



 
Symbol List Task List 

 
Math

Start of Loop

Report

Math

10

End of Loop

 
Math 
 mv1 = 1 
 Format = “?” 
Start of Loop 
 Loop count = 10 
 No pause between loops 
 Report 
  Text 
  DDE Item = Result#mv1# 
  Application = winword 
  Topic = c:\mydocs\abc.doc 
 Math 
  mv1 = mv1 + 1 
  Format = “?” 
End of Loop 

 
The Math task before the start of the loop task sets the macro 
variable mv1 equal to 1. The first time through the loop, the Report 
task looks for a Word bookmark named “Results1” because it 
substitutes “1” for “#mv1#” within “Result#mv1#” as defined in the 
Item field.  
 
The second Math task increments the value of mv1 by one for each 
iteration of the loop. So the second time through the loop, the Report 
task looks for a Word bookmark named “Results2”, and so on until it 
reaches the end of the loop. 
 

 
The example macro in this section shows you how to use the 
If…Then capability of Macros\Basic with the quantitative features 
of our TQ Analyst software package for quantitative analysis.  This 
example is not presented in a step-by-step form. Rather we show you 
the task symbols and task listing. These items show all of the tasks 
and parameters used in the macro. The task symbols and task list are 
on the next page.  

Using If…Then 
tasks to create 

branches in a macro 

 
You can examine this example macro yourself by opening the macro 
“ommac6.mac” in the macro subdirectory of the OMNIC folder. 
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 Note The example macro in this section will not run on your system 

because it calls several fictitious quantitative methods.  

 
This macro is designed to collect a sample spectrum, classify it as 
either “Alpha,” “Secondary,” or “Tertiary,” then quantify the 
spectrum with a quantitative method optimized for the class. The 
results are written to a text file. The macro loops until the operator 
clicks the Exit Loop button in the macro control, or until 20 
iterations are complete. 
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      Symbol List 

Collect Background

Start of Loop

Quant Setup

Collect Sample

20

Collect Setup

Start

Quantify

Store Quant Results

Quant Setup

Quantify

Store Quant Results

Report

End of Loop

End

If... Then

End If

If... Then

Quant Setup

End If

If... Then

Quant Setup

End If

 

          Task List 
Collect Setup 
 No. of scans = 8 
 Resolution = 8. 
 Apodization = Happ-Genzel 
 Zero Filling = None 
 Final Format = Absorbance 
 Correction = None 
 File Handling = Save Interferograms 
 Background Handling = Collect  
  background after 6000 minutes 
Collect Background 
 Show data collect window 
Start of Loop 
 Loop count = 20 
 No pause between loops 
 Quant Setup 
  Filename =  
   d:\omnic\quant\classify.qnt 
  Title 
  Parameters = Collect, Bench 
 Collect Sample 
  Show data collect window 
 Quantify 
 Store Quant Results 
  mv1 = Quantify | ClassName 1 
 If…Then 
  Execute tasks when mv1 = Alpha 
  Quant Setup 
   Filename =  
    d:\omnic\quant\class1.qnt 
   Title 
 End If 
 If…Then 
  Execute tasks when mv1 =  
   Secondary 
  Quant Setup 
   Filename =  
    d:\omnic\quant\class2.qnt 
   Title 
 End If 
 If…Then 
  Execute tasks when mv1 =  
   Tertiary 
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  Quant Setup 
   Filename =  
    d:\omnic\quant\class3.qnt 
   Title 



 
 Task List, con’t 
 
 

 End If 
 Quantify 
 Store Quant Result 
  mv2 = Quantify | SpectrumTitle 
  mv3 = Quantify | SpectrumDate 
  mv4 = Quantify | ConcentrationList 
 Report 
  Text = #mv2#  #mv3#  #mv1#  
   #mv4# 
  Append to file =  
   d:\omnic\macro\ommac6.txt 
End of Loop 

 
 
The Macro begins by setting up the collection parameters and 
collecting a background for use with the subsequent samples. The 
collection conditions could also be set by using an Open Experiment 
task to load an Experiment file. Samples are collected within the 
loop described below. 
 
This macro was created using an earlier version of Macros\Basic that 
contained a task called “Collect Setup.” This task has been replaced 
by a task called “Experiment Setup” in OMNIC E.S.P. However, 
Collect Setup is still supported and this task will execute correctly 
with your version of OMNIC. 
 
 

Setting up the loop The main macro loop is defined with 20 iterations and no pause 
between loops. The macro executes a Quant Setup task prior to 
collecting the sample. The Quant Setup task has the Collect 
parameter and Bench parameter options set so that OMNIC’s 
parameters will be set to those in the quantitative method. This 
ensures that the sample spectrum is collected under the same 
conditions as the method. This is very important for most 
quantitative methods, especially PLS (Partial Least Square). 
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The sample is then collected and quantified. The quantify task uses a 
TQ Analyst discriminant analysis method which analyzes the sample 
and classifies it as an “Alpha,” “Secondary,” or “Tertiary” sample. 
This analysis method is defined outside of the macro using our TQ 
Analyst software for quantitative analysis. The classification result is 
stored in macro variable mv1 using the first Store Quant Result task. 
 

 
Within the loop, three If…Then structures test the value of macro 
variable mv1. Each If…Then structure loads a quantitative method, 
which has been optimized for that particular class of samples. 

Adding the 
If…Then structure 

 
For example, the first If…Then task tests macro variable mv1 for the 
value “Alpha.” If mv1 = “Alpha,” then the Quant Setup task 
following this If…Then task is executed. This loads the quantitative 
method “class1.qnt.” If mv1 does not equal “Alpha,” the macro 
jumps to the task that follows the first End If task. 
 
This process is repeated for each If…Then structure. Our initial 
quantitative method guarantees that the classification result (stored 
in mv1) will be one of these three classes. Therefore, one and only 
one of these Quant Setup tasks will execute. 
 
 
When each of the If…Then tasks is complete, the macro uses 
another Quantify task to analyze the sample again using the 
optimized quantitative method. The last Store Quant Result task 
saves the title of the spectrum and its collection date as well as a tab 
separated list of the concentrations for each component the 
quantitative method is set up to analyze. 

Adding the Quantify, 
Store and Report tasks 

 
The Report task is set up to format the results and write them to the 
file “ommac6.txt.” You must use the full path and file name of the 
text file or choose Browse to select an existing text file stored on the 
disk when you create a Report task. If the specified file does not 
exist at run time, OMNIC will create it. As additional samples are 
run, they are appended as new lines to this text file in the format: 
 
SpectrumTitle <tab> SpectrumDate <tab> ClassName 1 <tab> 
ConcentrationList 
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You can enter the <tab> characters into the Text field of the Report 
task by holding down the Control key and pressing the Tab key. 
Note that we are not concerned with the exact number of 
components in the concentration list because the list is tab separated. 
 
The following illustration shows how the Report task would be set 
up for this example. 
 
 

 
 
 
When all samples have been run, the file ommac6.txt can be easily 
opened into a spreadsheet or word processor application for further 
analysis or to create a final report. 
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One of the features of Macros\Basic is the ability to call one 
Macros\Basic macro from another. You can use the Macro task in 
the Insert menu to tell the current macro which previously saved 
macro to call. It may be useful to you to pass values back and forth 
between these macros. The Store Arguments and Return Value tasks 
provide a mechanism for sharing values between macros. 

Sharing values 
between macros 

 
This example is not presented in a step-by-step form. Rather we 
show you the task symbols and task listing. These items show all of 
the tasks and parameters used in the macro. The task symbols and 
task list are on the next page. 
 
This example demonstrates how you can use one macro, named 
“call.mac” to make a value available to another macro. The called 
macro, named “function.mac,” takes the value passed to it and 
returns another value based on a calculation it performs. 
 
You can examine these example macros yourself by opening the 
macros “call.mac” and “function.mac” in the macro subdirectory of 
the OMNIC folder. 
 
Call.mac 
 

Symbol List Task List 

Macro function.mac

Math

Start

Comment

End  
 

Math 
 mv1 = 2 
 Format = ? 
Macro 
 File name:  = 
C:\OMNIC\macro\function.mac 
 File type = macro 
 Call macro as a function 
 Send the following argument string: 
   #mv1#,3.14159 
 Store return value in macro variable: 
   mv = 2 
Comment 
 Text of Comment:  Result = #mv2# 
 Caption for dialog = “Macros\Basic  
   ESP -Comment” 
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Function.mac 
 

Symbol List Task List 

Math

Store Arguments

Start

End

Return Value

 
 

Store Arguments 
 List of mv’s to store:  = 1,2 
Math 
 mv3 = #mv1# * #mv2# 
 Format = ? 
Return Value 
 Result = #mv2# 
 Return this value to calling macro: 
   #mv3# 

 
 
When function.mac is called, the Store Arguments task captures the 
values passed to it from call.mac (mv1=2 and 3.14159), and stores 
them in macro variables mv1 and mv2. There must be a one-to-one 
correspondence between the argument list in the macro task of the 
calling macro and the Store Arguments macro variable list. 
 
Macro variables are unique to the macro in which they are defined. 
In other words, all macro variables are local and known only to the 
macro currently executing. There are no global macro variables 
known to all macros. 
 
The macro function.mac includes a math task to perform a 
mathematical function on the values passed to the macro. When a 
macro is called as a function, it is the responsibility of the function 
macro to seize the arguments passed to it and set the return value. 
 
The Return Value task makes the results of the math task available 
to the calling macro, call.mac. Normally the returned result is the 
value of a macro variable calculated by the function macro, but it 
could also include text. 
 
Finally, the results are displayed in a comment dialog box. 
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8 OMNIC Macros Commands and 

Tasks 
 
 
 
This chapter describes the commands available in the menu bar 
when the Macros\Basic application or the Macro Panel application is 
running. The chapter also provides an alphabetical listing of the 
tasks that can be added to a macro. 
 
 
This is a menu by menu description of the commands available in 
the menu bar when the Macros\Basic application is running. The 
commands are presented in the order in which they appear in the 
menus. 

Macros\Basic 
command 

descriptions 
 
 
The Macros\Basic File menu commands allow you to work with 
macro files. This section describes how to use the File menu 
commands to open, save, print and run macros from Macros\Basic 
and to exit the Macros\Basic application.  

File menu 

 
 
Use the New command to start a new macro. When you choose New 
from the File menu, the macro Start and End tasks appear in the 
macro workspace.  

New command 

 
The insertion point is the blue dashed line which appears between 
task symbols in the macro workspace. The insertion point indicates 
where the next task you select will be placed in the macro. You can 
move the insertion point to a new location by clicking between the 
task symbols in the workspace at the new location. 
 



 
To add tasks to the macro, click the task in the task list or select the 
option in the Insert menu that you want to add to the macro. As each 
feature is added, the task symbol for the task or Insert option is 
placed in the macro workspace at the position of the insertion point.  
 
Some tasks have associated parameters which must be set in order 
for the macro to run. The task symbols for tasks with parameters 
which must be set are displayed in red until you set the associated 
parameters. Other tasks have settable parameters which can be 
changed but do not need to be set in order for the macro to run. The 
task symbols for tasks with parameters which can be changed are 
displayed in blue. The task symbols for tasks which have no settable 
parameters are displayed in black.  
 

 Note The task symbols for tasks which have required parameters will 
change from red to blue once the parameters have been set.  

 
To change the parameters associated with a task, double-click the 
task symbol. The setup dialog box for that task will appear in the 
workspace. When the parameters are set as you want them, choose 
OK. 
 
 
Use the Open command to open an existing macro. Open an existing 
macro when you want to modify, view, or print the macro. 

Open command (File menu) 

 
To open an existing macro, choose Open from the File menu. Type 
the file name of the macro you want to open or select the file from 
the list of available files and then choose OK. 
 
 
Use the Save command to save the current macro. When a macro is 
saved, it is first compiled. If errors are found during compilation, 
you are given the option of saving the macro with errors or canceling 
the Save command. The source of the error is indicated in the error 
message that is displayed. Help information on the source of the 
error and possible solutions can be displayed from the error message 
dialog box. 

Save command (File menu) 
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 Note If you choose to save a macro that has errors, the macro will not 

execute if you try to run it. However, you can open it later to fix the 
errors.  
 
To save the current macro, choose Save from the File menu. If the 
macro has not been saved before, the Save As dialog box will 
appear. Enter a file name for the macro in the File name box and 
then choose OK. Enter the optional Comments, Author or Title in 
the Summary Info dialog box. Then choose OK. These comments 
will be displayed in the Macro Panel when this macro is selected.  
 
If the Enter Password dialog box appears on the display, type a 
password and then choose OK. You will be asked to verify the 
password by entering it again. If you enter a password, the 
Macros\Basic program will require the password to be entered 
before opening the macro for editing. 

 
 Note The password feature is controlled by the Password Protect This 

Macro check box in the Options dialog box. See “Customizing A 
Macro By Setting Options” in chapter 2 “Creating A Macro Using 
Macros\Basic” for details.  
 
Macros are saved in the location specified by the active OMNIC 
Options file (usually in the C:\OMNIC\MACRO directory). 
 
 
Use the Save As dialog box to save the current macro with a new file 
name or in a different drive or directory. This is useful when you want 
to modify a macro but also want to keep a copy of the original macro.  

Save As command (File menu) 

 
When a macro is saved, it is first compiled. If errors are found 
during compilation, you are given the option of saving the macro 
with errors or canceling the Save command. The source of the error 
is indicated in the error message that is displayed. Help information 
on the source of the error and possible solutions can be displayed 
from the error message dialog box. 
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 Note If you choose to save a macro that has errors, the macro will not 

execute if you try to run it. However, you can open it later to fix the 
errors.  
 
To save the current macro with a new name, choose Save As from 
the File menu. Enter a file name for the macro in the File name box 
and then choose OK. Enter the optional Comments, Author or Title 
in the Summary Info dialog box. Then choose OK. These comments 
will be displayed in the Macro Panel when this macro is selected.  
 
If the Enter Password dialog box appears on the display, type a 
password and then choose OK. You will be asked to verify the 
password by entering it again. If you enter a password, the 
Macros\Basic program will require the password to be entered 
before opening the macro for editing. 
 

 Note The password feature is controlled by the Password Protect This 
Macro check box in the Options dialog box. See “Customizing A 
Macro By Setting Options” in chapter 2 “Creating A Macro Using 
Macros\Basic” for details.  
 
Macros are saved in the location specified by the active OMNIC 
Options file (usually in the C:\OMNIC\MACRO directory). All 
macro files are saved with the extension *.MAC. 
 
 
Use the Summary Info command to enter comments about the 
macro. This information will be stored with the macro when it is 
saved. Entering the summary information is optional. 

Summary Info command 
(File menu) 

 
When you choose Summary Info from the File menu, a dialog box 
appears which allows you to enter a title, author and comments 
about the current macro. The comments entered in the Summery 
Information dialog box will be displayed in the Macro Panel when 
the macro is selected. 
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Dialog box options 
File Name - This is the current file name, including the directory 
path, for the macro you are working on. If this field is blank, the 
macro has not yet been saved. 
Macro Title - Enter text to be displayed in the title bar of the 
Macros\Basic window. This field defaults to the name 
“Macros\Basic -” plus the file name. 
Author - Enter your name or initials. 
Comments - Enter text which will be displayed in the Macro Panel 
readout when this macro is selected. 
 
 
Use the Print Listing command to print a text listing of the tasks in 
the current macro. To print a listing of the current macro, choose 
Print Listing from the File menu. 

Print Listing command 
(File menu) 

 
 
Use the Print Symbols command to print a copy of the task symbols 
for the current macro as they appear in the workspace. To print the 
task symbols for the current macro, choose Print Symbols from the 
File menu. 

Print Symbols command 
(File menu) 

 
 
Use the Run command to run a saved macro from Macros\Basic. To 
run a macro from Macros\Basic, choose Run from the File menu. 
Type the name of the macro you want to run in the File Name box or 
select the macro from the list of available files and then choose OK.  

Run command (File menu) 

 
The Run command executes the macro you select as if you were 
running it from the OMNIC toolbar or menu. The macro you select 
is the one executed, not the one currently open in Macros\Basic. 
 
 
Use the Exit command to close the Macros\Basic application. Exit command (File menu) 
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The Macros\Basic Edit menu commands allow you to edit a macro. 
This section describes how to use the Edit menu commands to cut 
and copy task symbols onto the Clipboard, paste task symbols from 
the Clipboard into the macro workspace and clear task symbols from 
the macro workspace. 

Edit menu 

 
 

Cut command Use the Cut command to cut the selected task(s) from the macro. 
Tasks which are cut are placed on the Clipboard and can be pasted 
into the macro using the Paste command. 
 
To cut a task from a macro, select the task by clicking the task 
symbol in the workspace and then choose Cut from the Edit menu or 
press Ctrl + X. The task is placed on the Clipboard and remains there 
until a different task is cut or copied. 
 

 Note To select more then one task in the workspace, select the first task 
and then hold down the Ctrl key and make additional selections. You 
can use the Shift key to select contiguous tasks.  
 
 

Copy command Use the Copy command to create a copy of the selected task(s) on 
the Clipboard. Tasks which are copied can be pasted into the macro 
using the Paste command.  
 
To copy a task in a macro, select the task you want to copy by 
clicking the task symbol in the workspace and then choose Copy 
from the Edit menu or press Ctrl + C. The copied task is placed on 
the Clipboard and remains there until a different task is cut or 
copied. 
 

 Note To select more then one task in the workspace, select the first task 
and then hold down the Ctrl key and make additional selections. You 
can use the Shift key to select contiguous tasks.  
 
 
Use the Paste command to paste tasks which have been cut or copied 
into the macro at the position of the insertion point. 

Paste command (Edit menu) 
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To paste tasks in a macro, position the insertion point by clicking in 
the workspace at the point where you want to paste the task(s). 
Choose Paste from the Edit menu or press Ctrl + V. The tasks which 
are on the Clipboard are pasted into the macro at the insertion point. 
 
 
Use the Clear command to remove the selected tasks from the 
macro. To remove a task from the current macro, select the task you 
want to remove and then choose Clear from the Edit menu.  

Clear command (Edit menu) 

 
 Note To select more then one task in the workspace, select the first task 

and then hold down the Ctrl key and make additional selections. You 
can use the Shift key to select contiguous tasks.  
 
 
The Macros\Basic Insert menu commands allow you to customize 
your macro. This section describes how to use the Insert menu 
commands to add customized dialog boxes, loops and even stored 
macros to your macro.  

Insert menu 

 
 
Use the Comment command to add a dialog box to your macro 
which provides information or a prompt to the operator at run time. 
The run time dialog box will display the message until the operator 
chooses OK. 

Comment command 

 
When you choose Comment from the Insert menu, a dialog box 
appears which allows you to define the text to be displayed when 
this task is executed.  
 
Dialog box options 
Text of Comment- Enter the text for your comment exactly as you 
want it to appear when this task is executed.  
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To include the current value of the Result variable in the comment 
dialog box, type the placeholder #result# in the text of the comment. 
The Result variable is used by Macros\Basic to store the results of the 
most recently completed task. You may find it useful to access the 
Result variable to find the results of tasks such as:  Average, Find 
Peaks, Noise, Peak Height, Peak Area, Quantify, and Search. Each 
time the macro executes one of these tasks, the current value of the 
Result variable is overwritten. 
To include the current value of a macro variable in the comment text, 
select the macro variable you want to include by clicking its name in 
the Macro Variables window. A placeholder for the macro variable 
you select will appear at the end of any existing text in the Comment 
box.  

 Note If you include the Result variable in the Comment text, make sure 
you add the Comment task to the macro immediately following the 
task whose results you want to include.  

Caption for Dialog - Enter the text to display at the top of the 
Comment window. The default comment is “Macros\Basic ESP - 
Comment.” 
 
 
Use the Decision command to add a dialog box to your macro which 
allows the operator to choose between two or three buttons. When a 
button is selected at run time, the tasks which are specified for that 
button are performed. 

Decision command 
(Insert menu) 

 
When you choose Decision from the Insert menu, a dialog box 
appears which allows you to define the prompt text, the button labels 
and the action to be initiated when each of the buttons is pressed. 
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Dialog box options 
Prompt text - Enter the text for your Decision prompt exactly as 
you want it to appear when this task is executed. The prompt text 
should indicate the choices available in the dialog box and should 
give an indication of the results of each choice. To include the 
current value of the Result variable or a macro variable in a decision 
prompt, include the placeholder #result# or #mv?# in the text of the 
prompt, where ? is the number assigned to the macro variable whose 
value you want to include. 

 Note If you include the Result variable in the Decision prompt text, make 
sure you add the Decision task to the macro immediately following 
the task whose result you want to include.  
Label - Enter the text for the label of Button 1, 2, or 3 exactly as you 
want it to appear at run time. If you leave a button label blank, the 
button will not be displayed even though it may have tasks listed in 
its Action box. To blank a button, select the button label text and 
press the Delete key. Button labels containing only space characters 
may appear blank but are not considered blank by the system. If you 
want to define an underscore character for choosing the button from 
the keyboard, place the “&” character before the chosen letter in the 
button label. For example, to set up the key combination Alt + C for 
a Cancel button, type the label “&Cancel”. 

 Note You can also choose to define only one or two buttons for the 
decision dialog box if you want to limit the options available at run 
time.  
Action - Enter a list of tasks to be executed when the operator 
selects this button at run time. To enter a task, select the Action box 
then select tasks from the Tasks window. Tasks are added to the list 
in the Action box. Tasks which have parameters that you may define 
will cause the cursor to change from an arrow to a hand when you 
point to the task in the Action list box. To set a task’s parameters, 
double-click the task in the Action list box. Tasks which have 
parameters that must be set and are undefined appear in red when 
they are added to the Action box and begin with an asterisk (*). 
Tasks with parameters which can be set but do not need to be set in 
order for the macro to run appear in blue. Tasks which have no 
settable parameters appear in black. 
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Use the Loop command to insert a loop into your macro. Loops are 
used in macros to repeat a task or series of tasks a specified number 
of times. 

Loop command 
(Insert menu) 

 
When you choose Loop from the Insert menu, a dialog box appears 
which allows you to define the number of times to execute the loop. 
You may also specify whether or not to pause at the completion of 
each loop cycle. Then click OK. 
 
A Start of Loop and End of Loop task are created at the insertion 
point. You can choose to have the loop run a defined number of 
times, or to loop through all the spectra in a window. The Start of 
Loop task symbol indicates the number of times the loop will be 
executed. If the word “All” appears, the macro will loop through all 
the spectra in the currently selected window. You can insert tasks 
between the loop tasks, or you can cut and paste the Loop tasks to 
move them within the macro. 
 
When you double-click the End of Loop task, a dialog box appears 
which allows you to specify an end-of-loop condition. When the 
condition is true, the macro will exit the loop without completing the 
full number of iterations specified by the previous Start of Loop 
task. If you do not specify an end-of-loop condition, the macro will 
complete the full number of iterations specified by the previous Start 
of Loop task. 
 
Start of Loop Dialog box options 
Number Of Times To Execute Loop - Select this option to enter a 
defined number of times to execute the loop. The value must be 
greater than zero. If you want to use a macro variable to specify the 
number of loop cycles, select the value in the Number Of Times To 
Execute The Loop box, then click mv1 in the Macro Variable 
window. You can also type the placeholder #mv?# in this field, 
where ? is the number assigned to the macro variable you want to 
use. 
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Loop Through All Spectra Currently In Window - Select this 
option to apply each task in the loop to each spectra in the currently 
selected window. The macro affects only spectra originally in the 
spectral window; it does not affect any spectra added to the window 
while executing the loop. 
For example, suppose there are three spectra in a window and the 
loop contains the following tasks: 
 Start of Loop  (loop through all the spectra in window option) 
  Baseline Correct (automatic option) 
  Clear 
 End 
The first time through the loop, the first spectrum is selected (the last 
spectrum added to the window; last in, first out). The Baseline 
Correct task creates a new baseline corrected spectrum and adds it to 
the window. The Clear task then deletes the original spectrum (not 
the new baseline corrected spectrum). At the conclusion of the loop, 
the widow contains only the three new baseline corrected spectra. 
In this example, if the Loop Through All Spectra Currently In 
Window option was not checked, the new baseline corrected 
spectrum would be created and then immediately deleted. 
Pause After Each Loop Cycle - Select this option to display a 
dialog box at the completion of each loop cycle. The dialog box 
displays the number of times the loop has been executed and lets you 
choose to continue or exit the loop. The macro will pause until you 
close the dialog box. 
 
End of Loop Dialog box options 
Exit Loop When - Use this option to specify an end-of-loop 
condition. A valid condition uses a logical operator to evaluate two 
expressions. The result of the evaluation is either true or false. An 
expression may be a macro variable reference, a number, a text 
string or another expression. Text strings must be enclosed in quotes 
if they contain a space. 
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To specify a macro variable, enter it in the form “#mv?#” where ? is 
the number of the macro variable, or click a defined macro variable 
displayed in the Macro Variables window. To specify an operator, 
enter one of the operators from the list below. 
 
 Operator Function 

=, is Equal 
<>, is not Not equal 
< Less than 
> Greater than 
<= Less than or equal to 
>= Greater than or equal to 
contains Right <expression> appears in left <expression> 
is in Left <expression> appears in right <expression> 
is not in Left <expression> does not appear in right 

<expression> 
and Both the left <expression> and right <expression> 

are true (Boolean and) 
or Either <expression> is true (Boolean or) 
not Logical opposite of <expression> 

 
Examples of valid conditions: 

#mv3# >= 3.14 
#mv1# < #mv2# 
#mv2# = (#mv1# + 2) 
#mv1# > 2.5 and #mv1# < 10 
#mv1# is “this is a test” or #mv2# contains “test” 
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Use the If…Then command to insert an If…Then structure in your 
macro. If…Then structures can be used within a macro to allow 
certain tasks to execute based on the outcome of previous tasks. Using 
the If…Then, Else and End If tasks, you can carry out one set of tasks 
if a condition is true, and other set of tasks if the condition is false. 

If…Then command 
(Insert menu) 

 
When you choose the If…Then command from the Insert menu, a 
dialog box appears which allows you to specify an If…Then 
condition. Enter the condition to meet for the tasks to continue and 
choose OK. 
 
Position the insertion point after the If…Then task and then select 
the tasks that you want to be included when the If…Then condition 
is true. You can also cut and paste tasks to move them within a 
macro. If the condition specified with the If…Then task is met when 
you run the macro, the tasks immediately following the If…Then 
task will be executed. 
 
If you want to specify another set of tasks to be executed when the 
If…Then condition is not met, position the insertion point after the 
Else task and select the tasks you want to be included. 
 

 Note The Else task is optional. If you want the macro simply to continue 
when the If…Then condition specified in the If…Then task is not 
met rather than execute another set of tasks, delete the Else task.  
 
Dialog box options 
Execute Tasks If - Use this option to specify an If…Then condition. 
A valid condition uses a logical operator to evaluate two 
expressions. The result of the evaluation is either true or false. An 
expression may be a macro variable reference, a number, a text 
string or another expression. Text strings must be enclosed in quotes 
if they contain a space. 
To specify a macro variable, enter it in the form “#mv?#” where ? is 
the number of the macro variable. Current macro variables are listed 
in the macro variables window. To specify an operator, enter an 
operators from the operators table in the section “Loop Commands.” 
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Use the Macro command to call another macro or executable file 
from the macro you are creating. Macros can also be inserted in 
Decision dialog boxes. Two macro file types can be inserted in a 
macro:  User macros created with Macros\Basic (.MAC) and 
executable files (.EXE) created by Visual Basic or other application. 
If you call an executable file from a Macros\Basic macro, the 
OMNIC Macros application (either Macros\Basic or Macro Panel) 
will suspend execution of the macro until the executable file finishes 
or tells OMNIC Macros to resume.  

Macro command (Insert menu) 

 
You can use macro variables to specify the names of macro files. To 
add a macro variable to a file name, use the placeholder #mv?#, 
where ? is the number assigned to the macro variable whose value 
you want to include. The placeholder will be replaced by the current 
value of the macro variable at run time.  
 
To call an existing macro from a macro, position the insertion point 
where you want to call the macro and choose Macro from the Insert 
menu. Type the name of the macro in the File Name box or choose 
the Browse button to select the macro. When you are done, choose 
OK. Choose whether you want to call a macro (.MAC) or an 
executable (.EXE). 
 
If you choose to call a Macros\Basic macro as a function, you can 
pass values between the macros. The Store Arguments and Return 
Value tasks provide a mechanism for sharing values between macros 
when used with the Macro command. If you select this function, you 
can specify a list of arguments to be passed to the macro that you 
call. You can also designate a macro variable to hold the value 
returned by the function macro. 
 
When a macro is called as a function, it is the responsibility of the 
function macro (that is, the macro being called) to seize the 
arguments passed to it and set the return value. Macro variables are 
unique to the macro in which they are defined. In other words, all 
macro variables are local; there are no global macro variables. For 
more information, see the descriptions for these tasks in chapter 8, 
“OMNIC Macros Commands and Tasks.” 
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The Macros\Basic Macro menu contains the commands described in 
the following sections. 

Macro menu 

 
 
The Test command allows you to test your macro to see how it 
operates at run time. When you select the Test command, the macro 
is first compiled. If no errors are found, the macro will be run. If 
errors are found during compilation, they are reported and the test is 
canceled. You must correct the errors before you can proceed with 
the test. The source of the error is indicated in the error message that 
is displayed. Help information on the source of the error and possible 
solutions can be displayed from the error message dialog box. When 
you close the error message dialog box, the task symbol for the task 
that caused the error will be highlighted in the macro workspace.  

Test command 

 
 Note When you test or run a macro, the current OMNIC settings are saved 

before the macro is run, and then are restored after the macro has 
completed.  
 
 
The Show Macro Variables command allows you to see all of the 
macro variables you have assigned. Selecting the command once 
opens the macro variable viewer window. A check mark next to the 
command in the Macro menu indicates the viewer is open. Close the 
viewer by either choosing Show Macro Variables again from the 
Macro menu, or closing the viewer window directly.  

Show Macro 
Variables command 

 
 
You can define global parameters for your macros by setting 
options. Use the Options command to specify how your macros 
affect OMNIC, to set password protection for macros and to define 
the default format for numerical values displayed in Macros\Basic 
dialog boxes. 

Options command 

 
Macros\Basic includes the current settings for the global parameters 
whenever you save a macro. If you open a macro, the global 
parameters are reset to match their settings when that macro was last 
saved. To change global parameter settings for a macro, open the 
macro, reset the global parameters and then save the macro. 
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Dialog box options 
Reset OMNIC Parameters When Macro Ends - Turn on this 
check box to save the OMNIC configuration and experiment settings 
while the macro executes. Any changes the macro makes to OMNIC 
parameters persist only while the macro is running. When the macro 
completes, OMNIC reverts to its previous settings.  
We recommend that you always use this option by turning on the 
check box on, unless you want to create a macro that configures your 
system in a known way. This parameter is on by default for new 
macros. 
Password Protect This Macro - Turn on this check box if you want 
to enter a password to protect your macro. When this check box is 
on, the software displays the Enter Password dialog box before 
saving a macro. You can enter a password to protect the macro. If 
you leave the password entry box blank, the software saves the 
macro with no password protection.  
If you enter a password, the software asks you to verify it by 
entering the password again. The next time you open the macro in 
Macros\Basic, the software will ask you to enter the correct 
password before opening the macro. 
Default Format For Numerical Values – Use this entry box to 
specify the default format that Macros\Basic will use to display 
numerical values. This is also the format that is used when you select 
the “?” format option in the Math task.  
Use zeros to set up your default format if you want Macros\Basic to 
add zeros to the number when it has fewer digits than the format 
specifies. Use the pound sign (#) to set up your default format if you 
want to specify the number of significant digits but don’t want 
Macros\Basic to add zeros. For example, if you want the number 
24.123 to be displayed as 24.12, enter “#.##” in the Default Format 
text box. 
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The Program Note command is found in the Macro menu. Use this 
command to add a Program Note task to a macro at the location of 
the insertion point in the Macros\Basic dialog box. You can define 
global parameters for your macros by setting options. 

Program Note command 

 
 Note A Program Note task is used only to document a macro. It does not 

display a message while the macro is running. To display a message 
when a macro runs, use a Comment task.  
 
Dialog box options: 
Enter text for the program note in the Text Of Note box in the 
Program Note dialog box. You can also add an identifier to give 
each program note task a unique name. This makes it easier to 
correlate notes to the macro task sequence. An example program 
showing two program notes is shown below: 
 
Start of Loop 
 Number of times to execute loop = 2 
 Open 
  Display this dialog at run time 
 
*****  Program Note 153  ********************************* 
This is a test of the Program Note task in Macros\Basic. In this case, 
the text line is very long and wraps. Here is a complete list of 
characters after an LF: 
!@#$%^&*()_+`1234567890-=qwertyuiop[]\asdfghjkl;’zxcvbnm,./{}|:”<>? 
******************************************************* 
 Save 
End of Loop 
Print 
 
*****  Program Note 2  *********************************** 
This is a test of the Program Note task in Macros\Basic. In this case, 
the text line is very long and wraps. Here is a complete list of 
characters after a LF: 
!@#$%^&*()_+`1234567890-=qwertyuiop[]\asdfghjkl;’zxcvbnm,./{}|:”<>? 
******************************************************* 
 
Paste 
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This is an alphabetical listing of the tasks that can be added to a 
macro. Macros\Basic 

task descriptions 
The following information is provided for each task: 

• The operation of the task when the macro is run. 

• The conditions required by the task in order to execute properly at 
run time. 

• A description of the parameters that can be set for the task when 
the macro is created. 

 
For complete information about tasks that are also OMNIC 
commands, see the manuals and on-line help that came with your 
OMNIC software. 
 
 

 Absorbance When the macro is run, the Absorbance task converts the selected 
spectrum or spectra to absorbance units.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
This task does not have any settable parameters. 
 

 Note This task will fail if the selected spectrum is a Raman spectrum 
because this is not an allowed operation for a Raman spectrum.  

 
 
 Add Basis Vector The Add Basis Vector task appears in the Macros\Basic task list 

only when OMNIC Series software is loaded on the computer. When 
the macro is run, the Add Basis Vector task adds the specified basis 
vector to the active Series Gram-Schmidt basis set. A basis vector 
contains data collected at a point in time during a series data 
collection. Adding a basis vector that contains unwanted features, 
such as a drifting baseline, eliminates such features from the Gram- 
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  Schmidt reconstruction. The new Gram-Schmidt reconstruction will 

be displayed in the time response display of the series reconstruction 
window.  
 
Run time requirements  
A series reconstruction window or a contour window must be open 
and selected in order for this task to execute properly at run time.  
 
Task parameters  
The Add Basis Vector task parameter allows you to specify the 
collection time of the spectrum that you want to use for the basis 
vector. This parameter must be specified when you add the Add 
Basis Vector task to the macro. The macro will not run if this 
parameter is undefined.  
To specify the collection time of the basis vector, double-click the 
Add Basis Vector task symbol. Enter the time and choose OK. The 
value you enter must be in the same X-axis units as the Gram-
Schmidt reconstruction in the active series reconstruction window.  
 
 

 Add Constant When the macro is run, the Add Constant task adds the specified 
value to every data point of the selected spectrum. The resulting 
spectrum becomes the selected spectrum in the active spectral 
window.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
The Add Constant task parameter allows you to specify a value used 
to add to each data point in the spectrum. 
To specify the value used to add to each data point, enter a number 
or macro variable in the Add Constant dialog box, then choose OK.  
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 Add Spectra When the macro is run, the Add Spectra task adds the two selected 

spectra together to produce a new spectrum. When spectra are 
added, each data point of one spectrum is added to the corresponding 
data point of the other spectrum. You should use the Statistical 
Spectra task to average two or more spectra. 
 
Run time requirements  
The two spectra to be added must be selected in the same spectral 
window in order for this task to execute properly at run time. 
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Add to Library When the macro is run, the Add to Library task adds the selected 
spectrum to the specified user library with macro-entered or user-
entered field information. You can enter the field information when 
creating the macro or have the operator prompted to enter the 
information. 
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
The Add to Library task parameters are the same as the OMNIC Add 
to Library parameters. They allow you to specify the library to 
which the spectrum will be added. You must specify the library 
when you add the Add to Library task to the macro. You can also 
enter descriptive information in up to nine fields that you can view 
during or after a library search. 
To select the library, double-click the Add to Library task symbol 
and select a library from the list of available libraries. Then choose 
OK. 
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To have the operator enter descriptive field information, click the 
Prompt For Values At Run Time button in the Field Information 
section. Otherwise click the Use Values Supplied Below button to 
enter the information as you create the macro. To change the library, 
click the Change button. Then choose OK. 
 
 

 Add to Notebook When the macro is run, the Add to Notebook task adds the selected 
spectrum to the specified user notebook with macro-entered or user-
entered field information. You can enter the field information when 
creating the macro or have the operator prompted to enter the 
information. 
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
The Add to Notebook task parameters are the same as the OMNIC 
Add to Notebook parameters. They allow you to specify the 
notebook to which the spectrum will be added.  
To select the notebook, double-click the Add to Notebook task 
symbol and type the name of the notebook file in the File Name box 
or choose the Browse button to select the notebook. 
 

 Note Once you add a report to a notebook, you cannot delete the report or 
change its template.  
To have the operator enter descriptive field information, click the 
Prompt For Title At Run Time button in the field information 
section. Otherwise click the Use This Title button to enter the 
information as you create the macro. Then choose OK. 
 
 

 Advanced ATR Correction When the macro is run, the Advanced ATR Correction task performs 
the correction on the selected spectrum. A spectrum must be selected 
in order for this task to execute properly at run time.  
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Task parameters 
The Advanced ATR Correction task is the same as the Advanced 
ATR Correction command in OMNIC. This task allows you to 
specify the correction parameters to be used when the task is 
executed. These parameters do not need to be set in order for the 
macro to run. If the parameters are not set, the Advanced ATR 
Correction dialog box will be displayed when the macro runs. 
 
To specify the ATR correction parameters, choose the Advanced 
ATR Correction task symbol. The Advanced ATR Correction dialog 
box is displayed showing the parameter settings stored in the macro 
task. Make any changes you wish, and then choose OK to store the 
settings in the macro task. (See the on-line OMNIC Help for more 
information about parameter settings.) 
 

 Note To allow the operator to specify the parameter settings when the 
macro is run, add the task to your macro but do not choose it. This 
leaves the parameter settings undefined, so the Advanced ATR 
Correction dialog box will be displayed when the macro runs. If you 
accidentally choose the task, choose Cancel in the Advanced ATR 
Corrections dialog box, delete the task from your macro, and then 
add a new Advanced ATR Correction task to your macro.  

 
 

 Annotate When the macro is run, the Annotate task adds annotation to the 
selected spectrum at the specified X position.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. If more than one spectrum is selected, OMNIC 
issues a Failed message. 
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Task parameters  
The Annotate task parameters allow you to specify the annotation. 
You must specify the X position for the annotation when you add 
this task to the macro. The macro will not run if this parameter is 
undefined. You can also specify the annotation text and specify 
whether annotation is connected to the spectrum, whether X only or 
both X and Y values will be used, and whether the annotation for all 
spectra in the active window will be displayed.  
To set the Annotate task parameters, double-click the Annotate task 
symbol. Enter the X position, select the annotation options, and type 
the annotation text. If no annotation text is entered, the spectrum will 
be annotated with the X or X and Y values at the specified location. 
Choose OK when you have finished. 
 
 

 Apply Function The Apply Function task appears in the Macros\Basic task list only 
when OMNIC Series software is loaded on the computer. When the 
macro is run, the Apply Function task processes all data in the 
currently selected series data set. The results are displayed in the 
series reconstruction window. 
 
Run time requirements  
A series data set must be selected in order for this task to execute 
properly at run time.  
 
Task parameters  
The Apply Function task parameters allow you to apply one of 
several functions to the series data. These functions include 
converting to absorbance, % transmittance, Kubelka-Munk units, 
and others. Only functions appropriate for your selected data format 
can be selected. Applying a function to a data set permanently 
changes the series data; you cannot undo the change. 
To set the Apply Function parameters, double-click the Apply 
Function task symbol. Select the function to apply to the data set. 
Depending on which function you apply, you may need to enter 
additional parameters. Specify the parameters, then choose OK. 
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 Automatic Full Scale When the macro is run and this option is turned on, the Automatic 

Full Scale task automatically displays spectra full scale whenever 
you display a different spectral region. You can also choose to turn 
Automatic Full Scale off. 
 
Task parameters  
The Automatic Full Scale task parameter lets you specify whether or 
not to display the spectra at full scale automatically. 
To set the Automatic Full Scale task parameter, double-click the 
Automatic Full Scale task symbol. Turn the Automatic Full Scale on 
or off. (The default setting is on.) Then choose OK. 
 
 

 Average When the macro is run, the Average task calculates the average Y-
axis value in a region of the selected spectrum. The result of the 
average calculation will be stored in the Result variable. You should 
use the Statistical Spectra task to calculate an average spectrum. 
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time.  
 
Task parameters  
The Average task parameters allow you to specify the starting and 
ending values for the region in which to calculate the average. You 
must specify these values when you add the Average task to the 
macro. The macro will not run if these parameters are undefined.  
To specify the region, double-click the Average task symbol and 
enter the starting and ending X-axis limits. The limits must be 
specified in the same X-axis units as the selected spectrum. If you 
want to display the result of the average calculation automatically, 
select the Display Result check box. Then choose OK. 
The results of the Average calculation will be saved in the Result 
variable. 

 
 Note You may display the task results using a Comment task or send them 

to OMNIC or another Windows application using a Report task by 
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including the placeholder #result# in the text of your comment or 
report.  #Result# will be replaced by the results of the task at run 
time.  Each task result may also be stored in a macro variable by 
using a math task after the current task and setting up the math task 
to define a macro variable for #result# (for example, set mv1 equal 
to #result#).  
 
 

 Baseline Correct When the macro is run, the Baseline Correct task performs either a 
manual or automatic baseline correction on the selected spectrum, 
depending on what is specified in the Baseline Correct setup dialog 
box. If manual baseline correction is specified, the interactive 
Baseline Correct window will appear when the macro is run. The 
macro will not proceed at run time until you close the interactive 
Baseline Correct window. If automatic baseline correction is 
specified, the baseline correction is performed automatically and the 
baseline corrected spectrum is added to the active window when the 
macro is run.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. The selected spectrum must be in absorbance. 
 
Task parameters  
The Baseline Correct task parameters allow you to specify the type 
of baseline correction to be used. To specify the type of baseline 
correction to be used, double-click the Baseline Correct task symbol 
and select the type of baseline correction to use. Then choose OK.  
 
 

 Blank When the macro is run, the Blank task blanks the specified region of 
the selected spectrum. The spectrum with the blanked region will 
automatically replace the original spectrum.  
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Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
The Blank task parameters allow you to specify the region to be 
blanked. The Blank task parameters do not need to be set in order for 
the macro to run. If no region is specified, the spectrum will be 
blanked over the current X-axis display limits. 
To set the region to be blanked, double-click the Blank task symbol 
and enter the starting and ending X-axis limits for the region. Then 
choose OK.  
 
 

 Cascade Windows When the macro is run, the Cascade Windows task arranges all of 
the open OMNIC windows in a cascade pattern. 
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Change Data Spacing When the macro is run, the Change Data Spacing task changes the 
data spacing of the selected spectrum. The spectrum with the new 
data spacing will replace the original spectrum.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
The Change Data Spacing task parameter allows you to specify the 
data spacing to be used for the task. You must specify the new data 
spacing when you add this task to the macro. The macro will not run 
if this parameter is undefined.  
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To set the new data spacing, double-click the Change Data Spacing 
task symbol and select the new data spacing from the drop down list 
box. Then choose OK.  
 

 Note You cannot use a macro variable to set the data spacing.  
 
 

 Change Reason The Change Reason task appears in the Macros\Basic task list only 
when OMNIC DS software is loaded on the computer. When the 
macro is run, this task provides OMNIC with the reason changes 
were made to data while the macro was running. 

 
Task parameters 
When you add the Change Reason task to a macro, you may specify 
an explanation for the changes made while a macro was running. 
The OMNIC DS software uses this text whenever it is required to 
provide a reason for a change. If you do not include the Change 
Reason task in a macro that is running on an OMNIC DS system, the 
file name of the macro will be used in place of a reason you provide. 
 
If you add the Change Reason task to your macro, you must supply a 
reason. To specify a reason, choose the Change Reason task, enter a 
reason, and then choose OK. The macro will not execute if a reason 
is not provided. 
 
 

 Change Title The Change Title task appears in the Macros\Basic task list only 
when OMNIC Series software is loaded on the computer. When the 
macro is run, the Change Title task allows you to change the title of 
the currently selected series data set. 
 
Run time requirements  
A series reconstruction window must be selected in order for this 
task to execute properly at run time. 
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Task parameters  
To change the title of the series data set, enter the new name in the 
dialog box. If the title is not set, the operator will be prompted to 
enter a name at run time.  
 
 

 Clear When the macro is run, the Clear task removes the selected spectrum 
or spectra from the display. When Clear is used, the spectrum is not 
placed on the Clipboard.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Close Log When the macro is run, the Close Log task stops logging and closes 
the current OMNIC log window. 
 
Run time requirements  
An OMNIC log file must be open in order for this task to execute 
properly at run time.  
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Close Window When the macro is run, the Close Window task closes the specified 
OMNIC window.  
 
Run time requirements  
If a title is specified, it must match the OMNIC window title exactly. 
If there is no OMNIC window having a title that exactly matches the 
title you specify, OMNIC issues a Failed message. 
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Task parameters  
The Close Window task parameters allow you to specify the window 
to be closed and whether or not to display the “Save Changes…” 
confirmation dialog box at run time. The Close Window task 
parameters do not need to be set in order for the macro to run. If the 
parameters are not set, the currently active window will be closed 
and the “Save Changes…” confirmation dialog box will not be 
displayed. Any changes to the spectra in the window that were not 
previously saved will be lost. 
To specify the window to be closed, double-click the Close Window 
task symbol. Enter the title of the window to be closed. If you want 
the “Save Changes . . .” confirmation dialog box to be displayed at 
run time before the window is closed, make sure “Show 
Confirmation Dialog” is checked. Then choose OK. 
 

 Note OMNIC only displays the “Save Changes . . .” confirmation dialog 
box if a new spectrum has been collected into the window and never 
saved as a file.  
 

 Note You cannot close an OMNIC window with quotes (’) in its name 
using the Close Window task.  

 
 
 Coadd Region The Coadd Region task appears in the Macros\Basic task list only 

when OMNIC Series software is loaded on the computer. When the 
macro is run, the Coadd Region task produces a single spectrum or 
interferogram by coadding the data in the specified time region of 
the active series data set. The coadded data will be displayed in the 
spectral window specified in the Coadd Region setup dialog box.  
 
Run time requirements  
A series reconstruction window or a contour window must be open 
and selected in order for this task to execute properly at run time.  
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Task parameters  
The Coadd Region task parameters allow you to define the coadd 
region operation. You must specify the start and end time of the 
region to be coadded when you add this task to the macro. The 
macro will not run if this parameter is undefined. You may also 
specify the title of the window in which the coadded data will be 
placed. The title specified in the Coadd Region setup dialog box 
must match the OMNIC window title exactly. If there is no OMNIC 
window having a title that exactly matches the title you specify, 
OMNIC issues a Failed message. If you decide not to specify a 
window, the coadded data will be placed in the spectral data display 
of the active series reconstruction window. 
To set the Coadd Region task parameters, double-click the Coadd 
Region task symbol. Enter the start and end time of the region to be 
coadded. The values you enter must be in the same X-axis units as 
the reconstruction or rapid scan time line in the active series 
reconstruction window. Enter the exact title of the window the 
coadded data are to be placed in. Then choose OK.  
 
 

 Collect Background When the macro is run, the Collect Background task collects a 
background spectrum using the current parameter settings in the 
OMNIC Experiment Setup dialog box. Depending on how the task 
was set up, the Collect Background window and the operator 
prompts may or may not be displayed at run time. If the task is set 
up to display the Data Collect window, the operator will be able to 
view the progress of and stop data collection at run time. If the task 
is set up without prompts, the background will be collected 
immediately when the Collect Background task is reached in the 
macro. The collected background will be automatically added to the 
active window, and the macro will automatically proceed to the 
remaining tasks. If the task is set up with prompts, the macro will not 
proceed to the remaining tasks until the operator responds to the 
prompts and closes the Collect Background window. 
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Task parameters  
The Collect Background task parameters allow you to enter a title 
for the background and specify the amount of operator interaction 
for the background data collection. The Collect Background task 
parameters do not need to be set in order for the macro to run. If the 
parameters are not set, the Data Collect window will be displayed 
without prompts and a system generated title consisting of the date 
and time of collection will be used. 
To set the Collect Background task parameters, double-click the 
Collect Background task symbol. Enter the title for the background 
spectrum. Specify whether or not to show the Data Collect window 
and prompts at run time. Then choose OK. 
 
 

 Collect Raman The Collect Raman task appears in the Macros\Basic task list only 
when OMNIC for Raman software is loaded on the computer. When 
the macro is run, the Collect Raman task collects a Raman sample 
spectrum using the current parameter settings in the OMNIC 
Experiment Setup dialog box.  
Depending on how the task was set up, the Collect Raman window 
and the operator prompts may or may not be displayed at run time. If 
the task is set up to display the Data Collect window, the operator 
will be able to view the progress of and stop data collection at run 
time. If the task is set up without prompts, the sample will be 
collected immediately when the Collect Raman task is reached in the 
macro. The collected Raman sample will be automatically added to 
the active window, and the macro will automatically proceed to the 
remaining tasks. If the task is set up with prompts, the macro will not 
proceed to the remaining tasks until the operator responds to the 
prompts and closes the Data Collect window. 
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Task parameters  
The Collect Raman task parameters allow you to enter a title for the 
Raman sample and specify the amount of operator interaction for 
Raman data collection. The Collect Raman task parameters do not 
need to be set in order for the macro to run. If the parameters are not 
set, the Data Collect window will be displayed but no operator 
prompts will appear and a system generated title consisting of the 
date and time of collection will be used. 
To set the Collect Raman task parameters, double-click the Collect 
Raman task symbol. Enter a title for the Raman sample spectrum. 
Specify whether or not to display the Data Collect window and 
operator prompts at run time. Then choose OK. 
 
 

 Collect Reference The Collect Reference task appears in the Macros\Basic task list 
only when OMNIC for Raman software is loaded on the computer. 
When the macro is run, the Collect Reference task collects a white 
light reference spectrum using the current parameter settings in the 
OMNIC Experiment Setup dialog box. The white light reference 
spectrum is used to correct Raman sample spectra for effects caused 
by characteristics of the instrument.  
Depending on how the task was set up, the Collect Reference 
window and the operator prompts may or may not be displayed at 
run time. If the task is set up to display the Data Collect window, the 
operator will be able to view the progress of and stop data collection 
at run time. If the task is set up without prompts, the reference will 
be collected immediately when the Collect Reference task is reached 
in the macro. The collected reference will be automatically added to 
the active window, and the macro will automatically proceed to the 
remaining tasks. If the task is set up with prompts, the macro will not 
proceed to the remaining tasks until the operator responds to the 
prompts and closes the Data Collect window. 
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Task parameters  
The Collect Reference task parameters allow you to enter a title for 
the reference and specify the amount of operator interaction for the 
reference data collection. The Collect Reference task parameters do 
not need to be set in order for the macro to run. If the parameters are 
not set, the Data Collect window will be displayed without prompts 
and a system generated title consisting of the date and time of 
collection will be used. 
To set the Collect Reference task parameters, double-click the 
Collect Reference task symbol. Enter the title for the reference 
spectrum. Specify whether or not to show the Data Collect window 
and prompts at run time. Then choose OK. 
 
 

 Collect Sample When the macro is run, the Collect Sample task collects a sample 
spectrum using the current parameter settings in the OMNIC 
Experiment Setup dialog box. Depending on how the task was set 
up, the Data Collect window and the operator prompts may or may 
not be displayed at run time. If the task is set up to display the Data 
Collect window, the operator will be able to view the progress of 
and stop data collection at run time. If the task is set up without 
prompts, the sample will be collected immediately when the Collect 
Sample task is reached in the macro. The collected sample will be 
automatically added to the active window, and the macro will 
automatically proceed to the remaining tasks. If the task is set up 
with prompts, the macro will not proceed to the remaining tasks until 
the operator responds to the prompts and closes the Data Collect 
window. 
 
Task parameters  
The Collect Sample task parameters allow you to enter a title for the 
sample and specify the amount of operator interaction for sample 
data collection. The Collect Sample task parameters do not need to 
be set in order for the macro to run. If the parameters are not set, the 
Data Collect window will be displayed but no operator prompts will 
appear and a system generated title consisting of the date and time of 
collection will be used. 
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To set the Collect Sample task parameters, double-click the Collect 
Sample task symbol. Enter a title for the sample spectrum. Specify 
whether or not to display the Data Collect window and operator 
prompts at run time. Then choose OK. 
 
 

 Collect Series The Collect Series task appears in the Macros\Basic task list only 
when OMNIC Series software is loaded on the computer. When the 
macro is run, the Collect Series task collects a series of spectra 
equally spaced in time using the current parameter settings in the 
OMNIC Series Setup dialog box.  
Depending on how the task was set up, the prompts to enter a series 
title and collect a background may or may not be displayed at run 
time. If the task is set up without prompts, the first spectrum in the 
series will be collected when the operator responds to the message to 
begin data collection or the software receives an external trigger to 
start data collection. If the task is set up with prompts, the macro 
will not proceed with series data collection until the operator 
responds to the prompts to enter a series title and collect a 
background. In both cases, the collected data will be processed and 
displayed automatically and the macro will automatically proceed to 
the remaining tasks when series collection is complete.  
 
Task parameters  
The Collect Series task parameters allow you to enter a title for the 
series data and specify the amount of operator interaction for series 
data collection. The Collect Series task parameters do not need to be 
set in order for the macro to run. If the parameters are not set, a 
system generated title consisting of the date and time of collection 
will be used and the prompts to enter a series title and collect a 
background will be displayed at run time.  
To set the Collect Series task parameters, double-click the Collect 
Series task symbol. Enter a title for the series data. Specify whether 
or not to display the title and background prompts at run time. Then 
choose OK. 
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 Common Scale When the macro is run, the Common Scale task displays the selected 

spectra in the active window with the same Y-axis scale.  
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Contour/Waterfall Setup The Contour/Waterfall Setup task appears in the Macros\Basic task 
list only when OMNIC Series software is loaded on the computer. 
When the macro is run, the Contour/Waterfall Setup task sets the 
Contour/Waterfall Setup parameters to the values specified in the 
Contour/Waterfall Setup task dialog box. The OMNIC 
Contour/Waterfall Setup dialog box will not be displayed at run 
time. 
 
Task parameters  
The Contour/Waterfall Setup task parameters are the same as the 
OMNIC Contour/Waterfall Setup parameters. They allow you to set 
up the contour or waterfall display. The Contour/Waterfall Setup 
task parameters do not need to be set in order for the macro to run. If 
the parameters are not set, the current OMNIC Contour/Waterfall 
Setup parameter settings will be used. 
To set the Contour/Waterfall Setup task parameters, double-click the 
Contour/Waterfall Setup task symbol and set the parameters to the 
desired values. Specify the background threshold and foreground 
threshold values by typing the desired values in the text boxes. 
Specify the kind of scale to use for intensities represented by the 
map colors by selecting Linear or Log. 
Turn on Auto Threshold if you want the threshold values to be 
adjusted automatically for optimum viewing whenever you apply a 
function to a data set using Apply Function, reprocess a data set 
using Reprocess, truncate the spectral range of a data set using 
Truncate All spectra, or create a profile using the Profile button. 
Specify the Y display range for the waterfall by typing the desired 
values in the Minimum Y Value and Maximum Y Value text boxes. 
If you want waterfall spectra displayed with the most recently 
collected spectrum at the front of the waterfall (lowest position on 
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the screen), turn on Reverse View. Turn off Reverse View if you 
want to use the normal display, with the most recently collected 
spectrum at the back of the waterfall (highest position on the screen). 
Then choose OK.  
 

 Note You cannot use macro variables to set the Contour/Waterfall Setup 
task parameters.  
 
 

 Copy When the macro is run, the Copy task creates a copy of the selected 
spectrum or spectra and places the copy on the Clipboard.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Create Chemigram The Create Chemigram task appears in the Macros\Basic task list 
only when OMNIC Series software is loaded on the computer. When 
the macro is run, the Create Chemigram task creates a Chemigram 
and adds it to the active series data set. The Chemigram will be 
displayed in the time response display of the active series 
reconstruction window.  
 
Run time requirements  
A series reconstruction window or a contour window must be open 
and selected in order for this task to execute properly at run time.  
 

132       OMNIC Macros User’s Guide 
 



 
Task parameters  
The Create Chemigram task parameters are the same as the OMNIC 
Create Chemigram parameters. They allow you to specify the 
spectral region that you want to integrate to produce the Chemigram 
reconstruction and a baseline region. The Create Chemigram task 
parameters do not need to be set in order for the macro to run. If the 
parameters are not set, the OMNIC Create Chemigram dialog box 
will be displayed at run time. 
To set the Create Chemigram task parameters, double-click the 
Create Chemigram task symbol. Enter the starting and ending X-axis 
limits of the spectral region that you want to integrate. If you want to 
integrate above a baseline, enter the starting and ending X-axis 
limits of the baseline region. Then choose OK.  
 
 

 Create File The Create File task appears in the Macros\Basic task list only when 
OMNIC Series software is loaded on the computer. When the macro 
is run, the Create File task displays the Create File dialog box, which 
allows you to build a series data set from individual spectra or 
interferograms. After you build a data set, you can create a contour 
map or waterfall display of the data or view a reconstruction that 
shows changes in absorbance response over time. 
 
Task parameters  
The Create File task parameters are the similar to the OMNIC Create 
File parameters. They allow you to specify the series file spectra to 
use, the data range, series title, and the data range units. 
To specify the spectral data files to be included in the data set, 
double-click the Create File task symbol. Enter the base name and 
sequence numbers of the spectral data files that are in the indicated 
directory to be included in the data set. The filename consists of the 
specified base name, a four-digit number that will increase by one 
for each successive file used, and an extension. Enter a unique, 
descriptive base name of up four characters that will help you 
identify the files later. The default directory for retrieving the files is 
shown in the Series File Spectra box. To specify the directory 
location where the current data set is located, choose Browse.  
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You can use macro variables in any of the parameter fields except 
the Units drop-down list box. 
To select units for the Z-axis, choose a unit type from the Units 
drop-down list box. To specify the Z-axis range you want included 
in the data set, type the values in the Start and End text boxes. 
To enter a title for the series, type a name in the Series Title text 
box. 
To specify a background spectrum for ratioing the sample spectra in 
the series, type in the Background File text box the pathname of the 
background, or choose Browse and select a background from the 
dialog box that appears. If you don’t specify a background file, you 
will not be able to reprocess the spectral data using Reprocess Series 
in the Series menu. When you are finished, choose OK. 
 
 

 Create Profile The Create Profile task appears in the Macros\Basic task list only 
when OMNIC Series software is loaded on the computer. The Create 
Profile task allows you to create a new profile from the current data 
set. This profile is loaded when the macro task runs. The term 
“profile” is used to refer to any of six ways of representing series 
data. 
 
Run time requirements  
A Series Reconstruction window (.SRS) must be open and selected 
in order for this task to execute properly at run time. The task will 
fail if the selected window is a Series Contour or Waterfall display. 
 
Task parameters  
The Create Profile task parameters are the same as those displayed 
when you click the Profile Setup button in an OMNIC Series 
Reconstruction window. They allow you to specify the way the 
series data is represented. These are the same profile types as those 
that were available when you set up the series data collection. 
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To specify the profile for the series data, double-click the Create 
Profile task symbol and select the type of profile to display. 
Depending on the type of profile you select, you will also need to 
enter other parameters defining the display. The macro will not run 
if these parameters are undefined. Enter these parameters, then 
choose OK. 

 
 
 Custom Shift The Custom Shift task appears in the Macros\Basic task list only 

when OMNIC for Raman software is loaded on the computer. When 
the macro is run, the Custom Shift task shifts the selected Raman 
sample spectrum by the laser frequency specified in the Custom 
Shift setup dialog box. If no laser frequency is specified in the setup 
dialog box, the operator will be prompted to enter the frequency at 
run time. The shifted spectrum will automatically replace the 
original spectrum.  
 
Run time requirements  
A spectrum that has not been shifted by the standard or a custom 
laser frequency must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
The Custom Shift task parameter is the same as the OMNIC Custom 
Shift parameter. It allows you to specify the laser frequency for 
shifting Raman sample spectra. The Custom Shift task parameter 
does not need to be set in order for the macro to run. If the parameter 
is not set, the OMNIC Custom Shift dialog box will be displayed at 
run time.  
To set the Custom Shift task parameter, double-click the Custom 
Shift task symbol and enter the laser frequency. Then choose OK. 
 

 Note You cannot use macro variables to set the Custom Shift 
parameters.  
 
 

OMNIC Macros User’s Guide       135 
 



 
 Cut When the macro is run, the Cut task removes the selected spectrum 

or spectra from its window and places the spectrum or spectra on the 
Clipboard.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time.  
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Delay When the macro is run, the Delay task pauses the macro for a 
specified length of time or until a specified point in time. 
 
Task Parameters 
The Delay task parameters allow you to specify the type and length 
of the delay. You must set the Delay parameters when you add the 
Delay task to the macro. The macro will not run if these parameters 
are undefined.  
To set the Delay task parameters, double-click the Delay task 
symbol. Select the type of delay and enter the delay time. If you 
select Delay Until Specific Time, you can enter the time and choose 
AM or PM. Then choose OK. 
 
 

 Delete Annotation When the macro is run, the Delete Annotation task removes the 
annotation from the selected region of the selected spectrum.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time.  
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Task parameters  
The Delete Annotation task parameter allows you to specify the X-
axis region in which to delete the annotation. The macro will not run 
if this parameter is undefined.  
To specify the region in which to delete the annotation, double-click 
the Delete Annotation task symbol. Enter start and end values for the 
X-axis. Any annotations between these limits will be deleted at run 
time. 

 
 
 Delete File When the macro is run, the Delete File task deletes the file or files 

specified in the Delete File task dialog box. 
 
Task parameters  
The Delete File task parameter allows you to specify one or more 
files to be deleted. The Delete File task parameter does not need to 
be set in order for the macro to run. If the parameter is not set, the 
operator will be prompted to select the spectrum file to deleted at run 
time. 
Type the complete pathname of the file in the pathname box. If you 
do not specify a DOS path with the file name, the spectrum 
subdirectory of the OMNIC directory will be used. You can also 
choose the Browse button to display a dialog box that allows you to 
locate and select the file. 
To allow the operator to specify the file when the macro is run, click 
to turn on the Display This Dialog At Run Time check box. If this 
option is checked, the contents of the File Name edit box is ignored. 
 
 

 Delete Time Region The Delete Time Region task appears in the Macros\Basic task list 
only when OMNIC Series software is loaded on the computer. When 
the macro is run, the Delete Time Region task erases all the spectral 
data within the specified time region of the active series data set. All 
interferograms and spectra will be deleted and the data set will be 
resaved, overwriting the old data set. The original reconstructions or 
rapid scan time line will be retained.  
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Run time requirements 
A series reconstruction window or a contour window must be open 
and selected in order for this task to execute properly at run time.  
 
Task parameters 
The Delete Time Region task parameter allows you to specify the 
time region to delete. You must specify the start and end time of the 
region to be deleted when you add this task to the macro. The macro 
will not run if this parameter is undefined.  
To specify the time region to delete, double-click the Delete Time 
Region task symbol. Enter the start and end time of the region and 
choose OK.  
 
 

 Derivative When the macro is run, the Derivative task converts the selected 
spectrum to its first or second derivative and applies the selected 
filter option. The results are displayed in the active spectral window. 
A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
You cannot use macro variables to set the Derivative parameters. 
To specify a first or second order derivative, double-click the 
Derivative task symbol, select the chosen options, and choose OK. 
(If you choose Cancel, none of the changes you have made will be 
saved.)  
 
 

 Display Background When the macro is run, the Display Background task displays the 
current background spectrum in the active spectral window. 
 
Run time requirements  
A background must have been collected in order for this task to 
execute properly at run time. If there is no spectral window in which 
to display the background spectrum, OMNIC issues a Failed 
message. 
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Task parameters  
This task does not have any settable parameters. 

 
 
 Display Limits When the macro is run, the Display Limits task displays the selected 

spectrum or spectra or all of the spectra currently displayed in the 
active window using the limits specified in the Display Limits setup 
dialog box. 
 
Task Parameters 
The Display Limits task parameters are the same as the OMNIC 
Display Limits parameters. They allow you to specify the display 
limits for the selected spectrum or spectra.  
To set the Display Limits task parameters, double-click the Display 
Limits task symbol and set the X- and Y-axis display limits. The X-
axis limits you specify will apply to all the spectra in the active 
spectral window. If you want the Y-axis display limits to be used for 
all the spectra in the active window, make sure “Apply to All 
Spectra” is checked. To show the Display Limits window at run 
time, choose Display This Dialog At Run Time. You do not need to 
enter values for the other parameters if this option is checked. Then 
choose OK.  
 

 Note You cannot use macro variables to set the Display Limit 
parameters.  
 
 

 Display Setup When the macro is run, the Display Setup task sets the display setup 
parameters to the values specified in the Display Setup task dialog 
box. The OMNIC Display Setup dialog box will not be displayed at 
run time. 
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Task parameters  
The Display Setup task parameters are the same as the OMNIC 
Display Setup parameters. They allow you to set up the display. The 
Display Setup task parameters do not need to be set in order for the 
macro to run. If the parameters are not set, the current OMNIC 
Display Setup parameter settings will be used. 
To set the Display Setup task parameters, double-click the Display 
Setup task symbol and set the parameters to the desired values. Then 
choose OK.  

 
 
 Display Spectral Reference When the macro is run, the Display Spectral Reference task adds the 

spectral quality reference spectrum to the active OMNIC spectral 
window and makes it the active spectrum. 
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Edit Title When the macro is run, the Edit Title task changes the title of the 
selected spectrum to the title specified in the Edit Title setup dialog 
box.  
 
Run time requirements  
Only one spectrum can be selected in order for this task to execute 
properly at run time. If more than one spectrum is selected, OMNIC 
issues a Failed message. 
 
Task parameters  
The Edit Title task parameter allows you to specify the title for the 
selected spectrum. You must specify the title for the spectrum when 
you add this task to the macro. The macro will not run if this 
parameter is undefined.  
To specify the title, double-click the Edit Title task symbol. Enter 
the new title and then choose OK. 
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 Experiment Setup When the macro is run, the Experiment Setup task loads the 

Experiment Setup parameters from the macro task into the current 
Experiment settings. The OMNIC Experiment Setup dialog box will 
not be displayed at run time. 
 
Task Parameters 
The Experiment Setup task parameters are the same as the OMNIC 
Experiment Setup parameters. The Experiment Setup parameters 
allow you to set the parameters that control how spectra are 
collected, including which beam path and accessory are used and 
how collected spectra are checked for quality. You can also use the 
command to perform diagnostic checks of the optical bench and to 
align the bench.  
To set the Experiment Setup task parameters, double-click the 
Experiment Setup task symbol. Enter the parameters on the Collect, 
Bench, Quality, Advanced, and Diagnostic tabs, then choose OK. 
These parameters will load when the macro is run. The user cannot 
change the parameters when the macro is run. 
 

 Note You cannot use macro variables to set any of the Experiment Setup 
parameters.  
 
 

 Export Series to Grams The Export Series to Grams task appears in the Macros\Basic task 
list only when OMNIC Series software is loaded on the computer. 
When the macro is run, the Export Series to Grams task loads the 
optional GRAMS/3D software. If you have the GRAMS/3D 
software you can manipulate data in a special three-dimensional 
display and view spectra from different locations in the display. See 
the documentation that came with the GRAMS/3D software for 
complete information on using the software to manipulate the series 
data. 
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Run time requirements  
A series data set (.SRS) must be open in order for this task to 
execute properly at run time. A copy of the optional GRAMS/3D 
software must be installed on your system for this task to execute 
properly at run time. 
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Extract Spectrum The Extract Spectrum task appears in the Macros\Basic task list only 
when OMNIC Series software is loaded on the computer. When the 
macro is run, the Extract Spectrum task extracts the specified 
coadded spectrum from the active series data set and places it in the 
specified spectral window. 
 
Run time requirements 
A series reconstruction window must be open and selected in order 
for this task to execute properly at run time.  
 
Task parameters  
The Extract Spectrum task parameters allow you to specify the 
collection time of the spectrum that you want to extract and the 
window in which the spectrum will be placed. You must specify a 
collection time when you add the Extract Spectrum task to the 
macro. The macro will not run if this parameter is undefined. You 
may also specify the title of the window in which the extracted 
spectrum will be placed. The title specified in the Extract Spectrum 
setup dialog box must match the OMNIC window title exactly. If 
there is no OMNIC window having a title that exactly matches the 
title you specify, OMNIC issues a Failed message. If you decide not 
to specify a window, the extracted spectrum will be placed in the 
spectral data display of the active series reconstruction window. 
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To set the Extract Spectrum task parameters, double-click the 
Extract Spectrum task symbol. Enter the collection time of the 
spectrum you want to extract. The value you enter must be in the 
same X-axis units as the reconstruction or rapid scan time line in the 
active series reconstruction window. Enter the exact title of the 
window the extracted spectrum is to be placed in. Then choose OK.  
 
 

 Find Peaks When the macro is run, the Find Peaks task searches the selected 
region of the spectrum for absorptions that exceed a specified 
threshold value and then labels, or “annotates,” them with their X 
values. A list of the peak locations is stored in the Result variable. 
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time.  
 
Task parameters  
The Find Peaks task parameters allow you to set up the Find Peaks 
operation. You can specify the region in which to find peaks when 
you add the Find Peaks task to the macro. If you do not specify a 
region, the displayed region is used. You can also optionally select 
the sensitivity and threshold and you can specify whether or not to 
show the Find Peaks window at run time. If you decide not to 
display the Find Peaks window, you must set the sensitivity and 
threshold parameters in the Find Peaks setup dialog box. The 
Sensitivity and Threshold values are the same as those used in the 
OMNIC Find Peaks window. 
To set the Find Peaks task parameters, double-click the Find Peaks 
task symbol. Enter the starting and ending X-axis limits for the 
region in which to find peaks. The starting and ending limits must be 
entered in the same X-axis units as the selected spectrum. If desired, 
set the sensitivity and threshold and specify whether to show the 
Find Peaks window. Then choose OK. 
The list of peak locations will be saved in the Result variable. 
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 Note You may display the task results using a Comment task or send them 

to OMNIC or another Windows application using a Report task by 
including the placeholder #result# in the text of your comment or 
report.  #Result# will be replaced by the results of the task at run 
time.  Each task result may also be stored in a macro variable by 
using a math task after the current task and setting up the math task 
to define a macro variable for #result# (for example, set mv1 equal 
to #result#).  
 
 

 Fourier Self-Deconvolution When the macro is run, the Fourier Self-Deconvolution task 
performs a Fourier self-deconvolution on the selected spectra, 
allowing you to mathematically enhance the resolution of spectral 
data. It can separate overlapping spectral features that cannot be 
resolved by collecting data at higher resolution settings. The Fourier 
Self-Deconvolution window is displayed with the original spectrum 
at the top and the result spectrum at the bottom. 
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time.  
 
Task parameters  
The Fourier Self-Deconvolution task allows you to set the 
parameters for performing a Fourier Self-Deconvolution, or to allow 
the operator to perform the task manually. To set the parameters, 
double-click the Fourier Self-Deconvolution task symbol. Enter 
values for bandwidth and enhancement. The Bandwidth and 
Enhancement parameters are the same as in the OMNIC Fourier 
Self-Deconvolution window. To show the Fourier Self-
Deconvolution window at run time, choose Display This Dialog At 
Run Time. You do not need to enter values for the other parameters 
if this option is checked. 
 
 

 Full Scale When the macro is run, the Full Scale task displays the selected 
spectra so that the highest and the lowest points in the spectra appear 
at the top and bottom of the pane, respectively. 
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Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time.  
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Get Library Spectrum When the macro is run, the Get Library Spectrum task displays the 
Get Library Spectrum dialog box, which allows you to add a library 
spectrum to the currently active spectral window. 
 
Task parameters  
The Get Library Spectrum task parameters allow you to specify the 
library spectrum to display. 
To define the library spectrum to get, double-click the Get Library 
Spectrum task symbol. To specify the name of the library to use, 
choose a library from the drop-down list box. To specify which file 
from the library to get, enter a number in the Index box. To change 
the directory where the macro looks for libraries, choose Change 
Library and select another directory. When you are finished, choose 
OK. 
 
 

 Hide Spectra When the macro is run, the Hide Spectra task hides the currently 
selected spectra in the active spectral window. When the spectrum is 
hidden it cannot be seen in the spectral window, only its title appears 
in the title box list. When you hide a selected spectrum, it is no 
longer selected.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time.  
 
Task parameters  
This task does not have any settable parameters. 
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 Instrument Correct The Instrument Correct task appears in the Macros\Basic task list 

only when OMNIC for Raman software is loaded on the computer. 
When the macro is run, the Instrument Correct task corrects the 
selected Raman sample spectrum for instrument effects using the 
specified reference spectrum. The corrected spectrum will 
automatically replace the original spectrum.  
 
Run time requirements 
A spectrum must be selected in order for this task to execute 
properly at run time. If Use The Current Reference is selected (see 
below), a suitable reference spectrum must be in computer memory 
at run time. 
 
Task parameters 
The Instrument Correct task parameters are the same as the OMNIC 
Instrument Correct parameters. They allow you to specify whether 
the current reference or a reference stored on a disk will be used to 
correct the spectrum. The Instrument Correct task parameters do not 
need to be set in order for the macro to run. If the parameters are not 
set, the OMNIC Instrument Correct dialog box will be displayed at 
run time. 
To set the Instrument Correct task parameters, double-click the 
Instrument Correct task symbol. Select whether the current reference 
or a specified reference file will be used. If you select Use This File, 
enter the name of the reference file. Then choose OK. 
To allow the operator to specify the file when the macro is run, click 
to turn on the Display Open File Dialog At Run Time check box. If 
this option is checked, the contents of the Use This File edit box is 
ignored. 
 
 

 Library Setup When the macro is run, the Library Setup task loads the Library 
Setup parameters from the macro task into the current Library 
settings. 
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Task Parameters 
The Library Setup task parameters are the same as the OMNIC 
Library Setup parameters. The Library Setup parameters allow you 
to specify how to perform a spectral search of one or more search 
libraries to identify an unknown spectrum, or a QC comparison of 
one or more QC libraries to verify the composition of a sample. 
To set the Library Setup task parameters, double-click the Library 
Setup task symbol. Enter the parameters on the tabs, then click OK. 
These parameters will load when the macro is run. The user cannot 
change the parameters when the macro is run. 
 

 Note You cannot use macro variables to set the Library Setup 
parameters.  
 
 

 Log In When the macro is run, the Log In task lets you enter a user name 
for the OMNIC log-in feature. If you supply a user name while 
creating the macro, the runtime log-in changes to the user name you 
supplied without displaying a prompt. If you select the Prompt For 
User Name At Runtime option, a prompt will be displayed at 
runtime to enter a user name. 
 
Run time requirements  

You do not need to have OMNIC log-in enabled before running a 
macro with this task. Log In will be enabled, if required, for the 
duration of the macro. At the conclusion of the macro, OMNIC is 
returned to its original log-in state (enabled or disabled). 
 
 

 Mail Spectra When the macro is run, the Mail Spectra task starts your email 
application, opens a new email, and attaches the selected spectrum 
(or spectra). A spectrum (or spectra) must be selected in order for 
this task to execute properly at run time. 

 
Task parameters 
This task does not have any settable parameters. 
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 Match Scale When the macro is run, the Match Scale task displays all spectra in 

the active window using the same Y-axis display limits as the 
selected spectrum. 
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time.  
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Match Spectrum Settings When the macro is run, the Match Spectrum Settings task sets the 
Experiment Setup parameters on the Collect and Bench tabs to the 
values in the selected spectrum. This is useful if you want to collect 
a spectrum using the same collection settings as those in effect when 
an existing spectrum was collected. 
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time.  
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Math The Math task allows you to carry out mathematical calculations 
within a macro. When the macro is run, the calculated result will be 
stored in the specified macro variable which may then be used in 
other operations in the macro. You can also use the Math task to 
create macro variables and set them to initial values. For example, 
you could set mv13 = 3.141. 
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Task parameters  
The Math task parameters allow you to define the mathematical 
equation and to specify the macro variable that will store the 
calculated result. You must specify both of these parameters when 
you add the Math task to the macro. The macro will not run if these 
parameters are undefined. You may also specify the format for 
displaying the calculated result. 
To specify the Math task parameters, double-click the Math task 
symbol. The Math setup dialog box appears with the macro variable 
parameter set to the next available macro variable number. Enter an 
unused number for this macro variable (1-65535) or leave the default 
number. A list of macro variables that have already been assigned is 
provided in the Macro Variables window.  
Define the equation by entering a value, a text string, or a 
mathematical formula in the Definition text box. You can also 
include any previously defined macro variable in the mathematical. 
To include a macro variable placeholder in the equation, click a 
name in the Macro Variables window. A placeholder for the macro 
variable you select will be placed at the end of your equation. If you 
place a macro variable placeholder in the equation, OMNIC will 
replace the placeholder with the current value of the macro variable 
at run time.  
To include a text string in the equation, enclose the string in double 
quote marks “like this”.  
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To include a mathematical formula in the equation, type the formula 
in the Definition text box. Choose Available Functions to see a 
complete list of the functions the Math task can use. Most of the 
functions that you can enter are common mathematical operations. 
Some uncommon functions are explained below. 
 
 Symbol Function name Description 

& Concatenate Join the previous “text string” to 
the next “text string.” (Using the 
+ character to join strings in the 
equation will cause a syntax 
error in your macro).  

div  division integer 
result 

Integer division. Divide then 
return integer result with no 
remainder. 

mod division 
remainder 

Modulo. Divide then return 
remainder only. 

average() average in list Return the average of a list of 
numbers. Numbers in list must 
be separated with a comma.  

log(x,base) logarithm Return the logarithm of the 
number x in the specified base. 

round() nearest integer Round the number to the nearest 
integer (fractions of 0.5 or 
greater will be rounded up.) 

truncate() integer 
component 

Truncate the number to the right 
of the decimal point without 
rounding up or down. Return the 
truncated integer. 

systime & 
sysdate 

system time and 
system date 

The current time and date. 
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A complete list of the arithmetic operators, string operators, bitwise 
operators, and functions can be found in Macros\Basic on-line help. 
In the help system index, find “available functions” and go to the 
“Available Functions” topic. 
When you are finished defining the equation, choose Check Syntax. 
The software computes a hypothetical equation result. If the 
equation includes a macro variable, OMNIC will set its current value 
to a random number while it checks the equation syntax since the 
macro variable has no value at development time.  

 Note Check the syntax of your equation before including it in the macro to 
ensure that the equation doesn’t cause an error at run time.  
You can use the Math task to extract specific information stored in 
macro variables by other tasks. For example, if you stored a series of 
values in macro variable mv1 in this format: 

JT907, 0.346 
JT908, 0.477 
PT007, 0.953 

you could extract just the value in the second line using the 
following definition:  mv2 = item 2 of textline 2 of #mv1#. 
To define the format of the macro variable value when it is 
displayed, printed or reported, enter a custom format in the Format 
text box or choose one from the Format drop down list. This option 
does not affect the internal value of the macro used in calculations. If 
you enter a new format, it is automatically added to the format list so 
you can reuse it later. Macros\Basic keeps track of the 10 most 
recently added new formats. If you want to reset the Format list box 
to the default format examples, clear the contents of the Format text 
box and choose OK. If you want to set the default format for this 
entry box, use the Options command in the Macro menu. 
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Use zeros to set up your custom format if you want Macros\Basic to 
add zeros to the number when it has fewer digits than the format 
specifies. For example, if you want the number 24 to be displayed as 
024.00, enter “000.00” in the Format text box. Use the pound sign 
(#) to set up your custom format if you want to specify the number 
of significant digits but don’t want Macros\Basic to add zeros. For 
example, if you want the number 24.123 to be displayed as 24.12, 
enter “#.##” in the Format text box. If you use the symbol E- or e- 
rather than E+ or e+ to define an exponent, negative exponents will 
be displayed with a minus sign and positive exponents will be 
displayed without a sign. 
 
Some example formats are described below. 
? General precision format. Macros\Basic displays the 

number as precisely as possible and in the format 
defined in the Options dialog box (Macro menu). 

0 Macros\Basic displays a zero if there are fewer digits 
in a number than places in the format. If there are more 
digits than places, Macros\Basic displays all digits to 
the left of the decimal point and rounds digits to the 
right. For example, if the format is “000.00” for the 
numbers 34 and 3457.888, Macros\Basic displays 
034.00 and 3457.89. 

# Same as 0 above, except Macros\Basic displays a 
space if there are fewer digits in a number than places 
in the format. For example, if the format is “###.##” 
for the number 34, Macros/Basic displays a space, then 
34. 

 
A complete list of placeholder symbols for number formats can be 
found in Macros\Basic on-line help. In the help system index, find 
“math task” and go to the “Using the Math Task” topic. 
 
When you are finished setting the Math task parameters, choose OK. 
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 Maximize Window When the macro is run, the Maximize Window task expands the 

specified window so that it fills the screen. You can specify either 
the active window or the OMNIC window.  
 
Task parameters  
The Maximize Window task parameters allow you to specify the 
window to be maximized. 
To select the window to be maximized, double-click the Maximize 
Window task symbol. Select to maximize the active spectral window 
or the OMNIC application window and then choose OK. 
 
 

 Minimize Window When the macro is run, the Minimize Window task shrinks the 
specified window to its icon. You can specify either the active 
window or the OMNIC window. 
 
Task parameters  
The Minimize Window task parameters allow you to specify the 
window to be minimized. 
To select the window to be minimized, double-click the Minimize 
Window task symbol. Select to minimize the active spectral window 
or the OMNIC application window and then choose OK. 
 
 

 Minimum/Maximum When the macro is run, the Minimum/Maximum task calculates the 
minimum and maximum Y-axis values in the specified X-axis region 
of the selected spectrum. Both the minimum and maximum Y-axis 
values and their corresponding X-axis positions are calculated. The 
result of the Minimum/Maximum calculation is stored in the Result 
variable.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
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Task parameters  
The Minimum/Maximum task parameters allow you to specify the 
starting and ending X-axis region in which to calculate the Y-axis 
minimum and maximum. You must specify these values when you 
add the Minimum/Maximum task to the macro. The macro will not 
run if these parameters are undefined.  
To specify the region, double-click the Minimum/Maximum task 
symbol and enter the starting and ending X-axis limits. The limits 
must be specified in the same X-axis units as the selected spectrum. 
If you want to display the result of the noise calculation 
automatically, select the Display Result check box. Then choose 
OK. 
The results of the Minimum/Maximum calculation will be saved in 
the Result variable. 

 
 Note You may display the task results using a Comment task or send them 

to OMNIC or another Windows application using a Report task by 
including the placeholder #result# in the text of your comment or 
report.  #Result# will be replaced by the results of the task at run 
time.  Each task result may also be stored in a macro variable by 
using a math task after the current task and setting up the math task 
to define a macro variable for #result# (for example, set mv1 equal 
to #result#).  
 
 

 Move Stage The Move Stage task lets you position a sample from a macro by 
moving a motorized stage. The Move Stage task is available in the 
Macros\Basic task list only when the computer is connected to an 
FT-Raman system or a system that includes the Almega dispersive 
Raman microscope. For FT-Raman systems, the Move Stage task 
appears in the Raman group and may be used only in conjunction 
with the FT-Raman View Stage accessory. For Almega systems, 
Move Stage appears in the Collect group and may be used to control 
both the optional motorized microscope stage and the XYZ stage in 
the spectrometer sample compartment. 
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Task Parameters 
You must specify the stage movement in the X, Y and Z direction. 
You may use macro variables (#mv#) to specify the stage 
movement. When the macro is run, the Move Stage task moves the 
stage the specified amount without displaying prompts to the 
operator. The stage is moved relative to the current position of the 
sample.  
To specify the Move Stage task parameters, double-click the Move 
Stage task symbol in your macro. The software displays the Move 
Stage task dialog box. The parameters that appear in the dialog box 
depend on the type of system you are using. Set the dialog box 
parameters as described below.  
 
FT-Raman View Stage Controls 
If you are using an FT-Raman system, the Move Stage dialog box 
appears with the Sample Position option set to FT-Raman View 
Stage. The Move Stage task can be used to control the sample stage 
on an FT-Raman View Stage accessory. Set the stage movement 
parameters in step increments as described below. Each step 
corresponds to approximately 0.001 inch (25.4 micrometers).  
 
Focus Enter a positive Focus value to move the sample farther 

from the collection optics; enter a negative value to 
move it closer.  

Left/Right Enter a positive Left/Right value to move the sample to 
the right as you face the sample compartment; enter a 
negative value to move it to the left.  

Front/Back Enter a positive Front/Back value to move the sample 
closer to you as you face the sample compartment; 
enter a negative value to move it farther away from 
you.  
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Almega Microscope Stage Controls 
If you are using an Almega system, the Move Stage task can be used 
to control the optional motorized microscope stage and the XYZ 
stage in the Almega sample compartment. If you are using the Move 
Stage task to control the microscope stage, set the stage movement 
parameters as described below. Keep in mind that the software 
controls are designed to work using a frame of reference that 
assumes you are facing the instrument and looking down through the 
objective lens at the sample. 
 
Sample Position Set to Microscope Stage. 
Focus Enter a positive Focus value in micrometers to 

move the stage up so that the sample is closer to 
the microscope objective; enter a negative value to 
move the stage down.  

X-axis Enter a positive X-axis (right/left) value to move 
the sample to the right as you face the microscope; 
enter a negative value to move it to the left.  

Y-axis Enter a positive Y-axis (in/out) value to move the 
sample away from you as you face the 
microscope; enter a negative value to move it 
towards you.  

 
Almega Sample Compartment (XYZ) Stage Controls 
If you are using the Move Stage task to control the XYZ stage in the 
Almega sample compartment, set the stage movement parameters in 
step increments as described below. Each step corresponds to 
approximately 0.001 inch (25.4 micrometers). Keep in mind that the 
software controls are designed to work using a frame of reference 
that assumes you are the collection lens facing the sample.  
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Sample Position Set to Sample Compartment. 
Focus Enter a positive Focus value in steps to move the 

sample farther from the collection lens; enter a 
negative value to move it closer. Maximum range 
of movement is 400 steps. 

Side To Side Enter a positive Side To Side value in steps to 
move the sample toward the front of the sample 
compartment; enter a negative value to move it 
toward the back. Maximum range of movement is 
1000 steps. 

Up/Down Use the Up/Down parameter to move the sample 
vertically. Enter a positive Up/Down value to 
move the sample up, towards the top of the 
sample compartment; enter a negative value to 
move it down, towards the sample compartment 
baseplate. Maximum range of movement is 320 
steps. 

 
 

 Multiply When the macro is run, the Multiply task multiplies each data point 
in the selected spectrum by a factor and displays the resulting 
spectrum in the active window. 
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
The Multiply task parameter is the same as the OMNIC Multiply 
parameter. It allows you to specify the factor used to multiply each 
data point in the spectrum. 
To specify the factor used to multiply the spectrum, enter a number 
or macro variable in the Multiply dialog box. The macro will not 
execute if the factor is not specified. Then choose OK.  
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 New Window When the macro is run, the New Window task creates a spectral 

window.  
 
Task parameters  
The New Window task parameters are the same as the OMNIC New 
Window parameters. They allow you to specify the title of the new 
window. The New Window task parameters do not need to be set in 
order for the macro to run. If you do not specify a title, the default 
title, WINDOWn, will be used. 
To specify a title for the window, double-click the New Window 
task symbol and enter a title for the window. Then choose OK. 
 
 

 Noise When the macro is run, the Noise task calculates the noise in a 
specified region of the selected spectrum. The result of the noise 
calculation will be stored in the Result variable.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
The Noise task parameters allow you to specify the starting and 
ending values for the region in which to calculate noise. You must 
specify these values when you add the Noise task to the macro. The 
macro will not run if these parameters are undefined.  
To specify the region, double-click the Noise task symbol and enter 
the starting and ending X-axis limits. The limits must be specified in 
the same X-axis units as the selected spectrum. If you want to 
display the result of the noise calculation automatically, select the 
Display Result check box. Then choose OK. 
The results of the Noise calculation will be saved in the Result 
variable. 
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 Note You may display the task results using a Comment task or send them 

to OMNIC or another Windows application using a Report task by 
including the placeholder #result# in the text of your comment or 
report.  #Result# will be replaced by the results of the task at run 
time.  Each task result may also be stored in a macro variable by 
using a math task after the current task and setting up the math task 
to define a macro variable for #result# (for example, set mv1 equal 
to #result#).  
 
 

 Normalize Frequency When the macro is run, the Normalize Frequency task repositions 
spectral data points relative to the standard reference laser 
frequency. 
When the frequency is normalized, the spectral data points are 
repositioned as if they had been collected using an optical bench 
with a reference laser frequency of 15,798.0 wavenumbers. This 
allows you to compare spectra that were collected using optical 
benches with different laser frequencies. 
 

 Note The frequency is normalized only if it is not equal to the reference 
frequency and the difference between the two is less than 20 
wavenumbers.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
This task does not have any settable parameters. 

 
 
 Normalize Scale When the macro is run, the Normalize Scale task scales the selected 

spectrum from 0 to 1 absorbance units or from 0% to 100% 
transmittance units. The resulting spectrum becomes the selected 
spectrum in the active spectral window. These normal scales are 
typical of spectra in commercial spectral libraries. 
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Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time.  
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Offset Scale When the macro is run, the Offset Scale task displays all of the 
spectra in the window so that they are vertically offset from one 
another.  
 
Task parameters  
This task does not have any settable parameters. 
 
 

 OMNIC DDE When the macro is run, the OMNIC DDE task executes the specified 
OMNIC Dynamic Data Exchange (DDE) instruction. OMNIC DDE 
instructions allow you to initiate an OMNIC command, set an 
OMNIC parameter or return a parameter value.  
 
Task parameters  
The OMNIC DDE task parameters allow you to specify the OMNIC 
DDE instruction to be executed. You must specify the OMNIC 
command to be initiated or the OMNIC parameter value to be set or 
retrieved when you add this task to the macro. The macro will not 
run if there is no DDE command to execute. You may use a macro 
variable placeholder as a value when setting a macro parameter. For 
example,  

SetOMNIC “Display Xstat” , #mv1#  
At run time, the OMNIC DDE task uses the macro variable #result# 
to return the error completion code. It is set to “OK” if the OMNIC 
DDE command succeeded. If you are executing more than one 
command, this completion code refers only to the last command in 
the OMNIC DDE task.  
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If you are getting the value of an OMNIC parameter, use the Store 
Result task to store the parameter value into a macro variable. If you 
are getting more than one parameter, only the value of the last one 
can be stored. 
When the Display Error Messages At Runtime option is checked, the 
macro pauses if an error occurs during the OMNIC DDE task and 
displays an error message. If this option is not checked, errors are 
ignored and the macro continues without interruption. 
You can test for errors after the OMNIC DDE task by using the 
Store Result task. In the Store Result dialog box, select OMNIC 
DDE as the task and Error as the result. If no errors occur, the result 
will be null. If an error occurs, the text of the error is placed into the 
macro variable. 
If you are executing an OMNIC command which calculates a value, 
you must specifically request the result value by getting the value of 
Result Current or Result Array. Just executing the command does 
not return a value. For example,  

ExecuteOMNIC “FWHH” 
GetOMNIC “Result Array” 

To display the OMNIC DDE task parameters, double-click the 
OMNIC DDE task symbol. For detailed instructions on specifying 
an OMNIC DDE command or parameter, see chapter 9, “Designing 
a Macro with OMNIC DDE.” When you are finished setting the task 
parameters, choose OK. 
 
 

 Open When the macro is run, the Open task opens the spectrum or spectra 
specified in the Open setup dialog box. The spectrum or spectra will 
be displayed in the active OMNIC window. 
 
Task parameters  
The Open task parameter is the same as the OMNIC Open 
parameter. It allows you to specify the spectral file(s) to be opened. 
The Open task parameter does not need to be set in order for the 
macro to run. If the parameter is not set, the operator will be 
prompted to select the file to open at run time. 
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To specify the spectral file(s) to be opened, double-click the Open 
task symbol. To specify one spectrum, enter its full name in the File 
Name box, or click the Browse button and select its name in the list 
box. If you want to open more than one spectrum, click the Browse 
button in the File Name box, then hold down the Ctrl key and make 
your selections. You can use the Shift key to select contiguous file 
names. Multiple file lists are not editable. When you are finished 
selecting the files, choose OK.  
To allow the operator to specify the file when the macro is run, click 
to turn on the Display Open File Dialog At Run Time check box. If 
this option is checked, the contents of the File Name edit box is 
ignored. 
To edit the list of spectra to be opened after they have already been 
specified, double-click the Open task symbol. Select the spectra to 
be opened as described above and then choose OK. 
 
 

 Open Configuration When the macro is run, the Open Configuration task opens the 
Configuration file (*.CON) specified in the Open Configuration 
dialog box. 
 
Task parameters  
The Open Configuration task parameter is the same as the OMNIC 
Open Configuration parameter. It allows you to specify the 
configuration file to be opened, or to allow the operator to specify a 
file. 
To specify the configuration to be opened, double-click the Open 
Configuration task symbol. Select the file from the standard open 
file dialog box. When you are finished selecting the files, choose 
OK.  
To allow the operator to specify the file when the macro is run, click 
to turn on the Display Open File Dialog At Run Time check box. If 
this option is checked, the contents of the File Name edit box is 
ignored. 
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 Note The Open Configuration task replaces the Open Options task found 

in versions of OMNIC before OMNIC E.S.P. If you have an existing 
macro containing an Open Options task, it will still function 
correctly. However, for best performance, you should manually 
delete it and replace it with an Open Configuration task.  
 
 

 Open Data Set The Open Data Set task appears in the Macros\Basic task list only 
when OMNIC Series software is loaded on the computer. When the 
macro is run, the Open Data Set task opens the data set file (*.SRS) 
specified in the Open Data Set dialog box.  
 
Task parameters  
The Open Data Set task parameter is the same as the OMNIC Data 
Set parameter. It allows you to specify the data set file to be opened, 
or to allow the operator to specify a file. 
To allow the operator to specify the data set file when the macro is 
run, click to turn on the Display Open File Dialog At Run Time 
check box. If this option is checked, the contents of the File Name 
edit box is ignored. 
 

 
 Open Experiment When the macro is run, the Open Experiments task opens the 

parameter file specified in the Open Experiments setup dialog box. 
 
Task parameters  
The Open Experiments task parameter allows you to specify the 
experiment file to be opened. The Open Experiments task parameter 
does not need to be set in order for the macro to run. If the parameter 
is not set, the operator will be prompted to select the parameter file 
to open at run time. 
Select the parameter groups you want included when the experiment 
is opened. To select a parameter group, turn on its check box in the 
Groups box. These check box settings are the ones actually used—
the settings in the file open dialog are ignored. 
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To specify the experiment file to be opened, double-click the Open 
Parameters task symbol. Choose a parameter file or enter its full path 
and file name in the File Name text box. When you are finished, 
choose OK. 
To allow the operator to specify the file when the macro is run, click 
to turn on the Display Open File Dialog At Run Time check box. If 
this option is checked, the contents of the File Name edit box is 
ignored. 
 
 

 Open Log When the macro is run, the Open Log task opens the log file 
(*.LOG) specified in the Open Log setup dialog box and starts 
logging.  
 
Run time requirements  
There must be no open log file at run time in order for this task to 
execute properly. There must be no open log file at run time in order 
for this task to execute properly. If a log file is open prior to the 
Open Log task, the log file specified in this task will not be loaded. 
Instead, the currently opened log will be renamed with the file name 
specified in this task. 
 
Task parameters  
The Open Log task parameter is the same as the OMNIC Open Log 
parameter. It allows you to specify the log file to be opened. The 
Open Log task parameter does not need to be set in order for the 
macro to run. If the parameter is not set, the operator will be 
prompted to select the log file to open at run time.  
To specify the log file to be opened, double-click the Open Log task 
symbol. Select a log file or enter its full name in the File Name text 
box. Then choose OK.  
To allow the operator to specify the file when the macro is run, click 
to turn on the Display Open File Dialog At Run Time check box. If 
this option is checked, the contents of the File Name edit box is 
ignored. 
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 Other Conversions When the macro is run, the Other Conversions task converts the 

selected spectrum or spectra to the units which are specified in the 
Other Conversions setup dialog box (Kubelka-Munk, photoacoustic, 
% reflectance, log (1/r), wavenumbers, micrometers, or nanometers).  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
The Other Conversions task parameter is the same as the OMNIC 
Other Conversions parameter. It allows you to specify the 
conversion to be used when this task is executed. You must specify 
the conversion to be used when you add this task to the macro. The 
macro will not run if this parameter is undefined.  
To specify the conversion to be used, double-click the Other 
Conversions task symbol. Select the conversion to be used and 
choose OK. 
 

 Note You cannot use macro variables to set the Other Conversions 
parameter.  

 
 
 Other Corrections When the macro is run, the Other Corrections task performs the 

specified correction on the selected spectrum. Corrections include 
dispersion, ATR, H2O, CO2, and H2O and CO2. 
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
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Task parameters  
The Other Corrections task parameter is the same as the OMNIC 
Other Corrections parameter. It allows you to specify the correction 
to be used when this task is executed. You must specify the 
correction to be used when you add this task to the macro. The 
macro will not run if this parameter is undefined.  
To specify the correction to be used, double-click the Other 
Corrections task symbol. Select the correction to be used and choose 
OK. 
 

 Note This task will fail if the selected spectrum is a Raman spectrum 
because this is not an allowed operation for a Raman spectrum.  
 

 Note You cannot use macro variables to set the Other Corrections 
parameter.  
 
 

 Overlay Spectra When the macro is run, the Overlay Spectra task displays the 
currently displayed spectra in the active window in overlaid panes.  
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Paste When the macro is run, the Paste task pastes the spectrum or spectra 
currently on the Clipboard into the active window.  
 
Run time requirements 
A spectrum must be on the Clipboard in order for this task to execute 
properly at run time. 
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Paste to Log When the macro is run, the Paste to Log task pastes the spectrum or 
spectra currently on the Clipboard into the active log file.  
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Run time requirements 
A spectrum must be on the Clipboard in order for this task to execute 
properly at run time. The task will fail if there is not a spectrum on 
the Clipboard. 
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Peak Area When the macro is run, the Peak Area task calculates an uncorrected 
and corrected peak area for the specified peak. The uncorrected peak 
area is calculated for the specified region above zero absorbance 
units. The corrected peak area is the area for the specified region 
above the baseline you specify. The result of the peak area 
calculations will be stored in the Result variable. This will be the 
same text as that displayed in the OMNIC status bar when you use 
the Peak Area tool. 
 
Run time requirements  
An absorbance spectrum must be selected in order for this task to 
execute properly at run time. If more than one spectrum is selected, 
OMNIC issues a Failed message.  
 
Task parameters  
The Peak Area task parameters allow you to specify how the peak area 
will be calculated and whether or not to display the peak area 
calculation results at run time. You must specify the X-axis limits of 
the region to be measured when you add this task to the macro. The 
macro will not run if these parameters are undefined. You may also 
specify the X-axis limits of the baseline to be used for calculating peak 
area and whether or not to display the calculation results at run time. 
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To set the Peak Area task parameters, double-click the Peak Area 
task symbol. Enter the starting and ending X-axis limits for the 
region to be measured. Enter the starting and ending limits for the 
corrected peak area baseline. The values you enter for the region and 
baseline limits must be in the same X-axis units as the selected 
spectrum. If you do not enter the starting and ending X-axis limits 
for the baseline, a baseline will be drawn over the same region as the 
uncorrected peak area. If you want to display the peak area results 
dialog box at run time, turn on the Display Result check box. When 
the parameters are set, choose OK.  
The results of the peak area calculation will be saved in the Result 
variable. 
 

 Note You may display the task results using a Comment task or send them 
to OMNIC or another Windows application using a Report task by 
including the placeholder #result# in the text of your comment or 
report.  #Result# will be replaced by the results of the task at run 
time.  Each task result may also be stored in a macro variable by 
using a math task after the current task and setting up the math task 
to define a macro variable for #result# (for example, set mv1 equal 
to #result#).  
 
 

 Peak Height When the macro is run, the Peak Height task calculates an 
uncorrected and a corrected peak height for the specified peak. The 
uncorrected peak height is calculated for the specified location 
above zero absorbance units. The corrected peak height is the height 
of the specified point above the baseline you specify. The result of 
the peak height calculations will be stored in the Result variable. 
This will be the same text as that displayed in the OMNIC status bar 
when you use the Peak Height tool. 
 
Run time requirements  
An absorbance spectrum must be selected in order for this task to 
execute properly at run time. If more than one spectrum is selected, 
OMNIC issues a Failed message. 
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Task parameters  
The Peak Height task parameters allow you to specify the peak 
location and baseline limits to be used for the corrected peak height 
calculation. You must specify a peak location when you add this task 
to the macro. The macro will not run if this parameter is undefined. 
If you want OMNIC to calculate the height of the peak that is closest 
to the location you specify, turn on the Seek Closest Peak check box. 
You may also specify the X-axis limits of the baseline to be used for 
calculating peak height and whether or not to display the calculation 
results at run time. 
To set the Peak Height task parameters, double-click the Peak 
Height task symbol. Enter the peak location. If you want OMNIC to 
use the maximum peak closest to the position you specify, turn on 
the Seek Closest Peak check box. If you want to calculate the 
corrected peak height, enter the starting and ending baseline limits. 
The values you enter must be in the same X-axis units as the selected 
spectrum. If you want to display the Peak Height results dialog box 
at run time, turn on the Display Result check box. When the 
parameters are set, choose OK.  
The results of the peak height calculation will be saved in the Result 
variable. 
 

 Note You may display the task results using a Comment task or send them 
to OMNIC or another Windows application using a Report task by 
including the placeholder #result# in the text of your comment or 
report.  #Result# will be replaced by the results of the task at run 
time.  Each task result may also be stored in a macro variable by 
using a math task after the current task and setting up the math task 
to define a macro variable for #result# (for example, set mv1 equal 
to #result#).  

 
 
 Preview/Print Report When the macro is run, the Preview/Print Report task either displays 

or prints a report using the currently selected report template. You 
have the option to display the Print dialog box at run time. 
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Task parameters  
To preview the report when the task executes, choose Preview 
Report. To print the report when the task executes, choose Print 
Report. To allow the operator to change the print options when the 
macro is run, click to turn on the Display Print Dialog At Run Time 
check box. The default is to print the report without displaying the 
dialog. 

 
 
 Print When the macro is run, the Print task prints the contents of the active 

window as they are displayed. If no Printer Setup task is added to the 
macro before the Print task, the currently selected printer will be 
used. 
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Printer Setup When the macro is run, the Printer Setup task displays the OMNIC 
Printer Setup dialog box. This allows the operator to select the 
printer to be used for any subsequent print tasks. 
 
Task parameters  
This task does not have any settable parameters. The Printer Setup 
parameters are set by the operator at run time when the Printer Setup 
task executes. 
 
 

 Purge Correct Calibration When the macro is run, the Purge Correct Calibration task performs 
a Quant Purge Correct Calibration, which lets you create or 
recalibrate a quantitative analysis method to use for correcting 
spectra for the effects of water vapor or carbon dioxide or both. 
After you create a method, it becomes available for use by Quant 
Purge Correct in the Process menu. 
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Creating or calibrating methods involves collecting water and carbon 
dioxide reference spectra at several levels of purge. When the task 
runs, the user is required to select a method and open the sample 
compartment on the optical bench. Once started, the collection is 
automated and takes one to two hours. 
 
Task parameters  
This task does not have any settable parameters. 

 
 
 QC Compare When the macro is run, the QC Compare task compares the spectrum 

of the sample with spectra in the specified QC libraries and reports 
how well the spectrum matches the library spectra. 
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
The QC Compare task parameters allow you to define the way the 
QC Compare results are displayed. You can display the interactive 
window, create a results window, or hide the window. If you select 
to create a results window, you can also select to print the results. 
The entire displayed region is compared during a QC Compare. If 
you want to limit the spectral region compared, have the user define 
the region manually before running the macro, or use a task such as 
Blank Display Limits to automatically define the comparison region. 
The QC Compare task parameters allow you to choose whether you 
want to show the OMNIC QC Compare window and a search results 
window, show only a search results window, or hide both windows 
when this task is executed at run time. If you display the OMNIC 
QC Compare window, the macro will not proceed to the remaining 
tasks until you close the Search window. If you display only a search 
results window or hide both windows, the macro will automatically 
proceed to the remaining tasks when the search is completed. 
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To set the QC Compare task parameter, double-click the QC 
Compare task symbol. If you want to show the OMNIC search 
results window, click the button for Display Interactive Search 
Window. If you want to hide the OMNIC Search window and add 
the results to a new window, click the button for Create Results 
Window. If you want to print the results, turn on the Print Result 
check box when Create Result Window is selected. If you want to 
hide both windows during the search operation, click the Hide 
Windows button. Then choose OK. 
 
The QC Compare search results will be stored in the Result variable. 

 
 Note If you want to identify an unknown spectrum, use the Search task.  

 
 Note You may display the task results using a Comment task or send them 

to OMNIC or another Windows application using a Report task by 
including the placeholder #result# in the text of your comment or 
report.  #Result# will be replaced by the results of the task at run 
time.  Each task result may also be stored in a macro variable by 
using a math task after the current task and setting up the math task 
to define a macro variable for #result# (for example, set mv1 equal 
to #result#). Use the Report task to append the search results to a log 
file.  
 
 

 Quantify When the macro is run, the Quantify task uses the currently selected 
quantitative method to analyze the selected spectrum. The result of 
the quantify calculation will be stored in the Result variable.  
 
Run time requirements  
A spectrum must be selected and a quantitative method must be 
selected in order for this task to execute properly at run time. If no 
quantitative method is selected prior to the Quantify task, the macro 
will fail at run time. 
 

172       OMNIC Macros User’s Guide 
 



 
Task parameters  
The Quantify task parameter lets you specify whether or not to 
display the quantitative results dialog box at run time. The Quantify 
task parameter does not need to be set in order for the macro to run. 
If the parameter is not set, the Quant results dialog box will be 
displayed when this task is executed at run time. 
If you are using a quantitative method that uses a known pathlength, 
you can also choose to use a specific pathlength value or prompt the 
user for a pathlength at run time. If the quantitative method does not 
use a known pathlength, this option is ignored. That is, setting a 
value here does not change the quantitative method to a known 
pathlength type. 
To set the Quantify task parameter, double-click the Quantify task 
symbol. Turn the Display Result check box on or off. If you are 
using a quantitative method that uses a known pathlength, you can 
choose either Prompt For Pathlength At Run Time or Use This 
Pathlength Value and enter a value. Then choose OK. 
The result of the quantify operation will be saved in the Result 
variable 
 

 Note You may display the task results using a Comment task or send them 
to OMNIC or another Windows application using a Report task by 
including the placeholder #result# in the text of your comment or 
report.  #Result# will be replaced by the results of the task at run 
time.  Each task result may also be stored in a macro variable by 
using a math task after the current task and setting up the math task 
to define a macro variable for #result# (for example, set mv1 equal 
to #result#).  
 
 

 Quant Setup When the macro is run, the Quant Setup task selects the quantitative 
method specified in the Quant Setup dialog box, and optionally, 
resets the OMNIC experiment parameters to those stored in the 
quantitative method. 
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Task parameters  
The Quant Setup task parameters are the same as the OMNIC Quant 
Setup parameters. They let you specify the quantitative method to be 
used for the Quantify task and whether or not to reset the Collect and 
Bench parameters. The Quant Setup method file does not need to be 
set in order for the macro to run.  
To select the quantitative method, double-click the Quant Setup task 
symbol. Select the quantitative method from the list of available 
methods and then choose OK. 
To allow the operator to specify the file when the macro is run, click 
to turn on the Display Quant Setup Dialog At Run Time check box. 
If this option is checked, the contents of the File Name edit box is 
ignored. 
If you want to reset the OMNIC data collection and optical bench 
parameters to match the method you are opening, turn on the Collect 
and Bench check boxes. Resetting the parameters here is a 
convenient way to prepare for collecting sample spectra to be 
analyzed with the method. 
 
 

 Raman Shift The Raman Shift task appears in the Macros\Basic task list only 
when OMNIC for Raman software is loaded on the computer. When 
the macro is run, the Raman Shift task shifts the selected Raman 
sample spectrum by the standard laser frequency, 9394 
wavenumbers. The shifted spectrum will automatically replace the 
original spectrum and will be displayed with an X-axis range of 
3600 to 100 wavenumbers.  
 
Run time requirements  
A spectrum that has not been shifted by the standard or a custom 
laser frequency must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
This task does not have any settable parameters. 
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 Region Subtract When the macro is run, the Region Subtract task does an auto-scaled 

subtraction of one spectrum from another based on a specified 
spectral region. When you add the Region Subtract task to a macro, 
you must specify a reference spectrum to use for the subtraction and 
the spectral region over which the subtraction factor is to be 
calculated. The macro will not run if these parameters are undefined.  
 
Task parameters  
To set the Region Subtract task parameters, double-click the Region 
Subtract task symbol in your macro. The Region Subtract dialog box 
is displayed. Enter the Start and End location of the region you wish 
to use to determine the subtraction factor. The values you enter must 
be in the same X-axis units as the selected spectrum. Set the option 
for locating the subtraction reference to either File Name or 
Spectrum Title and then enter the reference file name or title in the 
text box. When the parameters are set, choose OK. 
At run time, the software uses the specified region of the two spectra 
to calculate a factor which minimizes the difference between the 
spectra in that region. That factor is then used to calculate the 
difference between the entire spectra (where they overlap). If the 
spectra do not have the same resolution, the spectrum with the 
higher resolution will be temporarily deresolved to match the 
resolution of the other spectrum. The subtraction operation will take 
longer in this case. 
The subtraction result becomes the active spectrum when the 
subtraction is completed. The title of the spectrum will be 
"Subtraction Result." 
 
 

 Report When the macro is run, the Report task outputs the specified text to 
the OMNIC log file, a field in an OMNIC spectrum, a text file or 
another Windows application via dynamic data exchange (DDE).  
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Run time requirements  
If you set up the Report task to send text to a field in an OMNIC 
spectrum, a spectrum must be selected in order for the task to 
execute properly at run time. If more than one spectrum is selected, 
OMNIC issues a failed message. If you set up the Report task to 
send text to the log file, an Open Log task must appear earlier in the 
macro in order for the Report task to execute properly at run time. If 
you set up the Report task to send text to another Windows 
application via DDE, the other application must be open in order for 
the text to be sent. If the application is not open, no DDE 
communication will occur but the macro will continue. 
 
Task parameters  
The Report task parameters allow you to specify the text to be 
reported and where it will be sent. You must specify both of these 
parameters when you add the Report task to the macro. The macro 
will not run if these parameters are undefined. 
To set the Report task parameters, double-click the Report task 
symbol. Enter the text to be reported at run time. The text may 
include placeholders for macro variables or the Result variable. If 
you add a placeholder for a macro variable or for the Result variable 
to the report, OMNIC will replace it with the current value of the 
macro variable or the Result variable at run time.  
To include the current value of the Result variable in the reported 
text, type the placeholder #result# in the Report text box. To include 
a macro variable placeholder in the reported text, click in the Report 
text box and then click a name in the list of the Macro Variables 
window. A placeholder for the macro variable you select will appear 
at the end of any existing text.  

 Note You should only include placeholders for macro variables that have 
already been defined. If you include a placeholder for an undefined 
macro variable, the variable will not have a value at run time and the 
Report task may cause unexpected results. For information on 
defining macro variables, see the “Using Variables in Macros” 
section in chapter 2, “Creating a Macro Using Macros\Basic.  
Select where you want the text to be sent. You may send it to a field 
in the selected OMNIC spectrum, the OMNIC log file, a text file or 

176       OMNIC Macros User’s Guide 
 



 
another Windows application. Instructions for choosing each of 
these options are provided below. 
To spectrum header field - Sends the text to a field in the selected 
OMNIC spectrum. When you choose this option, the list box for 
choosing a field in the spectrum header becomes active. Select 
whether you want the text to be placed in the Title or Comment field 
of the selected spectrum or appended to the spectrum’s history. You 
can also add the text to custom information fields. 
Append to log - Appends the text to the open OMNIC log file. 
Append to file - Appends the text to the specified text file. If you 
choose this option, enter the full path and file name of the text file or 
choose Browse to select a text file stored on the disk. If the specified 
file does not exist at run time, OMNIC will create it. 

 Note When appending to a text file, make sure to include a carriage return 
in the text field if you want data appended on separate lines. Data is 
appended exactly as entered in the text field.  
DDE - Sends the text to another Windows application, such as Excel 
or Lotus 1-2-3. If you choose this option, enter the name of the 
application, topic and item that the text should be sent to. The 
application name is usually the same as the application’s .EXE file 
name but without the .EXE extension. Some examples are provided 
below. 
 
 Product Name Application Name 

 Microsoft Word winword 
 Microsoft Excel excel 
 Lotus 1-2-3 123w 
 
Topic is a generic term for the type of file a given application 
creates, such as a spreadsheet file or a document file. Item refers to a 
field within the specified file, such as a row or column in a 
spreadsheet or a bookmark in a Microsoft Word document.  

 Note To determine the appropriate syntax for communicating with an 
application via DDE, refer to the documentation that came with the 
application.  
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You may include placeholders for other macro variables in any of 
the DDE fields by clicking in the Application, Topic or Item text box 
and then double-clicking a name in the list of currently defined 
macro variables. A placeholder for the macro variable you select will 
be added to the existing text in the selected text box.  
If you add a macro variable placeholder to a DDE field, OMNIC will 
replace it with the current value of the macro variable at run time. 
For example, if you place the Report task in a loop that increments 
the value of the macro variable mv1, then choose the DDE option 
and set Application=excel, Topic=Book1 and Item=R#mv1#C2, 
OMNIC will place the specified text in a different row of an Excel 
spreadsheet each time it completes the loop. 
When you are finished setting the Report task parameters, choose 
OK. 
For examples of how to use the Report task, see chapter 7, “Example 
Macros.” 

 
 
 Reprocess When the macro is run, the Reprocess task allows you to select a 

spectrum to be reprocessed. The reprocessed spectrum is added to 
the active spectral window and becomes the selected spectrum. For 
example, you can transform the interferogram data for a spectrum 
using different parameter settings or ratio the spectrum against a 
different background to improve the final data.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. The spectrum and background interferograms 
must have been saved on a disk when the spectrum was collected in 
order to reprocess the data. 
 
Task parameters  
The Reprocess task parameters are the same as the OMNIC 
Reprocess parameters. They allow you to specify the settings for the 
spectrum to be reprocessed, or to allow the operator to specify the 
settings. 
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To specify the spectrum to be reprocessed, double-click the 
Reprocess task symbol. Choose the parameters for reprocessing the 
spectra. Then choose OK. 
To allow the operator to specify the file when the macro is run, turn 
on the Display Reprocess Dialog At Run Time check box. If this 
option is checked, the settings in the Reprocess task dialog are 
ignored, and the operator can modify the parameter settings at run 
time. 
 
 

 Reprocess Series The Reprocess Series task appears in the Macros\Basic task list only 
when OMNIC Series software is loaded on the computer. When the 
macro is run, the Reprocess Series task allows you to select series 
data to be reprocessed. The series data must be in interferogram or 
single-beam format. You can transform them into a different format 
such as absorbance or % transmittance using various parameter 
settings. The reprocessed data will overwrite all the data collected 
during the experiment; you cannot reprocess only portion of the time 
range, and you can not reprocess a series more than once. To 
reprocesses a series more than once, make a copy of it before 
reprocessing. 
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. The spectrum and background interferograms 
must have been saved on a disk when the spectrum was collected in 
order to reprocess the series data. 
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Task parameters  
The Reprocess Series task parameters are the same as the OMNIC 
Reprocess Series parameters. They allow you to specify the settings 
used to reprocess the series, or to allow the operator to specify the 
settings. 
To specify the series to be reprocessed, double-click the Reprocess 
Series task symbol. Choose the parameters for reprocessing the 
series. Then choose OK. 
To allow the operator to specify the file when the macro is run, turn 
on the Display Reprocess Dialog At Run Time check box. If this 
option is checked, the contents of the file name edit box is ignored, 
and the operator can modify the parameter settings at run time. 

 
 
 Request When the macro is run, the Request task displays the specified 

message prompting the operator to enter a value, or reads a value 
from a text file or via DDE. If the macro prompts for a value, it will 
not proceed until the operator responds to the request by entering a 
value and pressing OK or by pressing Cancel. If the operator enters a 
value, the value will be stored as a macro variable which may be 
used in other operations in the macro. The macro continues 
automatically if it reads a value from a text file or via DDE. 
 
Task parameters  
The Request task parameters allow you to specify the text to be 
displayed at run time and the macro variable that will store the 
requested information. You must specify the macro variable and the 
source of the input value; the operator, a text file or via DDE. The 
macro will not run if these parameters are undefined.  
To set the Request task parameters, double-click the Request task 
symbol. Enter an unused number for this macro variable (1-65535). 
The Macro Variable window displays a list of macro variables that 
have already been assigned.  
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Select the source of the input variable. You may obtain it from the 
operator upon macro execution, a text file or another Windows 
application. Instructions for choosing each of these options are 
provided below. 
Prompt For Value With This Text - Enter the text to be displayed 
at run time to prompt the operator to enter an input value. The text 
may include placeholders for other macro variables or for the Result 
variable. To include a macro variable placeholder in the request, 
double-click its name in the list of currently defined macro variables. 
A placeholder for the macro variable you select will appear at the 
end of any existing text. To include a placeholder for the Result 
variable in the Request, type the phrase #result# in the Request text 
box. If you add a placeholder for a macro variable or the Result 
variable to the request, OMNIC will replace it with the current value 
of the macro variable or the Result variable at run time. 
Read Value From File - Enter the name of the file or click the 
Browse button to select a file. 

 Note The entire contents of the file is read into the macro variable. If the 
file contains multiple values, items, or lines of text, use the Math 
task to extract the value you want.  
DDE - To read the value from another Windows application via 
DDE, such as Excel or Lotus 1-2-3, enter the name of the 
application, topic and item that the text should be read from. The 
application name is usually the same as the application’s “.EXE” 
file name but without the “.EXE” extension. Some examples are 
provided below. 
 
 Product Name Application Name 

 Microsoft Word winword 
 Microsoft Excel excel 
 Lotus 1-2-3 123w 
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Topic is a generic term for the type of file a given application 
creates, such as a spreadsheet file or a document file. Item refers to a 
field within the specified file, such as a row or column in a 
spreadsheet or a bookmark in a Microsoft Word document.  

 Note To determine the appropriate syntax for communicating with an 
application via DDE, refer to the documentation that came with the 
application.  
You may include placeholders for other macro variables in any of 
the DDE fields. If you add a macro variable placeholder to a DDE 
field, OMNIC will replace it with the current value of the macro 
variable at run time. For example, if you place the Report task in a 
loop that increments the value of the macro variable mv1, then 
choose the DDE option and set Application=excel, Topic=Book1 
and Item=R#mv1#C2, OMNIC will place the specified text in a 
different row of an Excel spreadsheet each time it completes the 
loop. 
When you are finished setting the Request task parameters, choose 
OK. 
 
 

 Restore Window When the macro is run, the Restore Window task restores the 
specified window to its size and position before it was minimized or 
maximized. You can specify either the active spectral window or the 
OMNIC application window.  
 
Task parameters  
The Restore Window task parameter allows you to specify the 
window to be restored. The Restore Window task parameter does not 
need to be set in order for the macro to run. If the parameter is not 
set, the active window will be restored. 
To select the window to be restored, double-click the Restore 
Window task symbol. Select the window and then choose OK. 
 
 

 Retrieve Interferograms When the macro is run, the Retrieve Interferograms task extracts 
background and sample interferograms from the selected spectrum. 
The extracted interferograms are added to the active spectral 
window and the background interferogram is the selected spectrum. 
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Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. To be retrieved and displayed, the 
interferograms for a spectrum must have been saved when the 
spectrum was collected. 
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Return Value The Return Value task is used only in function macros which are 
called from another macro. When a function macro is called and 
executed, the Return Value task defines the value to be sent back to 
a calling macro. 
 
Task parameters  
When the macro is run, the Return Value task makes available the 
contents of the text box in this task to the calling macro. Normally 
this is the value of a macro variable calculated by the function 
macro, but it could also include text. 
Macro variables are unique to the macro in which they are defined. 
In other words, all macro variables are local and known only to the 
macro currently executing. There are no global macro variables 
known to all macros. This task provides a way to share macro 
variable values between two macros. 

 
 
 Revert Basis Vector The Revert Basis Vector task appears in the Macros\Basic task list 

only when OMNIC Series software is loaded on the computer. When 
the macro is run, the Revert Basis Vector task removes all added 
basis vectors from the Gram-Schmidt basis set in the active Series 
Reconstruction window. 
 
Run time requirements  

A Series Reconstruction window must be active in order for this task 
to execute properly at run time. The basis vectors that were used to 
process the data immediately after collection are not removed.  
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Task parameters  

This task does not have any settable parameters. 
 
 

 Save When the macro is run, the Save task saves the currently selected 
spectrum using its current file name and path. If the spectrum has not 
been saved before, the OMNIC Save As dialog box will appear.  
 
Run time requirements  

A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  

This task does not have any settable parameters. 
 
 

 Save As When the macro is run, the Save As task saves the currently selected 
spectrum with the file name specified in the Save As setup dialog 
box.  
 
Run time requirements  

A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  

The Save As task parameter is the same as the OMNIC Save As 
parameter. It allows you to specify the file name for the spectrum. 
The Save As task parameter does not need to be set in order for the 
macro to run. If the parameter is not set, the operator will be 
prompted to enter a file name for the spectrum at run time. 
To specify a file name to use when the spectrum is saved, double-
click the Save As task symbol. Enter a file name for the spectrum in 
the File Name text box and then choose OK. 
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To allow the operator to specify the file when the macro is run, click 
to turn on the Display Save File Dialog At Run Time check box. If 
this option is checked, the contents of the File Name edit box is 
ignored. 
 
 

 Save Configuration As When the macro is run, the Save Configuration As task saves the 
current OMNIC configuration settings in a configuration file 
(.CON). 
 
Task parameters  
The Save Configuration As task parameter is the same as the 
OMNIC Save Configuration As parameter. It allows you to specify 
the file name for the configuration file. The Save Configuration As 
task parameter does not need to be set in order for the macro to run. 
If the parameter is not set, the operator will be prompted to enter a 
parameter file name at run time.  
To specify a file name to use when the configuration file is saved, 
double-click the Save Configuration As task symbol. Enter a file 
name for the configuration file in the File Name box and then choose 
OK. 
To allow the operator to specify the file when the macro is run, click 
to turn on the Display Save File Dialog At Run Time check box. If 
this option is checked, the contents of the File Name edit box is 
ignored. 
 

 Note The Save Configuration task replaces the Save Parameters As task 
found in versions of OMNIC before OMNIC E.S.P. If you have an 
existing macro containing an Save Parameters As task, it will still 
function correctly. However, for best performance, you should 
manually delete it and replace it with an Save Configuration As 
task.  
 
 

 Save Experiment As When the macro is run, the Save Experiment As task saves the 
current OMNIC experiment settings in an experiment file (.EXP). 
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Task parameters  
The Save Experiment As task parameter is the same as the OMNIC 
Save Experiment As parameter. It allows you to specify the file 
name for the experiment file. The Save Experiment As task 
parameter does not need to be set in order for the macro to run. If the 
parameter is not set, the operator will be prompted to enter a 
parameter file name at run time.  
To specify a file name to use when the experiment file is saved, 
double-click the Save Experiment As task symbol. Enter a file name 
for the experiment file in the File Name box and then choose OK. 
Select the parameter groups you want included when the experiment 
is saved. To select a parameter group, turn on its check box in the 
Groups box. These check box settings are the ones actually used—
the settings in the file open dialog are ignored. 
To allow the operator to specify the file when the macro is run, click 
to turn on the Display Save File Dialog At Run Time check box. If 
this option is checked, the contents of the File Name edit box is 
ignored. 
 
 

 Save Group When the macro is run, the Save Group task saves the currently 
selected spectra as a single spectral group file with the file name 
specified. 
 
Run time requirements  

Two or more spectra must be selected in order for this task to 
execute properly at run time. 
 
Task Parameters 

The Save Group task parameter is the same as the OMNIC Save 
Group parameter. It lets you specify the file name for the spectral 
group file. The Save Group task parameter does not need to be set in 
order for the macro to run. If the parameter is not set, the operator 
will be prompted to enter a file name for the spectral group at run 
time. 
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To specify a file name to use when the group of spectra is saved, 
double-click the Save Group task symbol. Enter a file name for the 
spectral group file in the File Name text box and then choose OK. 
To allow the operator to specify the file when the macro is run, click 
to turn on the Display Save File Dialog At Run Time check box. If 
this option is checked, the contents of the File Name edit box is 
ignored. 
 
 

 Search When the macro is run, the Search task searches the selected 
spectrum against the libraries specified in the Library Setup task 
dialog box. The search results will be stored in the Result variable.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
The Search task parameters allow you to choose how you want the 
search results handled when the macro runs. The Search task 
parameters do not need to be set in order for the macro to run. If the 
parameters are not set, the OMNIC Search window will not be 
displayed when this task is executed at run time and the search 
results will be placed in a new window.  

To display the OMNIC search window and wait until the operator 
closes the window, choose the “Display Interactive Window” option. 
The macro will not proceed until the search window is closed. To 
display the search results and then continue with the macro, choose 
the “Create Results Window” option. The search results window is 
displayed and the macro proceeds to the next macro task. To search 
without displaying any window, choose the “Hide Windows” option. 
The search results will be stored in the Result variable. Then choose 
OK.  
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 Note You may display the task results using a Comment task or send them 

to OMNIC or another Windows application using a Report task by 
including the placeholder #result# in the text of your comment or 
report.  #Result# will be replaced by the results of the task at run 
time.  Each task result may also be stored in a macro variable by 
using a math task after the current task and setting up the math task 
to define a macro variable for #result# (for example, set mv1 equal 
to #result#).  
 
 

 Select All When the macro is run, the Select All task selects all of the spectra 
in the active window.  
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Select Spectrum When the macro is run, the Select Spectrum task selects the 
spectrum or spectra to be used in subsequent tasks in the macro. The 
order of selection is the most recently opened or collected spectrum 
first, then back in reverse-order. 
 
Run time requirements  
The spectra to be selected must be in the window which is currently 
active when this task is executed.  
 
Task parameters  
The Select Spectrum parameter allows you to specify the spectrum 
or spectra to be selected. You must set this parameter when you add 
the Select Spectrum task to the macro. The macro will not run if this 
parameter is undefined.  
To specify the spectrum or spectra to be selected, double-click the 
Select Spectrum task symbol. Set the Select Spectrum parameters as 
desired and then choose OK. The parameter options are described 
below. 
All - This option selects all of the spectra in the active window 
(same as Select All task). 
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First - This option selects one spectrum in the active window. The 
spectrum selected is the last one opened or collected. Always use 
this option before using the Next option. 
Next - This option selects another spectrum in the active window. It 
should be used after the First option to select a different spectrum in 
the active window. The spectra are selected in the reverse order of 
their being opened or collected. This option is typically used in a 
loop to carry out an operation on a group of spectra. 

 Note Using the Next option without initially using the First option will 
result in arbitrary spectra selection.  
By Title - This option allows you to select a specific spectrum by its 
title. The text you enter in the Title field must match the spectrum’s 
title exactly in order for the spectrum to be selected. 

 Note You cannot select an OMNIC window with quotes (’) in its name.  
Add To Current Selections - Check this box to leave all currently 
selected spectra selected and to select the new spectrum. This option 
always results in at least two spectra being selected. 

 
 
 Select Template When the macro is run, the Select Template task opens the Select 

Report Template dialog box, which allows you to specify an existing 
report template to use the next time a report is printed. 
 
Task parameters  
The Select Template task parameter is the same as the OMNIC 
Select Template parameter. It allows you to select the Report 
template file, or to allow the operator to specify a file. The Select 
Template task parameter does not need to be set in order for the 
macro to run. If the parameter is not set, the operator will be 
prompted to select the parameter file to open at run time.  
To specify the report template file to be opened, double-click the 
Select Template task symbol. Choose a report template or enter its 
full path and file name in the File Name text box. When you are 
finished, choose OK. 
To allow the operator to specify the report template when the macro 
is run, click to turn on the Display Open File Dialog At Run Time 
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check box. If this option is checked, the contents of the File Name 
edit box is ignored. 
 
 

 Select Window When the macro is run, the Select Window task makes the specified 
window active. 
 
Task parameters  
The Select Window task parameter allows you to select the window 
to make the active window. You must select the window when you 
add this task to the macro. The macro will not run if this parameter is 
undefined.  
To specify the window, double-click the Select Window task 
symbol. Enter the title of window to be made active and choose OK. 
The text must match the window’s title exactly in order for the 
window to be selected. 
 

 Note You cannot select an OMNIC window with quotes (’) in its name 
using the Select Window task.  

 
 
 Series Setup The Series Setup task appears in the Macros\Basic task list only 

when OMNIC Series software is loaded on the computer. When the 
macro is run, the Series Setup task sets the OMNIC series setup 
parameters to the values saved in the Series Setup task dialog box. 
The OMNIC Series Setup dialog box will not be displayed at run 
time.  
 
Task parameters  
The Series Setup task parameters are the same as the OMNIC Series 
Setup parameters. The Series Setup parameters allow you to set the 
parameters that control how spectra are collected, including which 
beam path and accessory are used and how collected spectra are 
checked for quality. You can also use the command to perform 
diagnostic checks of the optical bench and to align the bench.  
To set the Series Setup task parameters, double-click the Series 
Setup task symbol. Enter the parameters on the Collect, Background, 
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Heaters, and Live Display tabs, then choose OK. These parameters 
will load when the macro is run. The user cannot change the 
parameters when the macro is run. 
 

 Note You cannot use macro variables to set the Series Setup parameters.  
 
 

 Set Spectral Reference When the macro is run, the Set Spectral Reference task makes the 
active spectrum the new spectral quality reference spectrum.  
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Show Contour/Waterfall The Show Contour/Waterfall task appears in the Macros\Basic task 
list only when OMNIC Series software is loaded on the computer. 
When the macro is run, the Show Contour/Waterfall task displays a 
contour map of the spectral data contained in the open series data 
set. A contour map is a graphical representation of the absorbance 
response of a series of spectra collected over time and is displayed in 
a contour window. 
 
Run time requirements  
A series data set (.SRS) must be open in order for this task to 
execute properly at run time. 
 
Task parameters  
The Show Contour/Waterfall task parameter allows you to specify 
whether to display the series data set as either a contour or waterfall. 
A contour map is a graphical representation of the absorbance 
response of a series of spectra collected over time. A waterfall shows 
the specified number of consecutive spectra from the open data set in 
a three-dimensional display that makes it easy to see changes in 
absorbance response over time. 
To specify the type of display, double-click the Show 
Contour/Waterfall task symbol and select either Contour or 
Waterfall. Then choose OK. 

OMNIC Macros User’s Guide       191 
 



 
If you want to display the contour or waterfall using parameters 
other than the default settings, run the Contour/Waterfall Setup task 
before the Show Contour/Waterfall task. 
 
 

 Sign File When the macro is run, the Sign File task digitally signs the 
specified file using the current Windows NT/2000 username and 
password. You can sign Thermo Scientific files that contain spectra, 
spectral groups, experiments, configurations or options (option files) 
and JCAMP files. The Sign File task appears in the Macros\Basic 
task list only when our Val-Q DS software is installed.  
 
Task parameters  
When you add the Sign File task to a macro, you may specify the file 
name of the file to be signed or set up the macro to display the Open 
File For Signature dialog box to allow the operator to select a file at 
run time. If both of these parameters are undefined, the macro will 
display the Open File For Signature dialog box at run time.  
To specify the Sign File task parameters, double-click the Sign File 
task symbol in your macro. The Sign File dialog box is displayed. 
Enter the file name of the file to be signed or choose Browse and 
then select the file. You can select a Thermo Scientific file that 
contains a spectrum, spectral group, experiment, configuration or 
options (option file) or a JCAMP file. If you want the operator to 
select the file at run time, leave the File Name box blank and select 
the Display Open File Dialog At Run Time check box. When the 
parameters are set, choose OK. 
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At run time, the software uses the Windows NT/2000 username and 
password of the current user to digitally sign the specified file. If the 
file contains multiple items, such as two or more items in a spectral 
group file (*.SPG) or report notebook file (*.NBK), the software will 
sign all of the items in the file. The visible portion of a digital 
signature consists of a user name, a date and a stated reason for 
signing. A digital signature also contains encrypted information that 
guarantees that the file has not changed since it was signed and that 
the file can be changed only by a user who enters the correct name 
and password. 
 
 

 Smooth When the macro is run, the Smooth task performs a smooth on the 
selected spectrum using the specified number of smooth points.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
The Smooth task parameter is the same as the OMNIC Smooth 
parameter. It allows you to specify the number of smooth points to 
be used for the smooth. The number of smooth points must be 
specified when you add this task to the macro. The macro will not 
run if this parameter is undefined.  
To specify the number of smooth points, double-click the Smooth 
task symbol. Select the number of smooth points from the drop-
down list and then choose OK. 
 

 Note You cannot use a macro variable in this task.  
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 Spectral Interpretation When the macro is run, the Spectral Interpretation task initiates the 

IR Spectral Interpretation command found in the Analyze menu of 
OMNIC, which can help you determine which chemical functional 
groups may be present in an FT-IR sample. The command will 
operate on the active spectrum and the currently selected spectral 
region.  
At run time, the Spectral Interpretation task examines the frequency 
locations and intensities of peaks in the specified spectrum, or in a 
specified spectral region, and then lists the functional groups that 
may be present, along with reference information about the groups. 
Use this information along with your own evaluation of the spectrum 
to determine which functional groups are actually present in the 
sample.  

 
 Note No special preparation is needed before you use this task to find 

functional groups in a spectrum. However, keep in mind that the 
presence of totally absorbing bands in a sample spectrum may 
reduce the accuracy of the results.  
 
The list of functional groups and reference information are displayed 
in the Spectral Interpretation window. The window remains open 
until the operator closes it. After the operator closes the window, the 
macro continues to the next task. 
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Spectral Math When the macro is run, the Spectral Math task allows you to perform 
arithmetic operations on one or two selected spectra. When the 
macro is run, the software performs the operations on the Y values 
of the data points in the spectrum or spectra and then displays the 
result spectrum. 
 
Task parameters  
To specify the Math task parameters, double-click the Spectral Math 
task symbol. 
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The Spectral Math setup dialog box appears with options for 
entering the math operation, and defining the spectrum or spectra to 
be used. To define the operation, type the desired operations just as 
you would any mathematical expression, except do not include an 
equals sign (=). Keep in mind that the software uses the standard 
order of priority when performing the operations; that is, 
multiplication and division before addition or subtraction, and 
operations to the left before those to the right when they have the 
same priority. 
To define the spectra to use, select whether to enter a file name or 
spectrum title. To specify by file name, enter its full name or click 
the Browse button and select its name in the list box. If you select a 
spectrum title, the spectrum must be displayed in order for this task 
to execute properly at run time. 
To allow the operator to specify the arithmetic operation when the 
macro is run, click to turn on the Display Spectral Math Window At 
Run Time check box. If this option is checked, the contents of the 
Spectral Math edit box is ignored. 
 
 

 Split File The Split File task appears in the Macros\Basic task list only when 
OMNIC Series software is loaded on the computer. When the macro 
is run, the Split File task displays the Split File dialog box, which 
allows you to split the current series data set, or just a portion of the 
data set, into separate spectral data files. The new files are created by 
copying the specified portion of the data set; the original data set 
remains intact on the disk. 
 
Run time requirements  
A series data set (.SRS) must be open in order for this task to 
execute properly at run time. 
 
Task parameters  
The Split File task parameters are the similar to the OMNIC Split 
File parameters. They allow you to specify the series file spectra to 
use, and the start and end data range units. 
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To specify the starting and ending values of the portion of the series 
data set you want to split, double-click the Split File task symbol and 
enter values for the start and end of the split and the Base Name. The 
split values must be in the same units as the series data set Z-axis, 
for example, time. The base name is a four-character text string used 
to create the filenames for the individual spectral files. You can use 
macro variables for the Base Name and Start Split and End Split. 
The default directory for retrieving the files is shown in the Target 
File box. To specify the directory location where the current data set 
is located, choose Set Path. When you are finished, choose OK. 

 
 
 Stack Spectra When the macro is run, the Stack Spectra task displays the currently 

displayed spectra in the active window in stacked panes. The number 
of panes used is set by the current Number of Panes in Stack 
parameter setting in the OMNIC Display Setup dialog box.  
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Statistical Spectra When the macro is run, the Statistical Spectra task calculates an 
average or variance spectrum from the selected group of spectra. For 
each data point (X value), you can find the average, variance and 
range of Y values for the group of spectra. 
 
The results of the performed calculation are plotted in a spectral 
window using a vertical axis that indicates the average, variance or 
range and a horizontal axis that is identical to those of the original 
spectra. 
 
Task parameters  
The Statistical Spectra task parameters are the same as the OMNIC 
Statistical Spectra parameters. They allow you to control the data 
format and saved format. 
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To specify statistical spectra, double-click Statistical Spectra task 
symbol. Select the desired data format and save format. Then choose 
OK. 
To allow the operator to specify the parameters when the macro is 
run, click to turn on the Display This Dialog At Run Time check 
box. 

 Note All the spectra in the group must have the same X-axis and Y-axis 
units and the same data spacing.  
 
 

 Stop Macro When the macro is run, the Stop Macro task stops the execution of 
the macro. The Stop Macro task is most useful when used as an 
option in a Decision dialog box to give the operator the choice of 
stopping the macro at a given point. 
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Store Arguments When the macro is run, the Store Arguments task captures values 
passed to this macro from a calling macro, and stores them into 
macro variables. This task can only be used in a macro which will be 
called from another macro (a function macro). 
 
Task parameters  
When the macro is run, the Store Arguments task takes the comma 
separated list of arguments defined in the Macro command task 
(Insert menu) and stores them in macro variables for use by this 
macro. There must be a one-to-one correspondence between the 
argument list in the macro task of the calling macro and the Store 
Arguments macro variable list. 
To specify the arguments to be stored, double-click the Store 
Arguments task symbol. Enter a comma separated list of macro 
variable numbers. Values passed from the calling macro will be 
stored in the macro variables that you define here. 
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For example, if the list of macro variables to store is 1, 2, 5, then the 
first value received will be stored in mv1, the second in mv2 and the 
third into mv5. 
Macro variables are unique to the macro in which they are defined. 
In other words, all macro variables are local and known only to the 
macro currently executing. There are no global macro variables 
known to all macros. This task provides a way to share macro 
variable values between two macros. 
 
When a macro is called as a function, it is the responsibility of the 
function macro to seize the arguments passed to it and set the return 
value. 
 
 

 Store Result When the macro is run, the Store Result task stores the result from a 
previous task as a macro variable. 

 Note To avoid possible conflicts between tasks, place the Store Result 
task immediately after the task whose result you want to store.  
 
Task parameters  
The Store Result task parameters allow you to specify the task result 
to be stored and the macro variable that will store it. You must 
specify both of these parameters when you add the Store Result task 
to the macro. The macro will not run if these parameters are 
undefined. 
To set the Store Result task parameters, double-click the Store Result 
task symbol. The next available macro variable number will be 
displayed in the setup dialog box. Enter an unused number for this 
macro variable (1-65535) or leave the default number. Select a task in 
the Task list box. If the task produces more than one type of result, 
select the result you want to store in the Result list box. If the 
selected result is a table that may contain multiple entries, such as the 
result from a Find Peaks task, enter the item number for the result 
you want to store. When you are finished, choose OK.  
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 Store Quant Results When the macro is run, the Store Quant Result task stores any or all 

of the results of a Quantify task in macro variables.  
 
Run time requirements  
You must have executed a Quantify task in order for this task to 
execute properly at run time. 
Task parameters  
The Store Quant Results task parameters allow you to specify the 
Quantify task results to be stored. You must specify all of these 
parameters when you add the Store Quant Results task to the macro. 
The macro will not run if these parameters are undefined. 
To set the Store Quant Results task parameters, double-click the 
Store Quant Results task symbol. If you are staring the results from a 
method that was developed using TQ Analyst software, select the 
method analysis type by choosing an option in the Analysis Type list 
box. If you are storing the results from a method that was created in 
another software program for quantitative method development, 
such as QuantIR, QuickIR+, or CLSII, set the analysis type to 
Quantitative. Then choose OK. A dialog box representing a typical 
Quant dialog result is displayed. 
When the cursor is placed over an item in the typical results window, 
a brief description of the item displays at the bottom of the window, 
and the name of the item is displayed at the cursor location. This is 
the name that will appear in the macro variable definition. 
To select the quant file information you want to store from the top 
half of the window, click the item. Highlighted items you select will 
be assigned to a macro variable. Select items in the table portion in 
the bottom half of the window in one of these ways: 

• To store a tab separated list of all the results from that category, 
click the column header. The tab separated list is stored in a 
single macro variable. 
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• To store only specific items in each table category, click an item 
in the column. This displays a prompt that lets you select which 
of the results in that table category you wish to store. Each result 
is stored in a separate macro variable. You may select as many 
items as you want, but do not enter a number greater than the 
number of results calculated by your quantitative method. For 
example, if you have a PLS method that calculates 
concentrations for 10 components, you may enter a value up to 
10. To remove a selection you have made in the table category, 
delete all the values in the prompt dialog and choose OK. 

 Note The actual value of the selected item is determined at run time when 
the Store Quant Result task is executed. The values displayed in this 
dialog are only examples.  
To select all of the items, click to turn on the All Results check box. 
When you have completed selecting items, choose OK. 
 
 

 Straight Line When the macro is run, the Straight Line task generates a straight 
line in the specified region of the selected spectrum.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time. 
 
Task parameters  
The Straight Line task parameters allow you to specify the region to 
be replaced by a straight line. The Straight Line task parameters do 
not need to be set in order for the macro to run. If the parameters are 
not set, the region of the spectrum between the current X-axis 
display limits will be replaced with a straight line. 
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To specify the region of the spectrum to replace with a straight line, 
double-click the Straight Line task symbol. Enter the starting and 
ending X-axis limits for the region. Both values must be entered in 
the same X-axis units as the selected spectrum. To straighten the line 
in the region currently displayed, choose to turn on the Region Being 
Displayed At Run Time check box. When you are finished, choose 
OK. 
 
 

 Subtract When the macro is run, the Subtract task performs a subtraction 
using the selected spectra. The type of subtraction that is performed, 
manual, interactive or automatic, is specified in the Subtract setup 
dialog box.  
 
Run time requirements  
The sample spectra must be selected in order for this task to execute 
properly at run time. The reference spectra must be defined in the 
Subtract setup dialog box. If the Y-axis process checking option on 
the Process tab of the OMNIC Options dialog is on, both spectra 
must be in the same Y-axis units and only spectra in absorbance (or 
absorbance-like units such as Kubelka-Munk or log (1/R) units) can 
be subtracted. If these conditions are not met, OMNIC will fail to 
complete the Subtract task at run time. If the OMNIC Y-axis process 
checking option is off and one of the selected spectra is not in 
absorbance units, Macros\Basic will issue a warning message at run 
time and wait for the operator to respond to the message before 
continuing with the macro. 
 
Task parameters  
The Subtract task parameters allow you to specify the type of 
subtraction to be performed. The Subtract task parameters must be 
set in order for the macro to run. 
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To specify the type of subtraction that is performed, double-click the 
Subtract task symbol. If you want to display the Subtract window at 
run time, choose Display Subtract Window To Adjust Factor. When 
the Subtract window is displayed at run time, the macro will not 
proceed until the Subtract window is closed. If you choose either the 
Automatically Calculate Factor or Use This Factor options, the 
Subtract window will not be displayed. Choose Automatically 
Calculate Factor if you want the system to calculate the best factor 
and carry out an automatic subtraction. Choose Use This Factor to 
enter a factor to be used for the automatic subtraction.  
To specify the spectrum to be used as the reference in the 
subtraction, select to enter either a file name or a spectrum title. The 
macro will fail to run if the reference is not specified.  
The Factor option you select affects which spectra is selected when 
the Subtract task is completed. If you select the Display Subtract 
Window option, the sample spectrum will be the selected spectrum. 
This lets you add the subtraction result to a new window without 
changing the active OMNIC spectral window. If you select the one 
of the other options, the subtraction result is the selected spectrum 
when the Subtract task is completed. 
When you have set the Subtract task parameters, choose OK. 
 
 

 Text Search When the macro is run, the OMNIC Text Search dialog is displayed, 
which allows you to find library spectra by searching for an index 
number or key words or characters in the information saved with the 
spectra. After you find a library spectrum, you can add it to the 
spectral window. 
 
Task parameters  
This task does not have any settable parameters. 
 
 

 Tile Windows When the macro is run, the Tile Windows task arranges all of the 
open spectral windows in a tile pattern.  
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Task parameters  
This task does not have any settable parameters. 
 
 

 % Transmittance When the macro is run, the % Transmittance task converts the 
selected spectrum or spectra to % transmittance units.  
 
Run time requirements  
A spectrum must be selected in order for this task to execute 
properly at run time.  
 
Task parameters  
This task does not have any settable parameters. 

 
 Note This task will fail if the selected spectrum is a Raman spectrum 

because this is not an allowed operation for a Raman spectrum.  
 
 

 Truncate All Spectra The Truncate All Spectra task appears in the Macros\Basic task list 
only when OMNIC Series software is loaded on the computer. When 
the macro is run, the Truncate All Spectra task deletes from every 
spectrum in the active series data set all the spectral data outside the 
specified region.  
 
Run time requirements  
A series reconstruction window or a contour window must be open 
and selected in order for this task to execute properly at run time.  
 
Task parameters  
The Truncate All Spectra task parameters are the same as the 
OMNIC Truncate All Spectra parameters. They allow you to specify 
the spectral region that you want to save. The Truncate All Spectra 
task parameters do not need to be set in order for the macro to run. If 
the parameters are not set, the OMNIC Truncate All Spectra dialog 
box will be displayed at run time. 
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To specify the spectral region to save, double-click the Truncate All 
Spectra task symbol. Enter the starting and ending X-axis limits of 
the region to save and choose OK.  
 

 Note You cannot use macro variables to set the Truncate All Spectra 
parameters.  
 
 

 Use Raman Accessory The Use Raman Accessory task appears in the Macros\Basic task list 
only when OMNIC for Raman software is loaded on the computer. 
When the macro is run, the Use Raman Accessory task selects either 
the Raman accessory or the main IR bench for data collection. 
 
Task parameters  
To specify the IR bench or Raman accessory, double-click the Use 
Raman Accessory task symbol. Select to use either the Raman 
accessory or the main IR bench. Then choose OK. You can use this 
task to turn the Raman accessory on before collecting Raman 
spectra, then again to turn it off when done. 

 
 
 Verify File When the macro is run, the Verify File task verifies that a file has 

been digitally signed. You can verify signatures for Thermo 
Scientific files that contain spectra, spectral groups, experiments, 
configurations or options (option files) and for JCAMP files. The 
Verify File task appears in the Macros\Basic task list only when  
Val-Q DS software is installed. When the macro is run, the task 
result will be stored in the Result variable.  
 
Task parameters  
When you add the Verify File task to a macro, you may specify the 
file name of the file to be verified or set up the macro to display the 
Open File To Verify dialog box to allow the operator to select a file 
at run time. If both of these parameters are undefined, the macro will 
display the Open File To Verify dialog box at run time.  
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To specify the Verify File task parameters, double-click the Verify 
File task symbol in your macro. The Verify File dialog box is 
displayed. Enter the file name of the file to be verified or choose 
Browse and then select a file. You can verify signatures for Thermo 
Scientific files that contain spectra (.SPA files), spectral groups 
(.SPG files), experiments (.EXP files), configurations (.CON files) 
or options (.OPT files) and for JCAMP files. If you want the 
operator to select the file at run time, leave the File Name box blank 
and select the Display Open File Dialog At Run Time check box. 
When the parameters are set, choose OK. 
At run time, the software checks the selected file for a digital 
signature. If the file contains multiple items, such as two or more 
items in a spectral group file (*.SPG) or report notebook file 
(*.NBK), the software will verify only the first item in the multiple-
item file. The result of the Verify File task is a text string containing 
either an error message or a success message and is saved in the 
Result variable.  

 Note You may display the task results using a Comment task or send them 
to OMNIC or another Windows application using a Report task by 
including the placeholder #result# in the text of your comment or 
report.  #Result# will be replaced by the results of the task at run 
time.  Each task result may also be stored in a macro variable by 
using a math task after the current task and setting up the math task 
to define a macro variable for #result# (for example, set mv1 equal 
to #result#).  
 
 

 Unshift The Unshift task appears in the Macros\Basic task list only when 
OMNIC for Raman software is loaded on the computer. When the 
macro is run, the Unshift task returns the selected Raman-shifted 
spectrum to its original, unshifted condition. Unshift reverses the 
effects of Raman Shift and Custom Shift operations and of Raman 
data collection with Final Format set to Shifted spectrum. The 
original, unshifted spectrum will automatically replace the shifted 
spectrum.  
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Run time requirements  
A Raman-shifted spectrum must be selected in order for this task to 
execute properly at run time. 
 
Task parameters  
This task does not have any settable parameters. 
 
 

 View Notebook When the macro is run, the View Notebook task displays the 
notebook specified in the View Notebook dialog box. 
 
Task parameters  
The View Notebook task parameter is the same as the OMNIC View 
Notebook parameter. It allows you to specify the notebook file to be 
opened. The View Notebook task parameter does not need to be set 
in order for the macro to run. If the parameter is not set, the operator 
will be prompted to select the notebook file to open at run time. 
To specify the notebook file to be opened, double-click the View 
Notebook task symbol. Select an notebook file or enter its full name 
in the File Name text box. Then choose OK. 
 
 
This is a menu by menu description of the commands available in 
the menu bar when the Macro Panel application is running. The 
commands are presented in the order in which they appear in the 
menus. 

Macro Panel 
command 

descriptions 
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When the Macro Panel is in assign mode, the File menu contains the 
following commands: 

File menu 

 
 
Command name Description 

New Set Creates a set of seven macro buttons. 
Save Changes Saves your changes to the Macro Panel. 
Delete Set Deletes the currently displayed set of macro 

buttons. 
Exit Closes the Macro Panel application. 

 
 
When the Macro Panel is in select mode, only the Exit command is 
active in the File menu. This section describes all the commands in 
the Macro Panel File menu in both the assign and select modes. 
 
 
This command is only active when the Macro Panel is in assign 
mode. Use the New Set command when you want to add more 
macros to the Macro Panel and all of the buttons in the current 
button set are assigned. When you choose New Set from the File 
menu, a new set of seven macro buttons will appear on the Macro 
Panel. 

New Set command (File menu) 

 
 Note To add comments for the new set of macro buttons, make sure no 

buttons are selected. Then type the comments in the Comments box 
directly beneath the macro buttons.  
 
 
This command is only available when the Macro Panel is in assign 
mode. Use Save Changes to save your changes to the Macro Panel. 
When you choose Save Changes, all of the changes you made since 
you switched the Macro Panel to assign mode are saved. 

Save Changes command 
(File menu) 

 

OMNIC Macros User’s Guide       207 
 



 
 Note Changes are automatically saved when you switch the Macro Panel 

from the assign macros mode to the select macros mode. To switch 
to the select macros mode, choose Select Macros from the Options 
menu.  
 
 
This command is only available when the Macro Panel is in assign 
mode. Use the Delete Set command to delete a set of seven macro 
buttons. When you choose Delete Set from the File menu, the 
currently displayed set of buttons is deleted. 

Delete Set command 
(File menu) 

 
 Note Only the macro buttons are deleted. The macro files which were 

assigned to the macro buttons remain saved.  
 
 
Use the Exit command to close the Macro Panel. Exit command (File menu) 
 
 

 

The commands in the options menu allow you to switch the Macro 
Panel between assign macros mode and select macros mode and to 
display a directory of assigned macros. 

Options menu 

 
 
This command allows you to switch the Macro Panel from the select 
macros mode to the assign macros mode. To change to the assign 
macros mode, choose Assign Macros from the File menu. When the 
Macro Panel is in assign mode, you can assign macros to the macro 
buttons but you cannot select and run macros.  

Assign Macros command 

 
The Macro Panel menu bar and buttons have the following functions 
in assign mode. 
 
Macro Panel menu bar 
In assign macros mode, the menu commands allow you to create a 
new set of seven macro buttons, save your changes to or delete the 
currently displayed set of macro buttons, display a directory of 
assigned macros, get help on using the Macro Panel, and quit the 
Macro Panel application. 
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Macro buttons 
The macro buttons allow you to choose which button to assign a 
macro to. 
 
Macro control buttons 
Next Set - Displays the next set of macro buttons. 
Label - The Label text box allows you to enter the label for the 
selected macro button. 
Protect Assignments - Displays a dialog box which allows you to 
set protection for the macro. 
Change Assignment - Displays a dialog box which allows you to 
choose the macro to assign to the currently selected macro button. 
You can assign either a Basic macros (*.MAC) or executable file 
(*.EXE) using the Change Assignment dialog box. 
 

 Note The Run Macro, Exit Loop and Stop Macro buttons are disabled in 
the assign mode.  
 
 
This command allows you to switch the Macro Panel from the assign 
macros mode to the select macros mode. To change to the select 
macros mode, choose Select Macros from the File menu. In select 
mode, the Macro Panel can be used only for selecting and running 
macros.  

Select Macros command 
(Options menu) 

 
The Macro Panel menu bar and buttons have the following functions 
in select mode. 
 
Macro Panel menu bar 
In select macros mode, the menu commands allow you to quit the 
Macro Panel application, display a directory of assigned macros and 
get help on using the Macro Panel. 
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Macro buttons 
The macro buttons allow you to choose the macro to be run. The 
macro buttons are saved in sets consisting of seven buttons. 
Different sets of macro buttons can be displayed by clicking the 
Next Set macro control button. 
 
Macro control buttons 
Next Set - Displays the next set of macro buttons. 
Run Macro - Runs the currently selected macro. 
Exit Loop - Stops a loop in the macro which is being run before the 
loop has been executed the specified number of times. The macro 
will continue after exiting the loop. 
Stop Macro - Stops the macro before it is finished running. 
 
 

Directory command 
(Options menu) 

The Directory command displays a table of all the currently assigned 
macro buttons in the Macro Panel. Use the Directory command to 
quickly locate a macro which you want to run. Do this by clicking a 
line in the table to select it and then choosing “Go to.” 
 
Each line in the table displays the macro button label followed by 
the macro file currently assigned to it. The date and time the macro 
file was last saved is also displayed along with the first few words of 
the macro file’s comments. These comments are entered in the 
Summary Info dialog box when the macro is created. 
 
If a macro button is assigned to a macro file which cannot be found, 
the words “<NOT FOUND>“ are displayed in place of the date and 
time. This situation can occur if you have deleted a macro file from 
your disk or moved it to a different subdirectory. If you have moved 
it, you should use the Change Assignments button to reassign this 
macro button. 
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9 Designing a Macro with OMNIC DDE 
 
 
Using OMNIC DDE as a task in a Macros\Basic macro allows you 
to execute commands and set or get the value of parameters when a 
macro is executed. 
 

 Note For full documentation on using OMNIC DDE, including 
descriptions of commands and parameters, see the Macros\Pro 
User’s Guide.  
 
To add an OMNIC DDE task to your macro, click the OMNIC DDE 
entry at the bottom of the Macros\Basic Tasks list. An OMNIC DDE 
task will appear in the macro at the insertion point. To set-up the 
task, double-click the task object just as you would any other 
Macros\Basic task. 
 

 



 
When a macro containing an OMNIC DDE task is executed at 
runtime, the commands listed in the OMNIC DDE Commands To 
Execute field are executed by the OMNIC DDE application. When 
the last DDE conversation is completed, control returns to the task 
following the OMNIC DDE task in the Macros\Basic macro. 
 
The features of the OMNIC DDE task can be grouped into four 
categories: 
• Parameters (Group, Parameter, and Value). 
• Commands (Command and Keywords). 
• Readout. 
• Command buttons. 
 
 
Each OMNIC parameter belongs to a specific group. These groups 
are a way of organizing related parameters; for example, all data 
collection parameters are located in the Collect group. To access an 
OMNIC parameter you must specify both the group name and the 
parameter name. 

Parameters 
(Group, Parameter, 

and Value) 
 
The Group drop down list displays the parameter groups recognized 
by OMNIC. To access the parameters in a specific group, select a 
group from the Group list. The contents of the Parameter field will 
change to display the parameters in the selected group. 
 
The Value drop down list displays the values permitted for the 
selected parameter. You should select the appropriate value you 
wish to use from this list. This box will be empty for many 
parameters; in this case, you may enter any value you wish. See the 
parameter section of the Macros\Pro User’s Guide for the type of 
value to use with each parameter. 
 
The items listed in each drop down list are sorted alphabetically. You 
can select an item by scrolling through the drop down list or by typing 
the first few characters of an item while the drop down list is exposed. 
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You can also enter values into the Group, Parameter and Value text 
boxes if you do not see the parameter you want to use. 
 
 
Each OMNIC command is listed in the Command drop down list 
along with any arguments or options that the command recognizes. 
The commands are sorted alphabetically. You can select a command 
by scrolling through the drop down list or by typing the first few 
characters of the command while the drop down list is exposed. 

Commands 
(Command and 

Keywords) 
 
Some commands require arguments. If arguments are required, a 
description of them is shown after the command name enclosed in 
angle brackets. For example, 
 
DeleteAnnotation <RegionStart> <RegionEnd> 
 
The DeleteAnnotation command requires two arguments:  
RegionStart and RegionEnd. You must substitute values for these 
two arguments; these values must be separated by a space. An easy 
way to enter values for the arguments is to double-click the 
argument in the Command box and type the value. This will 
automatically substitute the value over the argument description 
place holder. For example, the following command deletes all 
annotation in the region from 4000 to 2000 cm-1 (assuming a 
wavenumber spectrum is currently selected). 
 
DeleteAnnotation 4000 2000 
 
Some commands have optional arguments. These arguments are 
enclosed in square brackets. For example, 
 
CoaddRegion [<StartTime> <EndTime> [<WindowTitle>]] 
 
Optional arguments do not need to be provided. If you choose not to 
provide them, you must delete the optional argument place holders 
from the command box. Do this by selecting all text between and 
including the square brackets then pressing the Delete key. 
 
In the previous example, there are two sets of optional arguments as 
indicated by the nested set of square brackets. This example can be 
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interpreted as follows. If you provide a value for StartTime you must 
also provide a value for EndTime because both of these arguments 
are within a set of square brackets. The WindowTitle argument is 
optional if you specify StartTime and EndTime. If you provide a 
value for WindowTitle you must also provide values for StartTime 
and EndTime. You cannot specify a value for just the WindowTitle 
argument because it is nested within the other option. For example, 
the following commands are valid: 
 
CoaddRegion 
 
CoaddRegion 2.05 4.30 
 
CoaddRegion 2.05 4.30 “Coadded Result” 
 
The following command is not valid because no StartTime and 
EndTime values were provided: 
 
CoaddRegion “Coadded Result” 
 
Some commands have arguments which are not enclosed in angle 
brackets and are separated by a vertical bar, |. For example, 
 
OtherCorrections Dispersion|ATR 
 
This notation means that you must select one of the keywords 
separated by the vertical bar. You must delete the vertical bar and 
the keyword which you do not want to use. 
 
Keywords are optional command arguments which affect the 
behavior of the command when it is executed. To add a keyword to 
the command, click the appropriate check box after selecting a 
command from the Command drop down list. 
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 Invoke Allows you to specify interactive operation for a command. When 

used with commands like CollectSample or Subtract, the interactive 
versions of these commands are “invoked. ” For example, the 
Collect Sample window appears during data collection and the 
Subtract window appears allowing you to perform an interactive 
subtraction. When used with commands like Average, the result will 
be displayed in a dialog box even though there is no equivalent 
OMNIC menu command. 
 
When the Invoke keyword is used with a command, execution of 
code pauses until the operator closes the interactive window or 
dialog. In other words, the DDE conversation which initiates the 
command is not completed until the window or dialog is closed. 
 
The Invoke keyword also affects how error messages are handled. If 
a command is used without this keyword, errors are stored and must 
be retrieved by getting the value of the parameter Result Error. 
When the Invoke keyword is used, these errors are displayed to the 
operator and a response is required. 
 

 Auto The Auto keyword sets up data collection so that no operator 
prompts for entering a title and preparing for data collection are 
displayed. This check box is enabled only for data collection 
commands which allow this option. The Invoke keyword must 
always be selected when the Auto keyword is selected. 
 

 Shift The Shift keyword is used with the Select command to cause the 
specified spectrum to be selected in addition to the currently selected 
spectrum or spectra. 
 
This keyword is also used with the PeakHeight command to seek the 
peak closest to the specified peak location. 
 

 Polling The Polling keyword causes OMNIC to complete, or close, the DDE 
conversation as soon as the command is initiated. Without this 
keyword, OMNIC holds on to the DDE conversation until the 
command has finished executing then closes the conversation. 
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This keyword may be used with data collection commands to initiate 
a data collection then immediately return. This allows your program 
to continue executing while OMNIC proceeds with data collection. 
 
This keyword gets its name from the polling mechanism you use in 
your code to test to see if the command has completed. Test the 
appropriate MenuStatus group parameter to see if its value is 
Enabled or Disabled. For example, the MenuStatus CollectSample 
parameter remains Disabled until data collection has finished, then 
its value becomes Enabled. 
 
 
The readout area of the OMNIC DDE application is the field at the 
bottom of the window labeled OMNIC DDE Commands To 
Execute. This field is editable (cut, copy, paste, delete, etc.) so you 
can copy or modify any of the text in this field. 

Readout 

 
 
These are the buttons in the application which carry out a specific 
action. Command Buttons 
 

 Find Use the Find button to display a dialog box which assists you in 
locating a specific command or parameter. Use this feature when 
you don’t know the exact name of a command or parameter or the 
group to which a parameter belongs. 
 
 

 
 
 
For example, suppose you want to find the parameter which returns 
error information. Type “error” into the Text to find box, click the 
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Parameter radio button, and click the Find button. The application 
searches all parameter names until it finds one containing “error”. 
The first occurrence is the parameter Collect CorrError. This 
parameter is displayed in the Group and Parameter boxes with the 
matching text highlighted. To continue the search, click the Repeat 
Find button. The search continues and finds the next parameter, 
Result Error. This is the parameter we want so you can click the 
Cancel button in the Find dialog to close it. 
 
Use the Find button to repeat the search of all parameters or 
commands; use Repeat Find to continue the search after the last 
occurrence. 
 
The search is not case sensitive; this means “error” will match both 
“error” and “Error”. 
 

 OK Use the OK button to save the contents of the OMNIC DDE 
Commands To Execute field in the Macros\Basic task and close the 
OMNIC DDE dialog. 
 

 Cancel Use the Cancel button to close the OMNIC DDE dialog without 
saving any changes in the OMNIC DDE task. 
 

 Set Parameter Use the Set Parameter button to create a command which sets the 
selected parameter to the value specified in the Value field at 
runtime. A SetOMNIC command to accomplish this is added to the 
current contents of the OMNIC DDE Commands To Execute field. 
 

 Get Parameter Use the Get Parameter button to create a command which obtains the 
value of the selected parameter from OMNIC at runtime. A 
GetOMNIC command to accomplish this is added to the current 
contents of the OMNIC DDE Commands To Execute field. At 
runtime, the current value of the selected parameter is held in 
memory and may be accessed using the Macros\Basic Store Result 
task. 
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 Send Command Use the Send Command button to create an ExecuteOMNIC 

command which executes the command at runtime exactly as it 
appears in the Command field along with the selected keywords. 
You must have already substituted values for any argument or option 
place holders in the command string. Any results of the command 
are held in memory and may be accessed using the Macros\Basic 
Store Result task. 

 
 

OMNIC DDE 
Commands to Execute 

The OMNIC DDE Commands To Execute field contains the code 
generated by each of the above command buttons. 
 
Note that the content of this field is editable; you may type, cut, 
copy, or paste any text in this field. You may find this more 
convenient than using the above command buttons to generate code. 
 
You may also use macro variable placeholders to set parameter 
values or send DDT commands. (You cannot use macro variables to 
get parameter values; you must use the Store Results task after 
OMNIC DDE for that.) 
 

 Test DDE Code Use this button to execute the contents of the OMNIC DDE 
Commands To Execute Field as you click the button. This is 
recommended so that you can be sure the code will operate as you 
intend at runtime. 
 
The Test DDE Code command does not display any error messages. 
The only way to verify that the code is doing what you want it to is 
to have OMNIC running and watch to see what happens when you 
test the code. 
 
 
If the Display Error Messages At Run Time option is checked (the 
default state), any error occurring during the OMNIC DDE task 
causes an error message to display in Macros\Basic at run time. 
When the option is not checked, errors are ignored, and the macro 
continues without interruption. 

Messages 
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You can test for errors after the OMNIC DDE task by using the 
Store Result task. In the Store Result dialog box, select OMNIC 
DDE as the task and Error as the result. If no errors occur, the result 
will be null. If an error occurs, the text of the error is placed into the 
macro variable. 
Some messages you may encounter when using OMNIC DDE and 
their meanings are provided here. 

• “No match found.” 
This message is displayed when you click the Find button in the 
Find dialog and there are no parameters or commands which contain 
the text you have entered in the Text To Find box. 

• “No additional matches found.” 
This message is displayed when you click the Repeat Find button in 
the Find dialog and there are no additional parameters or commands 
which contain the text you have entered in the Text To Find box. 
When you OK this message the last parameter or command which 
was found is displayed in the Parameter or Command fields. 

• “Executing command...” 
This message is displayed in the Result field while OMNIC is 
executing a command after you click the Send Command button. As 
soon as the command finishes and the DDE conversation is closed, 
this message is overwritten with the result of the command. 

• “Setting parameter value...” 
This message is displayed in the Result field while OMNIC is 
setting the value of a parameter after you click the Set Parameter 
button. As soon as the DDE conversation is closed, this message is 
overwritten with the result of the Set Parameter operation. 

• “Reading parameter value...” 
This message is displayed in the Result field while OMNIC is 
getting the value of a parameter after you click the Get Parameter 
button. As soon as the DDE conversation is closed, this message is 
overwritten with the value of the parameter. 
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10 Index 
 
 
 
A 
Absorbance task, 114 
Add Basis Vector task, 114 
Add Constant task, 115 
Add Spectra task, 116 
Add to Library task, 116 
Add to Notebook task, 117 
adding a comment dialog box to a macro, 30 
adding a decision dialog box to a macro, 31 
adding a loop to a macro, 24 
adding a macro to a macro, 35 
adding an If…Then condition to a macro, 27 
adding tasks to a macro, 19 
Advanced ATR Correction task, 117 
Annotate task, 118 
Apply Function task, 119 
Assign Macros command, 208 
Assign Macros password 

changing, 62 
deleting, 63 
entering, 61 

assigning a macro to a macro button, 57 
assigning macros to OMNIC, 41 
Auto keyword, 215 
Automatic Full Scale task, 120 
Average task, 120 
 
 
B 
Baseline Correct task, 121 
black task symbols, 21 
Blank task, 121 
blue task symbols, 21 

button 
Change Assignments, 57 
Exit Loop, 51 
Go To, 54 
Next Set, 51 
Protect Assignments, 57 
Run Macro, 51 
Stop Macro, 51 

button sets 
deleting, 60 
protecting, 61 
removing protection for, 63 

buttons 
assigning macros to, 57 
macro, 51, 56 
page, 15 

 
 
C 
Cascade Windows task, 122 
Change Assignments button, 57 
Change Data Spacing task, 122 
Change Reason task, 123 
Change Title task, 123 
changing the Assign Macros password, 62 
changing the directory used to store macros, 66 
Clear command, 103 
Clear task, 124 
Clipboard 

pasting task symbols from, 20 
placing task symbols on, 20 

Close Log task, 124 
Close Window task, 124 
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closing 

Macros, 4, 10 
the Macro Panel, 5, 50 

Coadd Region task, 125 
Collect Background task, 126 
Collect Raman task, 127 
Collect Reference task, 128 
Collect Sample task, 129 
Collect Series task, 130 
commands 

Macro Panel, 206 
Macros, 97 

comment 
specifying variables in, 30 

Comment command, 103 
comment dialog box 

adding to a macro, 30 
Comment task 

displaying Find Peaks and Search result in, 31 
specifying variables in, 30 

comments 
entering for a macro, 59, 68 

Common Scale task, 131 
compiling a macro, 39 
configuration file 

file name extension for, 185 
context-sensitive help, 7 
Contour/Waterfall task, 131 
Copy command, 102 
Copy task, 132 
copying tasks in a macro, 20 
Create Chemigram task, 132 
Create File task, 133 
Create Profile task, 134 
creating a macro, 16 
Custom Shift task, 135 
customizing macros, 38 
Cut command, 102 
Cut task, 136 
cutting tasks from a macro, 20 

D 
Decision command, 104 
decision dialog box 

adding to a macro, 31 
specifying variables in, 32 

Decision task 
example of, 34 
specifying actions for, 33 
specifying buttons for, 33 
specifying task parameters for, 33 

Delay task, 136 
Delete Annotation task, 136 
Delete File task, 137 
Delete Set command, 208 
Delete Time Region task, 137 
deleting a button set, 60 
Derivative task, 138 
dialog box 

adding to a macro, 30 
Comment, 30 
Decision, 31 
highlighting parameters in, 21 
on-line help for, 7 

directory 
for storing macros, 66 

Directory command, 210 
Display Background task, 138 
Display Limits task, 139 
Display Setup task, 139 
Display Spectral Reference task, 140 
displaying a different set of macro buttons, 54 
displaying a directory of assigned macros, 54 
 
 
E 
Edit menu commands, 102 
Edit Title task, 140 
editing a macro, 20 
Else task, 109 
End If task, 109 
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End of Loop task, 106 
End of Loop task symbols, 26 
End task symbol, 16 
entering summary information for a macro, 68 
error messages 

on-line help for, 39 
when compiling macros, 39 

example macro, 72 
DDE, 79 
If…Then, 72, 89 
Report task, 79 
sharing macro variable values, 95 

executable files 
file name extension for, 110, 209 

Exit command, 101, 208 
Exit Loop button 

in assign mode, 57 
in select mode, 51 

exiting 
Macros, 4, 10 
the Macro Panel, 5, 50 

experiment file 
file name extension for, 185 

Experiment Setup task, 141 
Export Series to Grams task, 141 
extension name 

executable files, 209 
extensions 

configuration file, 185 
experiment file, 185 
macros, 66 
series data set, 195 

Extract Spectrum task, 142 
 
 
F 
File menu commands 

for Macros, 97 
for the Macro Panel, 207 

Find Peaks task, 143 

format 
for numbers used in macros, 152 

Fourier Self-Deconvolution task, 144 
Full Scale task, 144 
 
 
G 
Get Library Spectrum task, 145 
Go To button, 54 
 
 
H 
help 

context sensitive, 7 
F1 key, 53 
for error messages, 39 
menu, 7 

Help menu, 7 
Hide Spectra task, 145 
 
 
I 
If…Then command, 109 
If…Then condition 

adding to a macro, 27 
If…Then macro 

example, 72, 89 
Insert menu commands, 103 
insertion point, 15 
Instrument Correct task, 146 
Invoke keyword, 215 
 
 
K 
Keywords, 214 
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L 
labels 

for macro buttons, 57 
Library Setup task, 146 
Log In task, 147 
Loop command, 106 
loops 

adding to a macro, 24 
pausing after each iteration, 26 
using a variable to set iterations, 25 

 
 
M 
macro 

adding a comment to, 30 
adding a decision point to, 31 
adding a loop to, 24 
adding a macro to, 35 
adding an If…Then condition to, 27 
adding tasks to, 19 
assigning to OMNIC, 41 
compiling, 39 
copying tasks in, 20 
creating, 16 
creation date, 54 
customizing, 38 
cutting tasks from, 20 
definition of, 2 
editing, 20 
entering a comment for, 68 
entering a title for, 68 
entering summary information for, 68 
entering the author for, 68 
example, 3, 72 
file name, 54 
file name extension for, 66 
moving between computers, 70 
opening, 65 
pasting tasks in, 20 
printing a listing of, 69 

printing the task symbols in, 69 
running from a function key, 53 
running from Macros, 69 
running from OMNIC, 5, 47 
running from the Macro Panel, 52 
saving, 40, 66 
saving with a new name, 67 
setting options for, 38 
setting password protection for, 112 
sharing values between, 95 
testing, 39 

macro button sets 
deleting, 60 
protecting, 61 
removing protection for, 63 

macro buttons 
assigning macros to, 57 
in select mode, 51 
specifying labels for, 57 

Macro buttons 
in assign mode, 56 

Macro command, 110 
macro comments, 54 

entering, 68 
macro control buttons 

in assign mode, 56 
in select mode, 51 

macro description, 52 
macro files 

using variables in, 35, 110 
Macro menu, 111 
Macro Panel 

description of, 3 
in assign mode, 56 
in select mode, 51 
message box, 52 
moving between computers, 70 
on-line help, 6 
quitting, 5, 50 
saving changes to, 60 
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Macro Panel buttons 

in assign mode, 56 
in select mode, 51 

Macro Panel commands, 206 
Assign Macros, 208 
Delete Set, 208 
Directory, 210 
Exit, 208 
New Set, 207 
Save Changes, 207 
Select Macros, 209 

Macro Panel menu bar 
in assign mode, 56 
in select mode, 51 

Macro Panel operations 
assigning a macro to a macro button, 57 
changing the Assign Macros password, 62 
deleting a button set, 60 
displaying a different set of macro buttons, 54 
displaying a directory of assigned macros, 54 
protecting macro button sets, 61 
removing the Assign Macros password, 63 
running a macro, 52 

macro set 
example, 3 

macro title 
entering, 68 

macro variable 
to store Average task results, 121 
to store Find Peaks task results, 144 
to store Minimum/Maximum task results, 154 
to store Noise task results, 159 
to store Peak Area task results, 168 
to store Peak Height task results, 169 
to store QC Compare task results, 172 
to store Quantify task results, 173 
to store Search task results, 188 
to store Verify File task results, 205 

macro variables 
adding to a comment dialog box, 30 
adding to macro names, 35, 110 
adding to task parameters, 23 
extracting information with math task, 151 
placeholders for, 23, 35, 110 

macro variables, 22 
macro workspace, 14 
Macros 

description of, 2 
on-line help, 6 
quitting, 4, 10 
window, 11 

Macros commands, 97 
Clear, 103 
Comment, 103 
Copy, 102 
Cut, 102 
Decision, 104 
Exit, 101 
If…Then, 109 
Loop, 106 
Macro, 110 
New, 97 
Open, 98 
Options, 111 
Paste, 102 
Print Listing, 101 
Print Symbols, 101 
Program Note, 113 
Run, 101 
Save, 98 
Save As, 99 
Show Macro Variables, 111 
Summary Info, 100 
Test, 111 

Macros menu bar, 12 
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Macros operations 

creating a macro, 16 
entering summary information for a macro, 68 
opening a macro, 65 
printing a macro, 69 
running a macro, 69 
saving a macro, 40, 66 
saving a macro with a new name, 67 
testing a macro, 39 

Mail Spectra task, 147 
manual conventions, 1 
Match Scale task, 148 
Match Spectrum Settings task, 148 
Math task, 148 

extracting macro variable information, 151 
Maximize Window task, 153 
menu bar 

Macro Panel, 51, 56 
Macros, 12 

message box, 52 
Minimize Window task, 153 
Minimum/Maximum task, 153 
modifying task parameters, 21 
Move Stage task, 154 
moving macro files between computers, 70 
Multiply task, 157 
 
 
N 
New command, 97 
New Set command, 207 
New Window task, 158 
Next Set button, 51 
Noise task, 158 
Normalize Frequency task, 159 
Normalize Scale task, 159 
number formats, 152 
 
 

O 
Offset Scale task, 160 
OMNIC DDE 

designing macros with, 211 
OMNIC DDE task, 160 
OMNIC menus 

assigning macros to, 41 
OMNIC parameters 

to reset after running a macro, 112 
OMNIC toolbar 

assigning macros to, 44 
on-line help 

context sensitive, 7 
F1 key, 53 
for error messages, 39 
Help menu, 7 

Open command, 98 
Open Configuration task, 162 
Open Data Set task, 163 
Open Experiment, 163 
Open Log task, 164 
Open Options task 

replacing, 163 
Open task, 161 
opening a macro, 65 
Options command, 38, 111 
Options menu commands, 208 
Other Conversions task, 165 
Other Corrections task, 165 
Overlay Spectra task, 166 
 
 
P 
page buttons, 15 
parameters 

for tasks, 19, 21 
to reset after running a macro, 112 
using variables in, 23 
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password 

for digital signature, 192 
password, Macros 

entering, 18, 40, 67, 68, 99, 100 
setting, 112 

password, Macros Panel 
changing, 62 
deleting, 63 
entering, 61 
specifying, 61 

Paste command, 102 
Paste task, 166 
Paste to Log task, 167 
pasting tasks 

from the Clipboard, 20 
in a macro, 20 

pause 
inserting after each loop cycle, 26 

Peak Area task, 167 
Peak Height task, 168 
% Transmittance task, 203 
placeholder 

for macro variables, 23 
for the Result variable, 23 

placing tasks on the Clipboard, 20 
Polling keyword, 215 
Preview/Print Report task, 169 
Print Listing command, 101 
Print Symbols command, 101 
Print task, 170 
Printer Setup task, 170 
printing a listing of a macro, 69 
printing the task symbols for a macro, 69 
Program Note command, 113 
Protect Assignments button, 57 
protecting macro button sets, 61 
protecting macros with passwords, 112 
Purge Correct Calibration task, 170 
 
 

Q 
QC Compare task, 171 
Quant Setup task, 173 
Quantify task, 172 
quitting 

Macros, 4, 10 
the Macro Panel, 5, 50 

 
 
R 
Raman Shift task, 174 
red task symbols, 21 
Region Subtract task, 175 
removing macro button assignment protection, 63 
replacing old tasks 

Open Options, 163 
Save Parameters As, 185 

Report task, 175 
example, 79 
to add QC Compare task results to a log file, 172 

Reprocess Series task, 179 
Reprocess task, 178 
Request task, 180 
Restore Window task, 182 
Result variable, 22, 104 

adding to a comment dialog box, 30 
adding to a decision task, 32 
adding to task parameters, 23 
placeholder for, 23 
requirements for using, 23 
storing Average task results in, 121 
storing Find Peaks task results in, 144 
storing Minimum/Maximum task results in, 154 
storing Noise task results in, 159 
storing Peak Area task results in, 168 
storing Peak Height task results in, 169 
storing QC Compare task results in, 172 
storing Quantify task results in, 173 
storing Search task results in, 188 
storing Verify File task results in, 205 
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Retrieve Interferograms task, 182 
Return Value task, 183 
Revert Basis Vector task, 183 
Run command, 101 
Run Macro button 

in assign mode, 57 
in select mode, 51 

running a macro 
from Macros, 69 
from OMNIC, 52 
from the Macro Panel, 52 
using a function key, 53 

 
 
S 
Save As command, 99 
Save As task, 184 
Save Changes command, 207 
Save command, 98 
Save Configuration As, 185 
Save Experiment As, 185 
Save Group task, 186 
Save Parameters As task 

replacing, 185 
Save task, 184 
saving a macro, 40, 66 

with a new name, 67 
saving changes to the Macro Panel, 60 
Search task, 187 
searching for a macro, 54 
Select All task, 188 
Select Macros command, 209 
Select Spectrum task, 188 
Select Template task, 189 
Select Window task, 190 
selecting task symbols, 20 
series data set 

file name extension for, 195 
Series Setup task, 190 
Set Spectral Reference task, 191 

sharing values between macros, 95 
Shift keyword, 215 
Show Contour/Waterfall task, 191 
Show Macro Variables command, 111 
Sign File task, 192 
Smooth task, 193 
specifying labels for macro buttons, 57 
Spectral Interpretation task, 194 
Spectral Math task, 194 
Split File task, 195 
Stack Spectra task, 196 
Start of Loop task symbols, 26 
Start task symbol, 16 
Statistical Spectra task, 196 
status bar, 13 
Stop Macro button 

in assign mode, 57 
in select mode, 51 

Stop Macro task, 197 
Store Arguments task, 197 
Store Quant Result task, 199 
Store Result task, 198 
storing macros, 66 
Straight Line task, 200 
Subtract task, 201 
Summary Info command, 100 
 
 
T 
task 

% Transmittance, 203 
Absorbance, 114 
Add Basis Vector, 114 
Add Constant, 115 
Add Spectra, 116 
Add to Library, 116 
Add to Notebook, 117 
Advanced ATR Correction, 117 
Annotate, 118 
Apply Function, 119 
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Automatic Full Scale, 120 
Average Scale, 120 
Baseline Correct, 121 
Blank, 121 
Cascade Windows, 122 
Change Data Spacing, 122 
Change Reason, 123 
Change Title, 123 
Clear, 124 
Close Log, 124 
Close Window, 124 
Coadd Region, 125 
Collect Background, 126 
Collect Raman, 127 
Collect Reference, 128 
Collect Sample, 129 
Collect Series, 130 
Common Scale, 131 
Contour/Waterfall, 131 
Copy, 132 
Create Chemigram, 132 
Create File, 133 
Create Profile, 134 
Custom Shift, 135 
Cut, 136 
Delay, 136 
Delete Annotation, 136 
Delete File, 137 
Delete Time Region, 137 
Derivative, 138 
Display Background, 138 
Display Limits, 139 
Display Setup, 139 
Display Spectral Reference, 140 
Edit Title, 140 
Else, 109 
End If, 109 
Experiment Setup, 141 
Export Series to Grams, 141 
Extract Spectrum, 142 

Find Peaks, 143 
Fourier Self-Deconvolution, 144 
Full Scale, 144 
Get Library Spectrum, 145 
Hide Spectra, 145 
Instrument Correct, 146 
Library Setup, 146 
Log In, 147 
Mail Spectra, 147 
Match Scale, 148 
Match Spectrum Settings, 148 
Math, 148 
Maximize Window, 153 
Minimize Window, 153 
Minimum/Maximum, 153 
Move Stage, 154 
Multiply, 157 
New Window, 158 
Noise, 158 
Normalize Frequency, 159 
Normalize Scale, 159 
Offset Scale, 160 
OMNIC DDE, 160 
Open, 161 
Open Configuration, 162 
Open Data Set, 163 
Open Experiment, 163 
Open Log, 164 
Other Conversions, 165 
Other Corrections, 165 
Overlay Spectra, 166 
Paste, 166 
Paste to Log, 167 
Peak Area, 167 
Peak Height, 168 
Preview/Print Report, 169 
Print, 170 
Printer Setup, 170 
Purge Correct Calibration, 170 
QC Compare, 171 
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Quant Setup, 173 
Quantify, 172 
Raman Shift, 174 
Region Subtract, 175 
Report, 175 
Reprocess, 178 
Reprocess Series, 179 
Request, 180 
Restore Window, 182 
Retrieve Interferograms, 182 
Return Value, 183 
Revert Basis Vector, 183 
Save, 184 
Save As, 184 
Save Configuration As, 185 
Save Experiment As, 185 
Save Group, 186 
Search, 187 
Select All, 188 
Select Spectrum, 188 
Select Template, 189 
Select Window, 190 
Series Setup, 190 
Set Spectral Reference, 191 
Show Contour/Waterfall, 191 
Sign File, 192 
Smooth, 193 
Spectral Interpretation, 194 
Spectral Math, 194 
Split File, 195 
Stack Spectra, 196 
Statistical Spectra, 196 
Stop Macro, 197 
Store Arguments, 197 
Store Quant Result, 199 
Store Result, 198 
Straight Line, 200 
Subtract, 201 
Text Search, 202 
Tile Windows, 202 

Transmittance, 203 
Truncate All Spectra, 203 
Unshift, 205 
Use Raman Accessory, 204 
Verify File, 204 
View Notebook, 206 

task list 
selecting a task, 13 

task list, 13 
task parameters 

modifying, 21 
using variables in, 23 

task symbols 
End of Loop, 26 
pasting from the Clipboard, 20 
placing on the Clipboard, 20 
printing, 69 
selecting, 20 
Start of Loop, 26 

task symbols, 14 
tasks 

adding to a macro, 19 
copying, 20 
cutting, 20 
modifying associated parameters, 21 
parameters associated with, 19 
pasting, 20 
requirements for, 19 
which allow variable placeholders, 22 

Test command, 111 
testing a macro, 39 
Text Search task, 202 
Tile Windows task, 202 
Transmittance task, 203 
Truncate All Spectra task, 203 
 
 
U 
Unshift task, 205 
Use Raman Accessory task, 204 
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V 
variables 

adding to a comment dialog box, 30 
displaying, 23 
in macro files, 35, 110 
in task parameters, 23 

Verify File task, 204 

View Notebook task, 206 
 
 
W 
workspace, 14 
workspace page buttons, 15 
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